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WWeellccoommee!!  

By opening up to this page you have made the first step  in using your toolkit.  
Before beginning you may have many questions about this toolkit and how to use it.  The 
following pages contain some important information which will help to answer some of 
your questions.   Please read through carefully! 
 

WWhhaatt  iiss  aa  ttoooollkkiitt??    
A toolkit is like a guidebook.  It is a collection of information, resources and activities to 
guide you to design and implement an out of class/school learning program for young 
people to develop skills for their future life, their future work and their future learning.    
 

WWhhoo  iiss  tthhee  ttoooollkkiitt  ffoorr??  
The toolkit has been written for use by anyone who works with young people in a 
learning capacity, such as a teacher, tutor, youth worker or mentor.   However, the 
toolkit is really for young people.  The toolkit has been designed for formal school students 
between the ages of 12 and 16 and so the terminology used often refers to the formal 
education sector.    However, if you are not working with youth in the formal education 
sector, do not let that stop you from using this toolkit.  The activities are equally useful and 
applicable for young people learning in a non formal or informal learning environment.  
 

WWhhaatt  iiss  tthhee  ppuurrppoossee  ooff  tthhee  ttoooollkkiitt??      
The aim of the toolkit is to support you to provide opportunities for young people to 
develop and expand on the academic skills they learn through the core curriculum in school 
whilst at the same time develop a number of important skills to prepare them for life, 
learning and work.    The activities included in the toolkit have been developed in order 
to supplement and not replace the contents of the formal education core curriculum.  For 
that reason, many of the activities start with an assumption of knowledge and skills that 
young people already have.  
 

WWhheenn  ccaann  yyoouu  uussee  tthhee  ttoooollkkiitt??  
As the activities in the toolkit have been developed for young people to expand on or 
practice and not repeat what they have learned in the core curriculum in the classroom in 
formal schools.  Therefore, the toolkit is best used in non core curriculum time – that is all 
the times in the school day/week when young people are not learning the compulsory 
academic subjects determined by the national government1.  Non core curricular time 
includes extracurricular activities, personal development activities and the local content curriculum.    
Nevertheless, it is still possible to use the activities during core curriculum time.  
Information included in the activities indicates the curricular subject, standard and base 
competency the activity is appropriate for. 
 
 

WWhhaatt  ssoorrttss  ooff  aaccttiivviittiieess  aarree  iinncclluuddeedd??  
The activities have been developed to provide an experience for young people, which is  
beyond their ordinary everyday experience of school and education.  The activities aim to build 
young people’s practical skills, promote team work, creativity and discovery learning and allow 

                                                 
1 Core curriculum subjects are Mathematics, Indonesian, English, Natural Science, Social Science, Citizenship, Religion, Sports, Arts 
and Culture and Skills/ICT 
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young people to have fun.  A key theme in the toolkit is activities is to try and promote 
school-community and school – home links many activities require young people to go out and 
try to find out more about their community.    
 

AArree  tthhee  aaccttiivviittiieess  ddiiffffiiccuulltt  ttoo  uussee??  
Some of the activities may be very different from what you have experienced either as a 
learner or an educator.  You may find some of them very challenging to use.  Nevertheless, 
you should try to use them.  To make it as easy as possible, all activities have been 
written in detail to provide clear guidance for you.  Furthermore, all activities have been 
developed with the general situation in most schools and non formal education providers 
in mind and therefore only use resources that are available in the school, community and 
home, have a minimal financial impact and can be done in the local environment.    You 
are strongly advised to read through all the information included in the activity prior to 
using it and make all preparations necessary.   
 
CCaann  aaccttiivviittiieess  bbee  mmooddiiffiieedd  oorr  nneeww  oonneess  ccrreeaatteedd??      
Yes! As you use more of the activities you will gain in confidence and you can change the 
activity to suit your context and you will be able to develop your own activities.  We hope 
that you do.  An activity template has been included at the back of the toolkit for you to use 
when developing your own activities.  If you do develop new activities, please send them 
to us and we may include them in our second version.  
 

DDoo  aallll  tthhee  aaccttiivviittiieess  hhaavvee  ttoo  bbee  uusseedd??      
No!    The toolkit is not a curriculum.  You do not have to use all the activities in the toolkit 
and you do not have to use them in sequence.  Activities are optional and only the ones 
considered useful and relevant should be used.  However, it is not you – the facilitator-, 
who decides which activities to use, but the participants, the young people.  Only they 
can decide what is relevant and useful for their future life, learning and work.   
 

HHooww  aarree  tthhee  aaccttiivviittiieess  oorrggaanniizzeedd??      
The activities have been organized into themes or units.  At the beginning of each unit 
there is a brief overview to give you a picture of what the unit is about.  Within each unit 
there are a number of activities.   All activities follow the same pattern and are designed 
to be as detailed and as easy to follow as possible.   Each activity contains the following: 
 

Introduction:  
Provides a brief explanation of the activity  
 

 Objectives and learning outcomes:  
Explains the purpose of the activity and what young people will learn through participating in the activity  
                  
   Target age range  
Indicates the age the activity is suitable for.  As this toolkit was developed specifically for formal education 
junior high school, the numbers given refer to the three grade levels 7, 8 and 9.  The darker shaded circle 
represents the grade the activity is most appropriate for.  
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��� Difficulty Rating  
Indicates how difficult the activity is for young people to complete.  If an activity has only one star it 
means that it is relatively easy and most young people should be able to complete it.  On the other hand, 
five stars means that it is difficult and young people will find it challenging.   
 

  Links to the Core Curriculum and life skills  
Illustrates how the activity can be used in the core curriculum (the compulsory academic subjects 
determined by the government). The information explains which subject the activity is appropriate for and 
what academic and life skills competencies young people will practice by completing the activity.  
 

 Time  
The approximate minimum time required to complete the activity.  However, this is an estimated time and 
is a minimum.  The activity may take longer and take place over a number of sessions, days and weeks.  
This depends on you, the young people and the time you have available.  
 

  Resources  
Lists the resources which are needed to complete the activity.  However, it is a suggested list of resources 
and you should not be put of doing the activity if you do not have exactly what is on the list.  Try to be 
creative and replace the suggested resource with something else available in your school or community. 
 

Assessment  
This explains how you can assess the learning of the participants as they complete the activity.  However, 
please remember that the activities are for non core curricular activities and therefore, assessment is not 
formal and not compulsory.  It is a good idea to remind them of what you expect but participants should 
not feel threatened nor should they fear making mistakes, they should not feel under pressure to perform 
for examinations.  Tell them that making mistakes is okay because we learn from these mistakes.  Let them 
enjoy their interactive learning. 
 

Technology  
Provides some suggestions as to how you can integrate technology into the activity.  All suggestions are 
optional and whether you use it or not will depend on the technology that is available to you and your 
confidence in using it.   
 

 Detailed Steps  
Includes very detailed step by step instructions on how to conduct the activity.  By following the steps you 
should be able to successfully work with young people in an engaging and interesting way and to meet the 
objectives of the activity.  It is strongly recommended that you read through all steps before beginning the 
activity.    

Sometimes in this section you will find this symbol  followed by some notes.  This is additional 
information for the facilitator to help you to provide guidance and input to the young people you are 
working with. 
 

 EExtennsioon    
Gives suggestions for further activities to follow up and extend the learning from the activity.  These are 
optional and can be done by young people themselves without the guidance of a facilitator. 
 

 Handout for Participants  
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Some activities include a handout for participants to use. If possible they should be copied and distributed.  
However, remember that if you are not able to photocopy the handouts there are other ways to use them 
such as writing the information on the board or flipchart paper or reading it out loud.   
  

WWhhaatt  eellssee  iiss  iinncclluuddeedd  iinn  tthhee  ttoooollkkiitt??  
The toolkit contains some additional information to support you to develop and implement 
non core curricular activities with young people.  The additional information at the back 
of the toolkit includes useful tips on how to set up after schools clubs and also list of resources 
for further support and learning.   The information also includes some suggestions on 
how you can use the community as a learning resource for young people by bringing the 
community into the school and by taking the young people into the community to 
engage in service learning activities.   
 

IIss  iitt  ppoossssiibbllee  ttoo  pprroovviiddee  ffeeeeddbbaacckk??    
Yes! Actually we really want your feedback and we welcome it.  We want to know if this 
toolkit is everything we hope it is.  We want to know whether it is practical, realistic and 
easy for you to use and we want to know how we can make it better.  Therefore, we have 
included an evaluation form for facilitators at the back of the toolkit and we hope that you 
complete these and send them to us as you use the toolkit.  However, as this toolkit has 
really been designed for young people it is equally as important for us is to know what they 
think of the activities and so we have also included an evaluation form for participants to fill 
in as they complete the activities and we hope that you can send them to us also. 
 

IIss  iitt  ppoossssiibbllee  ttoo  aa  rreeppllaacceemmeenntt  ttoooollkkiitt  oorr  mmoorree  ttoooollkkiittss??    
In the future, yes, at the present time, no.  This is a first version of the toolkit and there are 
only a limited number of copies available, as we receive your feedback we will improve 
and re-print a second version of the toolkit next year make many more copies available. 
 

We believe that the competencies young people gain from the use of the activities 
included in this toolkit in combination with the abilities developed through related 
classroom experiences will contribute to a wide collection of skills from which young 
people may use for many years to come and which will support them to be successful in 
future life, learning and work. 
 

GGoooodd  lluucckk  iinn  uussiinngg  iitt!!  
 
Lorna Power  

Formal Education Adviser  

Decentralized Basic Education Three  

November 2006  
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OOvveerrvviieeww    
IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  

TTeecchhnnoollooggyy  ffoorr  LLiiffee,,  LLeeaarrnniinngg  aanndd  WWoorrkk  
 
 
If there were a time machine. Imagine that you are walking around your city in 1940s. 
What do you see? Perhaps you will see that some people are still using horses as a 
transportation mode. You will also see that there are only a few people using electricity as 
a lighting tool. 
 
There is one interesting thing from the years that various inventions were not yet 
discovered. It is quietness. You may not hear noisy voice from bus muffler or car horn, 
electronic equipments, etc. We felt everything was slow and it seemed slow. 
 
But, now it is different. Time really is money. Imagine if you travel from Jakarta to 
Medan. How much time will it take if you ride a horse? Perhaps months and even years! 
But now you can easily take an airplane from Jakarta and arrive in Medan in two hours. 
 
Many eases we obtained from the inventions of technology. In the area of trading, we 
can easily buy goods and services from other countries. The other thing is transaction; it 
makes us very easy to buy things. With the presence of debit and credit cards we don’t 
need to bring big amount of cash money. In the area of health, various medicines were 
invented that previously could not have been made without the help of health 
technology, also in exchanging information. Nowadays, any information, wherever, and 
whenever they are, we can get them in millisecond (1/1000 second). 
 
This world has experienced economic development for many times. In the past, 
economy was controlled by agriculture sector, and then industrial revolution happened, 
where capital holders controlled the economy. Now, the main factor in developing the 
economy is not on land, and also not on capital. We are entering an information era 
where the society is now based on information (knowledge based society). The more we 
have and the faster we get information, the bigger role we will have in the society. 
 
Let’s get back to the time machine. One more time I remind you that you are now in 
1940s. You are walking in a school. What do you see? You see students sitting in chairs 
learning and a teacher standing in front of the class explaining a subject using chalk and a 
ruler. 
 
Now I ask you again to come back to present time. This time you are in year 2007. I 
want you to walk around in a school. What do you see? You see students sitting in chairs 
learning and a teacher standing in front of the class explaining................. (stop!!) What 
you would say perhaps would not be much different with the previous paragraph. 
 
In the area of trading, health, transportation, and many other things is changing because 
of the technology. But, one more time I ask you to look outside, and visit schools. What 
has changed? How is the learning process conducted? How does the teacher teach?? 
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Yes!! Everything is still the same. The old method has been used decades and decades. 
Are you able to say that your children are ready to face the future that full of technology? 
Can they compete in a workplace?? 
 
This ICT4LLW 2 Toolkit will help to prepare students to face the future which is full of 
technology. Students will learn about the basic of Information and Communication 
Technology (ICT) Skills needed for life, learning and work. 
 
Students will learn how to take advantage of technology to help them understand a 
concept and to memorize subjects explained in the class. Beside that, students will also 
do activities on creating things; such as poem, short story, and even school newspaper, 
digital graphic, etc. 
 
On the last unit of this toolkit, students will be more prepared to face the working world 
by ‘holding ICT’ as their partner. Students will conduct a research about the skills needed 
in the workplace, prepare a database on local companies, then analyze and present the 
result of their research by using and taking advantage the ICT. 
 
Change the learning activity in classes, and prepare your student to face the future by 
participating activities included in this ICT4LLW Toolkit.  
I wish you all SUCCESS!! ☺ 

                                                 
2 Information and Communication Technology for Life, Learning, and Work 
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INFORMATION AND COMMUNICATION TECHNOLOGY FOR LIFE, 
LEARNING, AND WORK TOOLKIT 
 
Information and Communication Technology for Life, Learning , and Work 
Toolkit  is one of six topic discussions started by DBE3 to promote extra curriculum 
activities in school. It is expected to give schools idea and resource to design and develop 
extra curriculum activities that will improve teenager’s skill to use Information and 
Communication Technology in every aspect of their life, therefore it would give them 
more chance to get a job that needs skills on using Information and Communication 
Technology. 
 
Information and Communication Technology for Life, Learning, and Work 
consists of six topics as it is shown in the table below: 
 

Topics of ICT Toolkit 
1. Computer and Internet 3. Language and Communication 
2. ICT for Learning  4. Towards My Dream Career  
 
Each topic contains some activities. Participant can choose one of the activities or can 
choose all activities within one topic. 
  
Web Quest in Computer and Internet topic is obliged for all participants who follow 
extra curriculum activities. This activity will learn from computer history up to the 
practice of using the Information and Communication Technology. This activity is also 
the base for other activities. 
 
Other activities are optional. Participants can do one or all activities in all units. 
 
Computer and Internet topic introduces participants about computer history, explains 
about hardware, software, how to operate basic computer, to choose a strategy to search 
in the internet to obtain information, analyze and prepare report and presentation, to use 
the computer and internet to communicate with other people, and participants will learn 
how to make a website in some easy steps. 
 
ICT for Learning topic helps participants in learning activities, of which participants 
will learn Mind Map and Flash Card to ease the understanding and memorizing. 
Participants will explore the internet to obtain animation of science processes and 
include them to a learning material. Participants will also be introduced to the use of 
worksheet application to learn on how to manage finance. In the last activity of this unit, 
participants will try to collaborate with other people through Internet. 
 
Language and Communication topic introduces participants to printing concept, how 
to manage school newspaper, publish a small book containing poems and short stories, 
teaches how to write a diary, learn to communicate ideas through pictures and 
caricatures, and obtain knowledge on how to make posters, banners, and invitation cards. 
 
Topic of Towards My Dream Career gives an understanding to participants about 
condition in work place. Participants will do a brainstorming and survey on what skills 
needed in work place, to get information on work vacancies in newspaper and internet, 
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input data in a database, to do sorting and filtering activities on local companies to get 
data needed. 
 
All activities have been designed to give direct experiences for participants. Skills that will 
be sharpened are the skills they will need in school, workplace, society, and personal life. 
 
Assignments and activities provided in this toolkit are adjusted to conditions in 
Indonesia. As a result, participants will know more about situations and conditions in 
Indonesia. 
 
All activities provided in the ICT toolkit are interactive, of which all activities, step by 
step, will be done by participants such as discussion, brainstorming, presentation, 
computer practice, research work and data analysing. 
  
Assessment is a process from beginning to the end. All participants’ involvement in all 
activities must be recorded. 
 
Each activity will end by making a final project. This final project can be worked on 
during outside of the class hour.  
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   OObbjjeeccttiivveess  aanndd  LLeeaarrnniinngg  OOuuttccoommeess    
  

By following the activities contained in this toolkit, the teenagers are expected to gain the 
knowledge, understanding and skills: 
 
To understand the basics for computer and internet operation  
• To explain the hardware, software as well as the function 
• To conduct computer basic operation 
• To scrutinize and select strategy of search in the internet to obtain information 
• To prepare and process report and presentation 
• To use computer for communications with another person 
• To carry out Micro Teaching Practice on ICT Skills  
 
To create personal website and school website  
• To understand the concept of website 
• To determine the hierarchy or personal web map 
• To arrange and manage the content of personal web 
• To determine the design and layout of personal web 
• To create personal web 
• To save and appear personal web in internet and/or intranet. 
• To set up group and share duty 
• To plan of Making school website 
• To determine hierarchy or school web map 
• To arrange and manage the content of school web 
• To determine the design and layout of school web 
• To create school web  
• To save and appear the school web in internet and or intranet. 
 
To make learning easier, more exciting and more effective using Mind Mapping, 
FlashCard, and Scientific Animation  
• To understand and explain the concept of mind map 
• Understanding the rules of mind map 
• To use the application of mind map 
• To make a mind map on one of the topics of subject 
• To understand and explain the concept of flash card 
• To see and study flash card which has existed in internet 
• To make flash card for one of the lessons  
• To share the flash card with the world 
• To find out the source of scientific process animation in the internet 
• To combine the scientific process animation with the learning subject 
• To conduct micro teaching in front of the class on the scientific process through the 

animation 
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To manage, plan and create a personal financial system  
• To understand and explain the concept of basic equation of accounting 
• To input number into the number processor 
• To make operation of simple addition 
• To use the function in processing the number 
• To make graph from the existing data 
• To make a cooperative/school canteen accounting system using the number 

processor 
 
To join and make learning group in virtual world 
• To understand and explain the concept of collaborative learning 
• To set up a dynamic group 
• To join in the community which has existed 
• To set up a form in learning 
 
To create of school newspaper, as well as to write short story and poem  
• To understand and explain the concept of printing 
• To set up a group/club 
• To organize the content 
• To prepare and combine the content and supporting drawing 
• To print a school newspaper 
• To understand and explain the concept of poem and short story 
• To practice writing diary book 
• To compose an English poem 
• To compose an English short story 
• To prepare a small book which contain English poem and short story 
 
To communicate through graphics/visual 
• To understand and explain the concept of caricature 
• To analyze and to contain idea in the drawing sketch 
• To use line and fills of the drawing 
• To combine the object as well as drawing in a “canvas” 
• To conduct technique of animation in the drawing which has been made 
• To make a caricature/animation 
 
To create a digital graphics work  
• To understand and explain the concept of graphics 
• To set up a poster 
• To make a banner  
• To design invitation card 
• To make poster, banner or invitation card 
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To understand the skills needed in work  
• To conduct brainstorming regarding the important capability in the work 
• To obtain data regarding the important capability from the local company 
• To insert the said data into database application 
• To make/prepare presentation regarding the important capability in the work 
 
 
To understand the particulars and details of  business world 
• To find information regarding vacancy available in the labor market 
• To determine and set up/stipulate the short term and long term objectives 
• To prepare strategy to achieve the said career/work desired 
• To make and present the objective, strategy and dream career 
• To collect data of each local company based on the type 
 
To carry out a survey on job data of local company  
• To collect data of each company on worker/number of workers, gender of worker, 

level of income, etc.) 
• To make query of the company based on the type, number of workers, gender of 

worker, level of income, etc.) 
• To make a database of local company 
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GGlloossssaarryy 
Dictionary of Computer Terms 

http://dhani.singcat.com/IT/dict.php 
 

Access Time - The term for measuring the accessing speed in a storage Media or 
Memory. The access time on a Hard Disk and CD-ROM is measured using the 

milisecond unit, while on memory the nanosecond unit is used. The smaller the figure of 
access time, the higher the speed. 
 
AGP - Accelerated Graphics Port. The Interface developed by Intel to support high speed 
graphics processing on a Pentium II processor and higher. (See diagram)  
 
Algorythm - The logical path of human thinking which is transformed into steps that are 
later implemented in the form of instruction lines in a programming language to produce 
a software.  
 
AT - Advanced Technology. The name for a PC using the Intel 80286 processor and its 
compatibles.  
 
ATA - AT Attachment, also known as IDE (Integratede Drive Electronics), is a harddisk 
interface design with an integrated controller in it. The ATA design is later further developed 
into the ATA-2 and Ultra ATA by adding various plus features, among which is the 
capability to provide information on harddisk characteristics for plug and play purposes 
and the acceleration of access speed.  
 
ATA-PI - ATA Packet interface. is the standard design for a device such as a CD-ROM and 
a tape drive connected to the conventional ATA (IDE) interface.  

BASIC - A high level programming languagedeveloped at Dartmouth College 
(Hanover, N.H.) in 1964 for use on mini computers. The inventor, Thomas E. 

Kurtz and John G. Kemeny composed Basic as a simple programming language meant for 
those learning computer for the first time. In the 1980s, Bill Gates (now head of Microsoft) 
succeeded to develop Basic for a PC platform. At present Basic has developed into the 
Visual Basic language for Windows basedprogramming.  
 
BIOS - Basic Input/Output System. is a program which facilitates input and output 
operation on a computer.  
 
Bottleneck - SUMBATAN at the neck of the bottle. The term used to refer to a 
disturbance taking place whenever the output ware does not match the performance of 
the processing ware leading to the slowing of the system’s working as a whole.  
 
Bug - The term for a defect/ an error in the software and hardware which causes 
malfunctioning. The process to find and overcome a bug is called debugging.  
 

A 

B 
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Bus - The main path of data stream between the processor and the other components 
(such as sound card, video card, memory) on the motherboard. 

C - The programming language first developed by Dennis Ritchie at Bell Laboratories 
in 1972. The C language is known to be efficient and most portable so as to be 

useable with various platforms. In the mid 1980s, Bjarne Stroustrup of Bell Laboratories 
developed the C++ language by adding the OOP capability.  
 
Cache - In hardware technology, this term usually refers to high speed memory which 
bridges data flow between the processor and the main memory (RAM) which usually has 
lower speed. The use of a cache is meant to minimize any occurrence of bottlenecks in 
the data flow between the processor and the RAM. Whereas in software terminology, 
this term refers to the place of temporary storage for oftenly accessed files (usually 
applied in a network). 
 
CAD - Computer Aided Design. 
 
CD-R - Compact Disk Recordable. A storage device of the CD-ROM type which is 
designed to be writeable by using a special drive ware. Unlike a CD-ROM, in which the 
data are directly written at the time the CD piece is produced, CD-R is sold in blank 
condition. The recording process is done with the help of a special software and termed 
as burning. The data recorded on it has the quality of WORM (Write Once Read Many), 
meaning that data can only be written once and subsequently can be read only. 
 
CD-ROM - Compact Disk Read Only Memory. An optical storage media that physically is 
identical with a CD-Audio which has previously been used as a storage of voice 
recording. This media is read using a CD-ROM Drive ware. The access speed of a CD-
ROM drive is usually measured by the following unit of speed, 1x speed equivalent to 150 
kBps (kilobyte per second), i.e. the reading speed of an Audio CD ware. 
 
CD-RW - Compact Disk Recordable and Rewriteable. A further development of the CD-R 
media in which the data recorded on the CD-RW disk can be added, changed, or erased 
at any time. 
 
Chipset - Chips on the mainboard serving to bridge data stream between the subsystems 
of a PC. A chipset is divided into two main chips called the northbridge and the southbridge. 
The northbridge chip functions to control data stream from the processor, AGP port, and 
the main memory system. Meantime, the southbridge chip controls data flow from the PCI 
bus, hard disk interface, and other external wares. 
 
CHS - Cylinder Head Sector. The conventional method to address a certain sector on a 
harddisk.  
 
CISC - Complex Instruction Set Computing. A series of instructions built-in in the processor 
that consists of complex commands. The available instructions make it easy for 
programmers to develop applications for the CISC platform. On the other hand, the 
numerosity of instruction in the CISC could reduce its speed. The CISC constitutes the 
converse of a RISC, which is usually used in the family of processors for a PC (Intel, 
AMD, Cyrix). 

C 
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Clock Set - The speed of a processor which is a multiplication of a value by the FSB. 
 
CPU - Central Processing Unit. The central processing unit in a computer. Generally a CPU 
is interpreted as the box in which the whole peripherals are assembled. However, in the 
technical sense, a CPU refers to the processor installed in a computer system. 

Database - A collection of information arranged in such a way as to be accessible 
by a certain software. A database is arranged into parts called fields and records 

stored in a file. A field constitutes the smallest unit of the information within a database. 
A collection of interrelated fields will make up a record.  
 
DDE - Dynamic Data Exchange.  
 
DDR-RAM - Double Data Rate-Random Access Memory. A RAM type that works with a 
higher speed than SDRAM. Usually used on a PC with the Pentium 4 processor or an 
equivalent.  
 
DLL - Dynamic Linking Library. 
 
DOS - Disk Operating System. An operation system which is used in most PCs until the 
mid-1990s era. DOS was first released by the Microsoft company in 1981 as a standard 
operation system for the IBM-PC. The last version of DOS was MS-DOS 6.3 which was 
launched in 1993. Lately, the popularity of DOS has begun to recede and it is being 
replaced by more dependable operation system such as Windows or UNIX.  
 
DPI - Dot Per Inch. The scale used to measure the level of resolution of a printer’s 
printing output and also of a monitor’s display. The higher the DPI, the finer will the 
display appears. 
 
DVD-ROM - Digital Versatile Disk-Read Only Memory. A storage media type with a 
physical form resembling a CD-ROM but has a much higher capacity and the capability 
to store data on both its sides. A DVD-ROM is usually used to store multimedia files of 
big sizes. 

EDO - Enhanced Data Out. A memory module possessing a higher speed than 
SIMM. 

 
EISA - Extended Industry Standard Architecture. A standard architecture developed by 
several computer companies (Compaq, AST, Zenith, Tandy, etc.) to standardize the 32-
bit operation. 
 
Ethernet - The protocol usually used in a LAN. 

File - In computer technology, this term bears the understandanting of an 
electronic dossier containing information and kept in a storage. 

 
Freeware - The software which is distributed gratis by the maker.  
 
FSB - Front Side Bus. The speed of a system bus on the mainboard. For example, the 

D 

E 

F 
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Pentium 4 processor has an FSB of 400 MHz (4 x 100 MHz) while AMD Athlon 
Thunderbird has an FSB of 266 MHz (2 x 133 MHz). 

GIF - Graphics Interchange Format. A standard format for a compressed graphic file 
(image). A GIF file applies the non-lossy compression making it more suitable for 

application in a not too complex image with a small number of colors. For a more 
complex image image, usually the JPEG format is used. 
 
GIS - Geographic Information System. A geographic based information system. 
 
GUI - Graphical User Interface. The term used to refer to the display is a graphics based 
program.   

Hardware - This notion comprises the whole peripheral wares together with the 
supporting wares in a computer system. 

 
Hyperthreading - The technology developed by Intel for the Pentium 4 processor 
family with the speed of 3 GHz and above. This technology enables the different 
elements of a processor—such as the integer unit, graphic processing, and floating point 
for a complex calculation—to be active simultaneously. Intel claims this technology is 
capable to step up system performace from 25 to 30 percent. 

IC - Integrated Circuit or chip. A microelectronic series in the form of semiconductor 
made up of a number of big transistors and other components. An IC is packed in 

a square piece of silicon wafer (called “die”). The IC can be grouped into analogue, 
digital or hybrid (mixture) ICs. 
 
IDE - Integrated Drive Electronics. See ATA. 
 
Interface - In software terminology, an interface could mean a display or the way the said 
software interacts with the user. In hardware terminology, interface refers to the standard 
used by a certain peripheral to relate with another peripheral in a system. 
 
ISA - Industry Standard Architecture. An expansion slot of 8 bit and 16 bit used on an XT 
and AT computer. (See diagram) 

JPEG - Joint Photographic Experts Group. An image file format compressed by the 
lossy methode. This format is suitable for application on a complex image file with a 

great number of colors. 

Compression – A technique of data placement such that a file is obtained with a 
size smaller than the original. Compression works by seeking recursive patterns on 

the data and replace them by a certain marker. There are two types of the compression 
methode, non-lossy and lossy. A compression of the non-lossy characteristics ddoes not erase 
the information bits in the original file so that it suits for application on a document file. 
On the contrary, the lossy methode erases information which is considered insignificant. 
Usually this technique is applied on big size multimedia files, for example on the JPEG 
(image), MPEG (video and MP3 (audio) files. 
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LAN – Local Area Network. A computer network that is inter-connected within a 
local scope (unaccessible to other network). Several LAN network can be 

connected through a certain hierarchy such as to form a WAN (Wide Area Network).  
 
LBA – Logical Block Address. One of the methodes of sector addressing on a harddisk which 
is using the numbering methode, from 0 as the address of the first sector on the harddisk. 
 
Linux – An operating system which is an open source variant of UNIX distributed free 
of charge under the GNU General Public License (GPL). Linux is developed by individuals 
as well as groups wroking voluntarily. The developers of Linux utilize the Internet to 
exchange codes, report bug, and resolve any problems. Anyone interested is invited to 
join in the development of Linux. Linux was for the first time created by Linus Torvalds 
at the University of Helsinki, Finland. Then Linux is further developed through the 
assistance of many programmers an UNIX experts on the Internet. Now Linux can be 
obtained through generally used public distributions, for example RedHat, Debian, 
Slackware, Caldera, Stampede Linux, Turbo Linux and so on. The applied kernel is the 
common Linux, while the differences are only the attached application package, directory 
system, init style, et cetera.  

Mainboard – Also commonly called motherboard, a panel for the main assembly on 
a computer where the processor, memory and other peripherals are installed. (See 

diagram)  
 
MBR – Master Boot Record. A sector on the harddisk located on the cylinder 0 head 0 sector 1 
(or known as LBA 0).  
 
MCA – Micro Channel Architecture. A bus developed by IBM in 1987. Used on a number 
of PS/2 computer models.  
 
MIDI – Musical Instrument Digital Interface. A standard for connecting a computer with an 
electronic musical instrument and the processing of special effects.  
 
MMX – See Pentium  
 
Modem – Modulator and Demodulator. A ware for the purpose of data communication 
between computers using the telephone media as channel. (See diagram)  
 
Motherboard – See Mainboard  
 
MP3 – MPEG layer 3. A format of compressed digital audio recording. The MP3 format 
is compiled based on an algorythm developed by Karlheinz Brandenburg of the 
University of Fraunhover, Germany. This technology enables a format of recording 
digital audio with a quality close to that of a CD of relatively small size so as to be 
distributeable and downloadable via the Internet.  
 
MPEG – Motion Picture Expert Group. A popular name for the compressed multimedia 
file. In the beginning MPEG was used for the compression of audio-video data on a 
VCD, but later is developed into the MP3 format.  
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OLE - Object Linking and Embedding.  
 

OOP - Object Oriented Programming. A programming technique which is oriented to the 
object. 
 
Open Source – A software distributed together with the source code. This software is free 
for modification by any user in adaptation to his need. 

Pascal – A high level programming language developed by Niklaus Wirth in 
Zurich at the close of the 1960s through the early 1970s. Pascal is a structured 

programming language, often used as the initial means of studying computer 
programming language. The Pascal version much used is Turbo Pascal, created by Borland 
International, which works in the environment of a DOS operating system. Lately, Pascal 
has also been developed as a visual programming language in the environment of the 
Windows operating system by the name Delphi. 
 
PC – Personal Computer. A personal computer comprising all kinds of computer system in 
general use today for personal or business purposes. 
 
PCI – Peripheral Component Interconnect. A bus with a high speed developed by Intel to 
support a computer which is based on a processor of the 486 series and above. (See 
diagram) 
 
Pentium – A trademark for the processor of the fifth generation produced by Intel. The 
Pentium processor was first developed in the vicinity of 1993 with the speed of 60 Mhz 
and 66 Mhz. In 1997 Intel released the Pentium MMX (Multimedia Extension) which is 
supplemented with special instructions for multimedia data processing. The Pentium 
MMX is capable of working at the speed of up to 233 MHz. Presently the Pentium 
Processor has developed into the 4th generation (Pentium 4) with a speed exceeding 1 
GHz (1000 Mhz). 
 
Port – An interface that enables a PC to send and receive information to and from an 
external ware, such as a printer or a modem. A PC generally has the serial, parallel ports 
and several USB ports. 
 
Processor – An IC that controls the whole running of a computer system. (See diagram) 
 
Prolog – The acronym of Programming in Logic. A high level programming language 
developed by French scientists in the 1970s era. Prolog is usually used to develop an 
application that needs knowledge processing, a kind of an expert system and artificial intelligence.  

RAM – Random Access Memory. The physical memory installed on a PC. 
 

ROM – Read Only Memory. Also known as static memory, that is a physical memory 
which can only be read. In a computer, the ROM is usually used to store the BIOS 
configuration. 
 
RISC – Reduced Instruction Set Computing. A series of built-in instructions on a processor 
which is made up of briefer commands compared with CISC. RISC has an advantage in 
matter of speed so that many are being used for applications needing intensive 
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calculations. The RISC concept was first developed by IBM in the 1970s era. The first 
computer to use RISC is the IBM 807 mini computer introduced in 1980. Today, RISC is 
used on the processors family made by Motorola (PowerPC) and SUN Microsystems 
(Sparc, UltraSparc). 

SCSI – Small Computer Systems Interface. The standard in connecting peripherals to 
the computer by using an interface applying the SCSI command. The SCSI 

standard can be distinguished into SCSI (SCSI1) and SCSI2 (the SCSI wide and the SCSI 
wide and fast). SCSI2 is the newest version of SCSI which connects various peripherals 
such as CD-ROM and Tape Drive. 
 
SDRAM – Synchronous Dynamic Random Access Memory. A memory module (RAM) with a 
higher clock speed than SIMM or EDO. Usually used on processors of the newest 
generation. This module is usually sold with a certain clock bus specification, e.g. 
32MB/133Mhz, meaning an SDRAM with a capacity of 32 MB which works on an FSB 
of 133Mhz. A high clock bus is used whenever the SDRAM is installed on a PC with a 
new generation processor that also works on a high FSB but not affecting in any way any 
machine having an old and low FSB. SDRAM is packed in a 172 pin module.  
 
Server – A computer that serves as a network “servant”. A server manages the traffic of 
data in a network and provide resource useable by another computer connected within 
the network. 
 
Shareware – A software distributed free for trial by user-to-be during a certain period. 
Should the user-to-be be interested, he may buy the commercial version.  
 
SIMM – Single Inline Memory Module. A Memory module generally used by PCs from the 
286 type up to the Pentium of early generation. Physically, SIMM is packed in a module 
of 30 pins and 72 pins. 
 
Software – This term also comprises a program made for running on a certain hardware.  
 
SQL – Structured Query Language. A programming langguage designed especially for 
sending a query command (accessing data based on certain addressing) into a database. 
Most database software avaliable today can be accessed through SQL. Every specific 
application can implement the SQL with some differences, but the whole SQL database 
does support the existing standard subset.  
 
Storage – A data storage medium on a computer. Storage is distinguished from removable 
storage, a data storage medium that can be moved at any time, and non-removable storage, a 
storage medium of a fixed nature. Floppy disk (disket) is grouped into the removable storage, 
while a harddisk is in the group of non-removable storage. 

Trojan horse – A computer pgrogram conataining hidden routines, usually 
destructive, running in the background while the main program is run. The Trojan 

horse usually manifests itself in an attractive program to be as a trap on the user in order 
to interest him to run it. Although its working resembles a virus, the Trojan horse 
(usually) is not designed to infect a program. 
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UNIX – One of the popular operating systems for the server these days. UNIX 
was developed by Ken Thomson and Dennis Ritchie around the year 1969 at 

AT&T Bell Laboratories. Initially, this system was developed in the assembly language. 
But then because of its low portability (so that it was difficult to be developed in other 
systems) Ritchie developed a new programming language called the C language (circa 
1972). The UNIX system later developed in the universities environment and there 
began emerging variants of the UNIX system. The major variant is UNIX BSD and 
UNIX System V. 
 
USB – Universal Serial Bus. The technology that enables the easy installation of a peripheral 
with a bandwith bigger than the serial or parallel port. 
 
Upgrade – The term for any act of replacement partially or wholely of the system ware 
with a similar ware which has a higher specification.  

Virus – The term for a computer program that has a capability to self-multiply 
through the method of inserting its own program into another file without human 

interference. Resembling the biological virus, the computer virus can spread into the files 
in a computer, or even infect files in another computer, both through the network and 
through the exchanges of files. A virus can contain certain routines injected by a virus 
programmer. These routines can contain destructive commands or just to display a 
message.  
 
VLB – Vesa Local Bus. A 32 bit extension possessing a high speed for ISA. VLB is 
promoted by VESA (Video Electronic StandardAssociation). 

WAN – See LAN 
 

Worm – A computer virus type that does not infect a program. A worm self-duplicates 
and infects other computers (usually by taking advantage of a computer network). 
Although a worm does not spread through a program, it can also assume a destructive 
characteristics.  

XT – eXtended Technology. The term for a computer that uses the Intel 8086/8088 
processor. 

 
If the word searched is not found in the above list of terms, open 
http://www.pnri.go.id/official v2005.4/glossary/computer/index.asp?search keyword
=&submit=Lihat+Hasil&box=list  
enter the keyword for the search, then press the button “See Result”. 
  
 
 
 
 
 
 
 
 

U 

V 

W 

X 



 
 

20 

Content Matrix 
Level of difficulty, age target and objectives. 

INFORMATION AND COMMUNICATION TECHNOLOGY FOR LIFE, LEARNING AND WORK  
Unit Theme/Topic Age 

Target 
Level of 

Difficulties
Objectives 

1 Computer and Internet Activities 
 Activity 1: 

Web Quest/Treasure 
Hunt 
 

All 
Grade 

 

** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and Skills to think critically as well as able to demonstrate their Skills in using the 
technology: 
• To explain the hardware, software as well as the function  
• To conduct computer basic operation 
• To scrutinize and select strategy of search in the internet to obtain information 
• To prepare and process report and presentation 
• To use computer for communications with another person 
• Micro Teaching (Final Project of Activity 1) 
Source from Internet: 
http://www.teachersfirst.com/summer/webquest/quest-a.shtml 
http://school.discovery.com/schrockguide/webquest/webquest.html  
http://adulted.about.com/cs/computerliteracy/a/computerbasics.htm  

 Activity 2:  
Making personal 
web  
 

Grade 9 
 

*** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and Skills to solve problem, make decision as well as actualizing oneself.  They are also 
expected to demonstrate their Skills in using the technology: 
• To understand the concept of website 
• To determine the hierarchy or personal web map 
• To arrange and manage the content of personal web 
• To determine the design and layout of personal web 
• To make personal web (Final Project of Activity 2) 
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Unit Theme/Topic Age 
Target 

Level of 
Difficulties

Objectives 

• To store/keep and appear personal web in internet and/or intranet. 
Source from Internet: 
http://www.freewebs.com/buatsite/index.htm 
http://www.woodlands-junior.kent.sch.uk/website/getting started.htm 

 
 

Activity 3:  
Making school web 
(online or intranet) 
 

Grade 9 
 

**** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and Skills to solve the problem, cooperate, as well as making decision.  The youth is also 
expected to demonstrate their Skills in using the technology: 
• To set up group and share duty 
• To plan of Making school website 
• To determine hierarchy or school web map 
• To arrange and manage the content of school web 
• To determine the design and layout of school web 
• To make school web (Final Project of the Activity 3) 
• To store/keep and appear the school web in internet and or intranet. 

Source from Internet: 
http://www.freewebs.com/buatsite/index.htm 
http://www.woodlands-junior.kent.sch.uk/website/getting started.htm  

2 ICT for Learning Activities  
 Activity 1:  

Mind Map for 
Understanding 
 

All 
Grades 

 

*** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and Skills to solve the problem, organize thought/concept, as well as making decision.  
The youth is also expected to be able to demonstrate their Skills in using the technology: 
• To understand and explain the concept of mind map 
• Understanding the rules of mind map 
• To use the application of mind map 
• To make a mind map on one of the topics of subject/Project at the end of Activity 1) 
Source from Internet: 
http://www.sekolahindonesia.com/sidev/NewDetailArtikel.asp?iid artikel=16&cTipe art
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Unit Theme/Topic Age 
Target 

Level of 
Difficulties

Objectives 

ikel=2  
http://www.sinarharapan.co.id/ekonomi/mandiri/2002/04/3/man01.html  
http://cybershopping.cbn.net.id/book2.asp?postid=131  

 Activity 2:  
Flash Card for 
Memorizing 
 

All 
Grades 

 

** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and Skills to solve the problem, organize thought/concept, as well as making decision.  
The youth is also expected to be able to demonstrate their Skills in using the technology: 
• To understand and explain the concept of flash card 
• To see and study flash card which has existed in internet 
• To make flash card for one of the lessons (Final Project of Activity 2) 
• To share the flash card with the world 
Source from Internet: 
http://www.flashcardexchange.com 
http://www.flashcardmachine.com  
http://www.teach-nology.com/arcade/math/  

 Activity 3:  
Animation of science 
process 
 

All 
Grades 

 

*** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and skills to think critically.  The youth is also expected to be able to demonstrate their 
skills in using the technology: 
• To find out the source of animation of science process in the internet 
• To combine the animation of science process with the learning project 
• To conduct micro teaching in front of the class on the science process through the 

animation (Final Project of Activity 3) 
Source from Internet: 
http://www.e-dukasi.net 
http://www.edumedia.fr  

 Activity 4:  
Making accounting 
system using 

All 
Grades 

 

*** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and skills to solve the problem, cooperate, as well as making decision.  The youth is also 
expected to be able to demonstrate their skills using the technology: 
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Unit Theme/Topic Age 
Target 

Level of 
Difficulties

Objectives 

worksheet 
application 
 

• To understand and explain the concept of basic equation of accounting 
• To input number into the worksheet application 
• To make operation of simple addition 
• To use the function in processing the number 
• To make graph from the existing data 
• make a cooperative accounting system/school canteen using the worksheet application 

(Final Project of Activity 4) 
Source from Internet: 
http://www.ilmukomputer.com/umum/tua-excel.php 
http://www.e-dukasi.net/modul.php?s=2&set=1&mp=16&nm=akuntansi  
http://www.belajar-gratis.com/v10-panduan-pelajaran-akuntansi.html 

 Activity 5:  
Collaborative 
Learning 
 

All 
Grades

** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and skills to solve the problem, cooperate, as well as making decision.  The youth is also 
expected to be able to demonstrate their skills in using the technology: 
• To understand and explain the concept of collaborative learning 
• To set up a dynamic group 
• To join in the community which has existed 
• To set up a discussion group in learning materials (Final Project of Activity 5) 
Source from Internet 
http://www.studygs.net/indon/cooplearn.htm  
http://ekuator.com/forummizan/index.php 
http://ksi.plasa.com  

3 Language and Communication Activity 
 Activity 1:  

Writing and printing 
a school newspaper 
 

All 
Grades 

 

*** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and skills to solve the problem, cooperate, think critically as well as making decision.  The 
youth is also expected to be able to demonstrate their skills in using the technology: 
• To understand and explain the concept of printing 
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Unit Theme/Topic Age 
Target 

Level of 
Difficulties

Objectives 

• To set up a newspaper club 
• To organize the content 
• To prepare and combine the content and supporting drawing 
• To print a school newspaper (Final Project of Activity 1) 
Source from Internet: 
http://www.komputeraktif.com/langkah.asp?tahun=2004&edisi=90&file=langkah2  

 Activity 2:  
Preparing and 
publishing English 
poem and short story 
booklet 
 

All 
Grades 

 

*** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and skills to solve the problem, cooperate, think critically as well as analyze.  The youth is 
also expected to be able to demonstrate their skills in using the technology: 
• To understand and explain the concept of poem and short story 
• To practice writing diary 
• To compose an English poem 
• To compose an English short story  
• To prepare a booklet which contain English poem and short story  (Final Project of 

Activity 2) 
Source from Internet: 
http://andreasharsono.blogspot.com/2005/02/cara-belajar-menulis-bahasa-inggris.html 

 Activity 3:  
Caricature regarding 
school activity, social 
or local problem 
 

All 
Grades 

 

*** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and skills to solve the problem,  think critically as well as skills to analyze.  The youth is 
also expected to be able to demonstrate their skills in using the technology: 
• To understand and explain the concept of caricature 
• To analyze and to contain idea in the drawing sketch 
• To use line and content of the drawing 
• To combine the object as well as drawing in a “canvas”, 
• To conduct technique of animation in the drawing which has been made 
• To make a caricature/animation (Final Project of Activity 3) 



 
 

25 

Unit Theme/Topic Age 
Target 

Level of 
Difficulties

Objectives 

Source from Internet 
http://dana-studio.tripod.com/artikel fl c.htm  
http://www.babaflash.com 
http://www.cartoonsmart.com 

 Activity 4:  
Digital Graphics 
 

All 
Grades 

 

*** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and skills to solve the problem, cooperate, as well as making decision.  The youth is also 
expected to be able to demonstrate their skills in using the technology: 
• To understand and explain the concept of graphics 
• To set up a poster 
• To make a banner  
• To design invitation card 
• To make poster, banner or invitation card (Final Project of Activity 4) 
Source from Internet 
http://www.gfxindo.com 
http://www.fotografer.net  

4  “Go Toward My Dream Career” Activity 
 Activity 1:  

Skills in the 
Workplace 
 

All 
Grades 

 

*** 
 

By following this activity, the Youth is expected to obtain the knowledge, understanding 
and skills to solve the problem, cooperate, and think critically as well as making decision.  
The youth is also expected to be able to demonstrate their skills in using the technology: 
• To conduct brainstorming regarding the important capability in the work 
• To obtain data regarding the important capability from the local company 
• To insert the said data into database application 
• To make/prepare presentation regarding the important capability in the work (Final 

Project of Activity 1) 
Source from Internet: 
http://pembelajar.com/wmview.php?ArtID=313  

 Activity 2:  All *** By following this activity, the Youth is expected to obtain the knowledge, understanding 
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Unit Theme/Topic Age 
Target 

Level of 
Difficulties

Objectives 

My Dream Career 
 

Grades 
 

 and skills to solve the problem, cooperate, and think critically as well as making decision.  
The youth is also expected to be able to demonstrate their skills in using the technology: 
• To find information regarding vacancy available in the labour market 
• To determine and set up/stipulate the short term and long term objection 
• To prepare strategy to achieve the said career/work desired 
• To make and present the objective, strategy and dreamt career (Final Project of 

Activity 2) 
Source from Internet: 
http://www.ekarir.com  
http://www.karir.com  
http://www.jobsdb.com/ID  
http://www.e-bursa.com 

 Activity 3: 
My Local Company 

All 
Grades 

 

*** By following this activity, the Youth is expected to obtain the knowledge, understanding 
and skills to solve the problem, cooperate, think critically, analyze  as well as making 
decision.  The youth is also expected to be able to demonstrate their skills in using the 
technology: 
• To collect data of each local company based on the type of company 
• To collect data of each company on worker/number of workers, gender of worker, 

level of income, etc.) 
• To make query of the company based on the type, number of workers, gender of 

worker, level of income, etc.) 
• To make a database of local company  (Final Project of Activity 3) 
Source from Internet: 
http://www.ilmukomputer.com/umum/agus-access.php 
http://www.pcmedia.co.id/detail.asp?Id=279&Cid=23&Eid=7  
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CCoommppuutteerr  aanndd  
IInntteerrnneett  
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UUnniitt  OOnnee  
CCoommppuutteerr  aanndd  IInntteerrnneett  

 
Participants: Teenagers who do not want to be left behind with the developments in 
information and communication technology. They want to know further about 
everything relevant with the world of computer and internet. 
 
Unit One: Computer and Internet introduce the participants about the history of 
computer, describe about its hardware, its software, performing basic computer 
operation, selecting and choosing search strategy in the internet in order to find 
information, to write and process report and presentation, using computer and internet 
to communicate with other people, and the participants will learn how to make a website 
in several easy steps. 
 
The main objective of this unit is to provide a basic understanding on information and 
communication technology, particularly on Computer and Internet. The skill which the 
participants will get is the skill in putting into application ICT in their life and work 
environments. The participants will be introduced with the source of knowledge which is 
called internet. Almost all activities in unit one are related with internet. 
 
Three activities in this Unit One introduce the skill of ICT to the participants so that they 
will be able to work within a society that depends on technology. 

• Web-Quest on ICT Skill 
• Creating Personal Website 
• Creating School Website 

 
All activities have been designed to give direct experiences for participants. Skills that will 
be sharpened are the skills they will need in school, workplace, society, and personal life. 
 
Assignments and activities provided in this toolkit are adjusted to conditions in 
Indonesia. As a result, participants will know more about situations and conditions in 
Indonesia. 
 
All activities provided in the ICT toolkit are interactive, of which all activities, step by 
step, will be done by participants such as discussion, brainstorming, presentation, 
computer practice, research work and data analysing. 
  
Assessment is a process from beginning to the end. All participants’ involvement in all 
activities must be recorded. 
 
Each activity will end by making a final project. This final project can be worked on 
during outside of the class hour.  
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AAccttiivviittyy  11  
WWeebbQQuueesstt  oonn  IICCTT  SSkkiillllss 

IInnttrroodduuccttiioonn 
This activity will take the participants into exploring the internet. This exploration will be 
guided through by following several activities. By so doing, the participants will no longer 
need to seek in the online search engine. 
What will be explored is the Information and Communication Technology (ICT) skill. 
This skill is obtained through participating in the following activities: 
9 Describing computer functions, its hardware and its software. 
9 Performing basic computer operation. 
9 Going through internet exploration. 
9 Writing and editing report and presentation. 
9 Using computer to communicate with other people. 
 

   OObbjjeeccttiivveess  aanndd  LLeeaarrnniinngg  OOuuttccoommeess    
The objective of this activity is to arouse and increase the participants feeling of interest 
in exploring the internet. Aside from that, this activity will also arouse participants 
learning interest in relation with various things. In the first stage, the exploration will be 
focused on skill in ICT. Almost all basic skills in the use of ICT are included in this 
activity. However, when it comes to how far one can get during learning process, this will 
depend on each of the participants’ interest. 
 
By following this activity, the participants are expected to be able: 

• To be aware of the benefits of using internet in searching for knowledge. 
• To know the basic skills in the use of Information Technology and 

communication. 
• To possess high level of interest and desire in further learning and digging 

Information in the internet. 
• To participate in Micro Teaching in relation with one skill of ICT (finishing 

project one). 
 

      

AAggee  TTaarrggeett::    
This activity is intended for all grades (VII, VIII, IX) 
 
��� LLeevvell  oof  DDiiffffiiccuulltyy  
The level of difficulty of this activity is three stars. This means the difficulty level of this 
activity is above average. 
 

IX VIII VII 
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    LLiinnkkss  ttoo  tthe  Currriiccuulluumm     
ICT Competency 
This activity can be used to intensify the Competence Standard (SK) and the Basic 
Competence (KD) of ICT subject.  Specifically, the SK, KD which are contained are: 

Grade VII,  Semester 1  

Competence Standard Basic Competence 

1. Understanding the use of information and 
communications technology and future 
prospect. 

 

 

   

 

 

1.1 Identifying various equipment of information and 
communications technology 

1.2 Describing the history of development of the 
information and communication technology from the 
past to the present 

1.3 Explaining the role of the information and 
communication technology in daily life 

1.4 Identifying various benefits and uses of the 
information and communication technology 

1.5 Identifying various negative impact of using the 
information and communication technology 

2.    Familiarizing the basic operation of 
computer equipment. 

 Activating the computer in accordance with the 
procedure 

 Turning off the computer in accordance with the 
procedure 

 Conducting the basic operation in a operating system 
systematically 

Grade VII, Semester  2 

Competence Standard Basic Competence 

2. Practicing the basic skill of computer  

 

 Identifying various components of the computer 
hardware 

 Identifying various software of application program 

 Understanding the usefulness of several program of 
application 

 Practicing one application program 

Grade VIII,   Semester  1 

Competence Standard Basic Competence 

1. Using word processor software to present 
information 

  

 Identifying the menu and icon n the software of word 
processor 

 Explaining the function of menu and icon in the work 
processor program 

 Using menu and main icon in the software of word 
processor 

 Creating document on simple word processor 
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Grade VIII,  Semester  2 

Competence Standard Basic Competence  

2. Using numbers processor software to 
present information 

 Identifying the menu and icon the number processor 
software 

 Explaining the function of menu and icon in the 
number processor program 

 Using the menu and icon in the number processor of 
the software 

 Creating document on simple numbers processor 

Grade IX ,  Semester 1 

Competence Standard Basic Competence 

1. Understanding the basics of 
internet/intranet use 

 Explaining the basic understanding of internet/intranet 

 Understanding the basics of network system in 
internet/intranet 

 Identifying the size of speed of internet access 

 Identifying the hardware used in the access of 
internet/intranet 

 Conducting various ways to obtain connection of 
internet/intranet 

Grade IX ,  Semester  2  

Competence Standard Basic Competence 

2. Using Internet to obtain information 

 

 Demonstrating the access of Internet in accordance 
with the procedure 

 Identifying several information serious, which are 
available in Internet 

 Accessing various sites to obtain information, which is 
useful.  

 
Life Skills 
Also related to the development of life skills, as follows:  
Learning Skills Searching 

Information  
Decision Making Problem 

Solving 
Self 

Consciousness  
Vocational 

9 9 9 9 9 9 

 

   TTiimmee::  
Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs. 
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    RReeqquuiirreedd  MMaatterriiaalls  
• Blackboard 
• Stationary 
• Photocopy of “ICT Skills Internet Address” sheet to be distributed to the 

participants 
 

  IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonnss  
TTeecchhnnooloogyy 
• Computer Unit which has been installed with the following applications: 

o Internet Explorer (or any other browser) 
o Acrobat Reader 
o Mircrosoft Office Word 

Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (if permissible) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 

   AAsssseessssmmeenntt    
The skill in using ICT is often born because of a person’s ability in motivating himself to 
learn without being continuously accompanied by a teacher or facilitator. In this one 
particular activity, the participants are trained to understand a computer application only 
by reading it and discussing it with fellow members of one group. After this, the Micro 
Teaching will start. 
 
During the Micro Teaching, the followings are some of things that need to be attended 
to and perhaps should become points of consideration in assessment: 

• Answers given are correct or incorrect 
• Mastery of the materials 
• Ability in presenting the materials 
• Interactivity during presentation of the materials 
• Ability in troubleshooting 
• Etc. 

 
In order to be objective during assessment, pass the assessment matrix sheet to each of 
the participants, and let each of them evaluate the result of another participant’s work. 
 



USAID DBE3 Life Skills for Youth 33

 Step One:  Assigning Groups and Exploration assignments (15 
Minutes) 

    Notes for the Facilitator 
This activity will be more managed and performed without being guided by the 
facilitator. What the facilitator should do in this context is to organize the 
participants into groups and manage to control the time to be as allocated. 
On the first step, let all participants be divided into several groups. Try seeing, in 
the best way you can, that the division into groups would please all participants in 
one group and that each participant has varying degrees of initial ICT ability. 
When all participants have been organized into five groups, assign to each group an 
exploration assignment.  The assignment goes as follows (each group has a 
different assignment): 
1. What is the meaning of hardware, software and computer itself?  
 What must we do whenever we want assemble computer by ourselves?  
 What are the things to buy?  
 How can we install a computer’s operating system? 
2. When a computer has been successfully assembled, then installed with an 

operational system, how do you turn-on and turn-off the computer in 
accordance with its correct procedural steps? How do you change the time 
written in an operation system? How do you change the background and screen 
saver on a desktop? What are the ways in finding a file or a folder? 

3. Our computer will soon or has been connected with the internet. What are the 
necessary things you need to do to get connected with internet? How do you 
explore through the internet? When we have found the file we’re searching for, 
how do we retrieve and save keep it? How do you search for an article or a 
drawing in the internet? 

4. Now, we are going to write a report in relation with the assignment that we’ve 
carried out. How do you make a document? If we are going to write 100 
invitation letters how can we do that fast (Ref: mail merge)? How do you insert 
a picture, edit the text, and set columns etc., in a document? How do you write 
a presentation document, giving it a moving effect and then exhibiting it? 

5. With the use of internet, we are able to communicate with anyone, wherever 
and whenever they are. What must we do so that we can communicate like 
this? What is the meaning of e-mail, chatting, blogs and mailing list? 
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 Step Two: Begin to Explore and Study the Assignment Given 
(45 Minutes) 

    Notes for the Facilitator 
Distribute to each participant the sheet that is found at last part of this activity, but 
do it fractionally. After that, let them go through internet exploration in order to 
answer all the questions distributed earlier. Tell all the participants that the 
remaining 30 minutes will be used for micro teaching. Micro teaching is a teaching 
conducted on other group pertaining to what has been studied during the internet 
exploration. 
There are some files that need to be opened by using certain applications. For 
example, the file extension .pdf, this file must first be opened by using Adobe 
Acrobat Reader program (may be obtained in: 
http://www.adobe.com/downloads/). Or if the file is compressed (.zip), it must 
first be extracted by following this procedure. Right click at file extension .zip. 
Then choose Extract All. 

 

 Step Three: Techniques in composing Micro Teaching 
Presentation (30 Minutes) 

    Notes for the Facilitator 
After completing the internet exploration and then all materials and information 
needed in answering the questions have been gathered, the facilitator may begin to 
intercede the discussion with the participants on techniques of compositions which 
will be taught to other participants that they may know and understand about 
materials and information they are about to explore in the internet. Try the touch 
of attractiveness to fully catch the participant’s attention during the materials 
presentation. Also tell the participants that there will be an assessment by using the 
assessment sheet.  

 

 Step Four: Micro Teaching (30 Minutes) 

    Notes for the Facilitator 
During the micro teaching, each member of the group is to be separated and joins 
again in a new group which members consisting of “alumni” of each group that has 
been assigned with different internet exploration assignment. When a new group is 
formed, then the facilitator may begin the micro teaching, where each group 
member gives an answer to all questions distributed from the beginning of this 
activity. 
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   EExxtteennssiioonn  
The subject on this occasion is very numerous.  For that purpose, it is necessary to have 
several extensions, among others: 

• Outside the time of lesson, request representative of each participant to teach to 
another participant on what they have learnt. 

• If the school provides a computer laboratory as well as internet access, after to 
the surrounding community about computer course where the instructor is the 
participant. 

E 
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Handouts for Participant 1.1 
Internet Address on ICT Skills  

Describing the function of computer, hardware, and software 
� http://www.ilmukomputer.com/pengantar/romi-apaitukomputer.php  
� http://www.ilmukomputer.com/pengantar/ivansudirman-hardwarekomputer.php  
� http://www.ilmukomputer.com/pengantar/ivansudirman-softwarekomputer.php  
� http://www.oke.or.id/tutorial/Struktur Komputer.pdf  
� http://www.oke.or.id/tutorial/Yamta-Merakit%20Komputer[1].pdf  
� http://artikel.webgaul.com/Komputer/merakitkomputer.htm  
� http://www.ilmukomputer.com/umum/arifirwansyah-merakit.php  
� http://www.kompas.com/kompas-cetak/0209/06/iptek/mera31.htm  
� http://www.komputeraktif.com/laporan.asp?tahun=2003&edisi=57&file=laporan2  
� http://www.oke.or.id/tutorial/Troubleshooting Komputer.pdf  
� http://www.oke.or.id/tutorial/Pemeliharaan Komputer.pdf  
 
Conducting computer basic operation  
� http://ikc.cbn.net.id/umum/zaki-windows.php  
� http://ikc.cbn.net.id/umum/yuhefizar-komputer.php  
 
Internet searching 
� http://www.oke.or.id/tutorial/inter-intra.pdf  
� http://www.oke.or.id/tutorial/Panduan%20Internet.pdf  
� http://www.oke.or.id/tutorial/Cara%20Aman%20Menggunakan%20Internet.doc  
� http://www.ilmukomputer.com/umum/yadi-internet.php  
� http://ikc.cbn.net.id/umum/yuhefizar-internet.php  
� http://www.smu-net.com/main.php?act=ti&xkd=3  
 
Preparing and editing reports and presentation  
� http://ikc.cbn.net.id/umum/deddy-word.php  
� http://www.oke.or.id/tutorial/7Mencetak%20Dokumen.doc  
� http://www.oke.or.id/tutorial/6Membuat%20MailMaerge.doc  
� http://www.oke.or.id/tutorial/5Membuat%20tabel%20dan%20kolom.doc  
� http://www.oke.or.id/tutorial/4Mengunakan%20Tabulasi.doc  
� http://www.oke.or.id/tutorial/3Melakukan%20editing%20sederhana.doc  
� http://www.oke.or.id/tutorial/2Mengoperasikan%20Software%20Pengolah%20Kata.doc 
� http://www.oke.or.id/tutorial/1Mengoperasikan%20Software%20Pengolah%20Kata.doc 
� http://www.ialf.edu/kipbipa/papers/OudaTedaEna.doc  
� http://www.kmpk.ugm.ac.id/data/tutorial/Membuat%20Slide%20Presentasi.pdf  
� http://ikc.cbn.net.id/umum/yuhefizar-office.php  
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Using computer to communicate with other persons 
� http://www.oke.or.id/tutorial/Yamta~Email%20OKE.pdf  
� http://belajarblog.tk/  
� http://bebas.vlsm.org/v10/onno-ind-2/application/education/belajar-internet-

melalui-istilah-internet-04-2001.rtf  
� http://www.sony-ak.com/articles/2/apa itu blog.php  
� http://student.unpar.ac.id/milis/index.htm#Apa%20itu%20Mailing%20list?  
� http://balita-anda.com/milis.html  
� http://www.smu-net.com/main.php?act=ti&xkd=2  
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AAccttiivviittyy  22  
CCrreeaattiinngg  aa  PPeerrssoonnaall  WWeebbssiittee    

IInnttrroodduuccttiioonn 
This activity will explain how to create a personal website through several easy steps. 
Starting from an explanation about what is meant by a website, the hierarchy and map of 
a website, arrangement and planning of contents, design and layout; and how to save our 
website on the Internet or intranet to enable other people to see and read them when and 
wherever they may be. 

  OObbjjeeccttiivvee  aanndd  LLeeaarrnniinngg  OOuuttccoommeess    
By this activity the participants are expected to gain ability to create a personal website 
used to display all works done (portfolio) by the participants. The works can be poetry, 
short story, or tasks as well as works that they have completed. On this personal website, 
any achievements they have accomplished in the past, the ideals and goals of their lives et 
cetera, can also be displayed. 
 
The aim of creating the personal website is to enable the participants to collect and 
appreciate personal works. From the pieces displayed on the personal website, hopefully 
the potentials and talents of the participants can easily be seen. It is also hoped to 
facilitate their effort in creating a web based curriculum vitae which is fully filled for use 
in application for a job. 
 
By joining the activity, the participants are expected to be able: 

• To understand the website concept 
• To determine the hierarchy or map of a personal website 
• To arrange and manage the contents of a personal website 
• To determine the design and layout of a personal website 
• To create a personal website (Final Project of Activity Two) 
• To save and display a personal website on the Internet and/or an intranet 

 
 

    

AAggee  TTaarrggeett::    
This activity is intended for all grade IX  
 
��� LLeevveell  ooff  DDiiffffiiccuullttyy  
The level of difficulty of this activity is three stars. This means the difficulty level of this 
activity is above average. 
 
 
 
 

IVII
I

VII 
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    LLiinnkkss  ttoo  tthhee  CCuurrrriiccuulluumm     
ICT Competence 
This activity can be used to intensify the Competence Standard (SK) and Basic 
Competence (KD) of ICT subject. Specifically the SK, KD which are contained are: 
 
Grade IX ,  Semester 2 

Competence Standard Basic Competence 

2. Using Internet to obtain information 

 

2.1 Demonstrating the access of Internet in accordance 
with the procedure 

2.2 Identifying several information serious, which are 
available in Internet 

2.3 Accessing various sites to obtain information, which is 
useful.  

 
Life Skills 
Also related to the development of life skills, as follows: 
Working in small 

group 
Cooperation Decision Making Problem 

Solving 
Self 

Consciousness 
Vocational 

  9 9 9 9 

 

   TTiimmee::  
Minimum 2 (two) hours. For practice work, it can be adjusted to the needs. 
 

    RReeqquuiirreedd  MMaatteerriiaallss  
• Blackboard 
• Stationary 
• Photocopy of “8 Steps in Creating Website” sheet to be distributed to the 

participants. 
 

IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  TTeecchhnnoollooggyy 
• Computer Unit which has been installed with Microsoft FrontPage 2003 

application. 
Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (if permissible) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 
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   AAsssseessssmmeenntt    
Like  it is with  the  works  of  art, it will be  difficult  to  assess  a  website, the  creation  
of the respective  participants, for they  all differ in  style  and aesthetic   judgment  in 
design  and  website layout. 
 
However, there are technical matters that should be heeded and could be used as material 
of assessment: 
• File management (e.g. keeping prints in print folders, naming files, etc.) 
• Aptitude to follow  instructions or ready  steps 
• Good  website navigation 
• Coordination of layout, text, animation, etc. 
• Size  of web sheets 
• Overall  design  (web  usability); 
• Creativity 
• Etc. 
 
In order to be objective during assessment, pass the assessment matrix sheet to each of 
the participants, and let each of them evaluate the result of another participant’s work.
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    Step 1: In depth Understanding of the Website (15 Minutes) 
 

    Note for the Facilitator 
If access to the Internet is available, ask the participants to open the web page 
http://www.amperaweb.com. Amperaweb is an Indonesian owned webhosting 
company. On it are found a number of tips and tricks for creating a website as 
well as the procedure to conduct web hosting registration, to register the domain, 
and save files in the server. 

 
The following is a definition of the term website taken from 
www.amperaweb.com/apa itu website.php   
 

DEFINITION OF WEBSITE  
 
What is meant by website?  
Basically a Website is a methode of presenting yourself on the Internet. Your 
Website is a place on the Internet, whoever may be in this world could visit it, at 
any time they could get to know you, present your questions, give you input or 
even come to know of and buy your product.  
The Internet is like a big trade center in the world and your Website is one of the 
Shops/Kiosks in that trade center.  
 
Why do you need a Website?  
Five years ago one owns a Website just for prestige. 
Two years ago one owns a Website only because it was trendy. 
Today owning a Website is a must.  
All people use the Web for everything from schoolwork to making orders for 
food because the process is speedy, cheap, convenient & satisfying! You do not 
need to leave your table. In fact, even people who are shoppers look for the 
products they want on the Web. Now they are trying to find your product or 
service, the first place they seek is on the Web – and if they do not find your 
product and service on the Web, most likely they will find your competitor who 
already owns a Website!  
 
What can be done with the presence of a Website?  
Your Website can be used to serve various tasks, for example:  
To make announcements or notifications.  
To provide services to your Customer.  
To get inputs from your visitors/customers.  
To share and distribute files and photos.  
To communicate directly with your Customers on any other sides of the world.  
And, of course, to sell your product and service. Perhaps the above still sounds 
like not attractive enough, but don’t forget that you can do the above to the 
whole world any time .. during the day or the night at a very cheap cost!  
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How does a Website work? 
A Website is a mere collection of files placed in a computer that is connected to 
the Internet. When someone visits your Website, he actually is only connected to 
a computer and the computer (which is later called a Server) provides him with 
the file he wants to see.  
This sounds simple, but generally an ordinary computer does not have the power 
and the software necessary to respond to all the requests of the visitors of your 
Website. And although your computer/server can, your computer will still need a 
connection or access to the Internet which is mighty fast to serve the number of 
visitors to your Website.  
Generally a small company is incapable of running a Web Server and here comes 
the need for Web Hosting! 
 
How do you create a Website? 
To have your own Website will need a Website Address, namely a Domain Name 
and the service of a Computer/Server to store your data, that is the Web Hosting 
Service. 
 

    Step 2: Creating a personal Website (90 minutes) 

      Note for the Facilitator 
Distribute the “Creating a Website in 8 Steps” paper to the participants. 
Make sure each of the participants already has the paper. 
 
Before starting the activity, make sure the participants don’t open any other 
application. If anyone is opening the Internet or any other applications, 
have it shut down. Full attention is necessary from the participants to 
follow this activity so that none of them will get confused. 
 
Assist the participants if they get confused. Don’t give too much help, let 
them discover for themselves what their problems are. With more 
participants making trials and errors, the faster they will understand a 
material. 
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  Handout for Participant 2.1 
8 Steps in Creating Website 

 
To  create  a  website, please  follow the  following  easy  steps. There  are  a  few prints  
in  this  tutorial to  prime  your ability  to  read and  your aptitude to follow  instructions.  
So, please follow the instructions☺. Good  luck!!  

 

 Open Microsoft FrontPage. (2 Minutes) 
Click the START button -> All Programs -> Microsoft Office -> Microsoft 
Office FrontPage 2003. 

    Notes for the Facilitator 
Do not rush, use the allocated time well. Be careful lest you get trapped too 
long in just one step. If the  allocated  time is up, move  immediately to the 
next  step.  If  there  is  still time left, ask  around  and assist those who  
were not yet done. 

 

 Create a New Website. (3 Minutes) 
Click the menu File -> New… -> One Page Website 

 
 
 

 Make a Folder for Keeping Websites. (5 
Minutes) 
Click the display One Page Website. Then click Browse. Click the Desktop 
display (on the left side). Make a new folder and named it WebsiteKu (My 

Website). Then click  the  WebsiteKu  folder  twice  and  push  the OPEN button, then  
push  the OK display. 
 

1. 

2. 

3. 
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      Notes for the Facilitator 
In  step 3,  make sure that all participants keep  their  folders  in  the  
designated  place.  It  is important to watch  over this  as the participants 
often forget where  they kept their folders. 
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 Site Structural Design (Navigation). (25 
Minutes) 
 Push  the Navigation display. Right click the  box  on  which  is  displayed 
index.htm Then  select New Page.  

 
 
 
 
 
 
 
 

 
 

      Notes for the Facilitator 
Participants   are allowed to create  website maps/ hierarchy  
according  to their  respective desire.  However, it  is  recommended 
that for  the  initial stage   they  follow  the given  example  of   the  
website  map/hierarchy. 

4. 

After  the new page  emerged, right click  
the  printed New Page 1  and select 
Rename. (Do not click  twice!! ) Change 
that  name to ”Tentangku” (”About 
Me”). Then  create  the  sites  structure 
like the  print  on  the next  page. 
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The above figure shows sites map or website hierarchy. On the top part there is 
“index.htm”. This page is the main page of website, the page which is first presented 
when we visit a website. The following is the detail of WebsiteKu sites map: 

 
index.htm 
¾ About me 
¾ My family 

o My parents 
o My siblings 

¾ My hobbies 
¾ School 

o My  friends 
o My duties 

¾ My achievements 
o Academic 
o Non-academic 

¾ My  aspirations and  Aim  in Life 
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The contents of website pages. (30 Minutes) 
Click index.htm twice. Then  enter  an  expression  of welcome,   of thanks, 
briefly  explain what  the  website  holds, etc. Be Creative!! ☺ Insert  images,  
Flash  animations, alter  text,  create  marquees, etc. Make them  as nice  and  as 

attractive  as  possible. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

      Note for the Facilitator 
Step 5 is  given   the most  of  the  available time.  Impart to the 
participants  tips and  tricks for  colouring,  letter  sizes, entering  prints, 
flash animation, etc.  Attention should also be  given  to the  size  of  the 
print files.  Don’t make  them too  large  for this  will  slow down the 
loading of  the  website. 

5. 
Note  the  sign *  This 
means that  the page  has 
not  been  saved  yet. Be  
sure  to always  save  
them.!! The sign *  will 
not  appear if  the page  
were saved. 

The  above  window  will  appear   when  
the  page shows a images or  Flash 
animation. Don’t  worry,  it is  just  file 
management  (file  tidiness).  Because what 
we  are  keeping  are images,  keep them  
in  the  images   folder  (click  twice). 
Then push the OK button.
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 Create a Navigation Menu. (5 Minutes) 
This   navigation  menu is  to  facilitate moving  from one page  to  another.  Do  
these  steps  please……… 
 

Click menu Format -> Shared Borders. Select All Pages, select Top, Include 
Navigation, select also Left, Include… (See print). If done,  push OK. 

 
 

      Note for the Facilitator 
Creating  the  navigation  menu  by using  the  shared  borders is  the  
quickest  step in linking one page  to another   If there  is  time, show the  
different ways of hyperlinking  one page to another. 

6. 
Note: 
To activate the Shared 
Borders. Select the 
TOOLS -> PAGE 
OPTIONS -> select tab 
AUTHORING -> tick 
off SHARED 
BORDERS. Then push 
OK. 
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 Designing a Theme. (10 Minutes) 
To adorn  our page,  we  will  furnish it  with  a THEME,  a  design  packet 
prepared  by  Front Page.   We  can choose a  THEME  out of  tens of  
Themes.  Moreover, we  can download   from  the  internet. 

 
To apply  the  THEME  to our  page,  we will do  the  following:  
Select the menu Format -> Theme…. Select  the Theme you want.  Push  the  arrow 
button  at  the  side of  the theme to elect  whether to apply  the theme to the  whole   
website  page, or only  to that  particular page.  For this tutorial, we choose Apply as  
Default Theme, then push  Yes. 
 

 
CONGRATULATIONS!! Your Website has been successfully created!! ☺ 

 

      Note for the Facilitator 
Explain to the  participants  that these frontpage themes  are easily  
available  on  the  internet.  Explain  also  that  we  can  create  these  
themes  ourselves  according  to  our  wishes.  Make it  as  nice  and  as 
attractive as can  be,  but  remember!  Note  the size of the  pages, do  not  
have  them too large  for  this  will  impede  access  to  the  website. 

7. 
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 Upload Website!!! (15 Minutes) 
After  we  finished  creating  the  website,  we  must store  the  website  in  the  
server  at  the  internet  (the impressive  term is WebHosting)  so that  our  
website can be seen  by  anyone, anytime,  anywhere. 

 
There are  several steps  to be  taken  for keeping  the website  in  the internet, including: 

1. Using Front Page Extensions (Publish Web) 
This   second method  is  not quite easily  done.  Easy because all  you  have  to do  is 
push  the  File->Publish site menu..  Select Frontpage or Share Point Services,  
then enter  the  registered  website  address, then push OK.  When  requested, enter  
user  name  and  password. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. 

To upload, just  push  the  

Publish Website  button.  

Then  wait  until  all  files 

are sent to the  sever. 

CONGRATULATIONS!! 
To see your website in internet, 
type the address given by the 
netfirms. 
Example: 
http://iqbalfr.netfirms.com  



USAID DBE3 Life Skills for Youth 51

      Note for the Facilitator 
One  the  webhostings  that  provides free FrontPage Extension services is 
www.netfirm.com. If   the  internet  connection  is  available, guide the  
participants to  enroll  in that  webhosting. Remember  to choose the  
FREE one. ☺. FrontPage Extensions enable us  to  have guest books,  
feedback, counter hits, etc., easily. 

  
2. Using FTP (File Transfer Protocol) 
Open   Internet Explorer.  Type the ftp  address  at  the  Address Bar. An 
example: ftp://iqbalfr.cakraweb.net.   Then enter username  and password. After  
these  are  entered, push  the Log On   button. 

 
 After entered into the  cakraweb server,  put a copy of the contents of  WebsiteKu  
folder  into the  cakraweb server. If  the  copied  file were  going  well, it  will  be  shown 
as follows. 

 
 
 
 
 
 
 
 

CONGRATULATIONS!! 
To see your website in 
internet, type the address 
given by the netfirms. 
Example: 
http://iqbalfr.cakraweb.net   
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3. Using  the File Manager provided by webhosting 

The  third method appears  in  different  presentations  depending  on the  
respective  websites.  The  File  Manager  facilitates  a  direct  upload from  the  
browser  without   using  the FTP  program or  the FrontPage  itself. 

      Note for the Facilitator 
There  are  many free webhosting  sites that provide  these  services.  
Point  out one  or several webhostings that  provides  these  services.  A  
File   manager  is  also  provided in  webhosting www.netfirms.com. 
To seek free webhosting, type the keywords free webhosting in 
www.google.com. Hundreds and even thousands of free webhosting 
addresses will appear. Have a try! ☺ 

 
 
 

   EExxtteennssiioonn  
The  work  we have  done  forms  the  basis of  the  website  we  created.  For further  
developments, the  following are  suggested: 

• Add  several web  components provided by  FrontPage,  such as marquees, 
interactive  buttons,  and  hit  counters  ( hit  counters and  several web  
components at  FrontPage  are  called WebBot.  Be  sure that  those  
webhostings  have FrontPage  Extensions) 

• Add  the “guest  book”  page  to  record whoever  has  visited  the  website and  
the  comments they  wrote. 

• Add the  picture  gallery  page  to  include personal ,  family, friends, school  
pictures, etc. (a picture  gallery constitutes  one  of  the Web’s and  FrontPage’s  
components). 

E 
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AAccttiivviittyy  33  
CCrreeaattiinngg  aa  SScchhooooll  WWeebbssiittee 

IInnttrroodduuccttiioonn 
This  activity  shall  explain how  to  create  a school website.   The  steps  to  be  taken  
correspond to  the ones  taken  for  the  creation of  a  personal  website.  However,   
creating  a school  website  requires good  group-cooperation, and  it will  be  more 
specialized. If   in  creating  a  personal  website  everything  were done  by  a  single 
person,  the   creation  of a  school  website requires  good group-cooperation,  and  it 
will  be  more specialized.  The  creation of  a school  website  requires  several  persons 
gathered in  one  group,  each  member  of  the  group  possessing  a different   skill. 
 

   OObbjjeeccttiivveess  aanndd  LLeeaarrnniinngg  OOuuttccoommeess    
It is hoped  that  this  activity  will  enable  the  participants to  create  a  school website 
to  be used  for  presenting the  school’s  profile,  i.e.  its  mission and  vision,   activities,  
achievements,  database  of the  entire  civitas  academica,  announcements,  posters of 
the  works of  the  students,  etc. 
 
The  purpose of  creating  this  school   website  is  to  establish  the ability   of  the  
participants to cooperate with  each  other  and  the  ability of  coordinating with  the 
school administrator.  By merging  several  skills in  a  single group,  the  participants  
may  get  a  sense  of  the condition of  the working  world which  is filled with all  kinds  
of  people possessing  various skills. 
 
By participating in this activity, participants are expected to be able to: 

• Form a  group  and  share duties 
• Plan  the  creation  of  a school website 
• Determine  a  hierarchic or  personal web  map 
• Organize  and  manage the  contents  of  a  personal web 
• Determine  the  design  and layout  of  a personal web 
• Create  a  personal  web (End  Project of Second  Activity) 
• Store   and  present the  personal web in the internet and/or intranet 
 

 

      

AAggee  TTaarrggeett::    
This activity is intended for grade IX  
 
����  LLeevveel  ooff  DDiifffiiccullttyy  
The level of difficulty of this activity is four stars.  The same as that of a general with 
four stars, this activity is quite difficult. 
 

IVIII VII 
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    LLiinnkkss  ttoo  tthhee  CCuurrrriiccuulluumm     
ICT Competence 
This activity can be used to intensify the Competence Standard (SK) and Basic 
Competence (KD) of ICt subject. Specifically, the SK, KD which are contained are: 
 
Grade IX ,  Semester 1 

Competence Standard  Basic Commpetence 

1. Understanding the basic of internet/intranet 
use 

1.1 Explaining the basic understanding of internet/intranet 
1.2 Understanding the basics of network system in 
internet/intranet 
1.3 Identifying the size of speed of internet access  
1.4 Identifying the hardware used in the access of 
internet/intranet  
1.5 Conducting various ways to obtain connection of 
internet/intranet 

Grade IX ,  Semester 2 

Competence Standard Basic Competence  

2. Using internet to obtain information 
 

2.1 Demonstrating the acess of internet in accordance with 
the procedure 
2.2 Identifying several information, which are available in 
Internet 
2.3 Accessing various sites to obtain information, which is 
useful.  

 
Life Skills  
Also related to the development of life skills, as follows: 
Working in small 

group 
Cooperation Decision Making Problem 

Solving 
Self 

Consciousness 
Vocational 

9 9 9 9 9 9 
 

   TTiimme::  
Minimum 2 (two) hours. For practice work, it can be adjusted to the needs. 
 (Because this is a joint project, give the opportunity from two to three weeks to complete the school 
website.) 
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    RReeqquuiirreedd  MMaatteerriiaallss  
• Blackboard 
• Stationary 
• Photocopy of “8 Steps in Creating Website” sheets to be distributed to the 

participants. 
 

IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  TTeecchhnnoollooggyy 
 

• Computer Unit which has been installed with Microsoft FrontPage 2003 
application. 
Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (if permissible) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 

   AAsssseessssmmeenntt  
Like it  is with  the  works of  art, it  will  be  difficult to  assess  a  website  the  creation  
of the  respective  participants,  for  they  all  differ in   style and  aesthetic  judgment in  
design and website  layout. 
However,  there  are  some  technical  matters  that  should  be  heeded  and  could  be  
used as  material  for  assessment: 
• File  management (e.g. keeping print files in a  print folder, naming of the file, etc) 
• Aptitude  to  follow  instructions or the  available  steps  
• Good website navigation 
• Arranging  the  layout  of  prints, text, animation, etc. 
• The  size of web  sheets 
• Overall  design (web  usability): would it  be  easy or not  for  visitors  to  understand  

the  context  of  the  website. 
• Creativity 
• Group  collaboration 
• Etc. 

In order  that  the  assessment  is  objective  in  nature,  give  the matrix of  the 
assessment sheet to   the   respective  participants, and  leave  them to assess  the  work 
of  the  other participants.
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 Step 1: Forming Groups (10 minutes) 

In creating a Website, at least three skills are combined in one group. The first is that of 
Web Designer: his/her task is to design the layout, colouring, website theme, and so on. 
The core of his/her task is to beautify the page in order to attract visitors and make them 
feel comfortable visiting the Website. 

The second is the skill of a Web Developer: his/her task is to create and manage the 
database and the codes found on the Website. With the presence of the web developer, 
the web designer does not have to create tens of web pages, enough with only certain 
codes tens and even hundreds of pages can be formed automatically. The database such 
as a guest book, contacts list, inventory, students profile etc. are few of the job of the 
Web Developer. 

The third skill is that of Web Manager: his/her task is arranging and coordinating all 
members of the group. It is also his/her task to determine the website contents, and to 
decide what messages are to be conveyed to visitors. It can be said that the web manager 
is the leader of the website creating project. 

    Note for the Facilitator 
Divide the participants into several groups, each group having at least the three 
major skills. Determining what the task of participant A will be can be done 
through several ways. 
 
The first method is by seeing the results of their work in the activity of creating a 
personal website. It will be seen which participant will suit as the web designer. 
Then to pick out the web developer, it will be seen if he prefers to make web 
components such as a guest book, hit counter, etc. For a web manager, this will 
be seen from the daily activities of the participants. 
 
The second method is presenting a questioner about Multiple Intelligences. It will 
be seen which way is the intelligence tendency of a participant. If he inclines to 
have a visual intelligence, he is a web designer; if the tendency is toward logical-
mathematical intelligence, he is suitable for the web developer; and if his 
tendency is to have interpersonal intelligence, he will be the right one for the web 
manager. (Questioner is available in attached paper.)  

 Step 2: Planning (10 minutes)  
A proverb says, failing to plan is planning to fail. We need to observe a number of things in 
creating a Website. Among these are: 

• Goal – What actually do we want to convey or to achieve? 
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 What are the indicators of having a successful website? 
• Visitors Target – Which groups do we aim at? E.g.: parents, youths, high school and 

university students, the elites, consumers, etc. 
• Content – Just what materials are to be displayed on the website that will attract 

the interest of visitors and achieve our goal? 
• Resources – How much time and money are provided to create and manage our 

website? 
  

    Note for the Facilitator 
Give as much time as needed for the participants to make an analysis of the 
website creation. Give inputs if there are things the participants still do not 
understand. 

 

 Step 3: Understanding the benefit of a School Website (10 
minutes) 

    Note for the Facilitator 
If Internet access is available, ask the participants to open the web page 
http://www.amperaweb.com. Amperaweb is an Indonesian owned webhosting 
company. On it are to be found a number of tips and tricks of creating a website 
as well as the procedure of web hosting registration, registering a domain, saving 
a file in a server. 

 
The following is the benefits of owning a website taken from 
http://www.amperaweb.com/saatnya memiliki website.php  
 

IT’S TIME TO OWN A WEBSITE  
 
The Internet began to spread and grow busy in 1995. The rise in number of 
Internet users occurred in the whole world including Indonesia. Then in 1998 
numerous dotcom companies began to develop with offers of various 
information. The increase of websites on the Internet makes the Internet a global 
information vehicle.  
By owning a website on the Internet you can: 
Widen Your Promotion Space 
In addition to catalogue, brochure and advertisement in the print media, by 
owning a website on the Internet you can expand your promotional network. For 
your fans or would-be customers can see information on your website anytime 
and anyplace. 
Facilitate Communication 
You can get into two-way communication with your customers or would-be 
customers by the Internet through email or contact information available on your 
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website. Thus two-way communication is made more convenient. And the 
ongoing communication is very efficient. 
Interacting 
With the website, you can interact with your website visitors. The interactions 
made possible are such as arena for sale-purchase transactions, forum of 
discussions, file upload and download and the like. Therefore your website will 
not only be presenting information but more than that and the benefits can be 
felt. 
e-PR (electronic Public Relations) 
Widening the communication reach of your Public Relations team. At present 
many companies utilize the Internet as an effective, fast and wide channel to 
build relationships between the market and the business company.  
Brand Imaging 
You can build the image of your company’s brand or product through the 
Internet which is an expansive market reaching the whole countries of the world. 

 

    Step 4: Creating a School Website (90 minutes) 

      Note for the Facilitator 
Distribute the “Creating a Website in 8 Steps” sheet to the participants 
(found in the “Sheets for Participants in Activity 2”).  All the steps of 
creating a website are the same, but in Step 4 – Navigation there’s a little 
difference. See the example of navigation given below: 
For this website hierarchy/map, the participants are allowed to make for 
themselves on the basis of their respective wishes. However, in the first 
stage, it is suggested to follow the website hierarchy/map as given in the 
example. 

 
The diagram above shows a site map or website hierarchy. On the top 
part there is “index.htm”. This page is for the front page of the website, the 
first page displayed when we visit a website. The following is the details of 
the site map of WebsiteKu: 
index.htm 
¾ Remarks of the School Principal 
¾ School Profile 
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o Vision and Mission 
o History 
o Teachers and Employees 
o Achievement 
¾ Academic 

o Subjects 
o Academic Calendar 
¾ Students’ Activities 

o OSIS (School Intra-Students Organization) 
o Extracurricular 
¾ Visitor Books 

 
Before carrying out this activity, ensure that all participants do not open 
other applications, immediately stop. Full attention is needed from the 
participant to follow this activity in order that the participant does not 
undergo confusion. 
Help the participants, if they feel confused. Don’t give them many aids, let 
the participants find themselves what become their problems. The more the 
participants conduct tests and trials, the fater they understand a subject. 

 

   EExxtteennssiioonn  
The activity which has been completed is creating a website for a third party, in this case 
the school. To make a further development, the following are suggested: 

• Give to the participants web form and cooperation contract. Let them form their 
group as well as let them seek their own clients. Under this activity the 
participants will feel the condition of real world. And if there is an interested 
client, all service pay for the creation of website is owned by them. (the form and 
example of contract are included inside the CD) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

E 
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IInnffoorrmmaattiioonn  aanndd  
CCoommmmuunniiccaattiioonn  
TTeecchhnnoollooggyy  ffoorr  

LLeeaarrnniinngg  
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UUnniitt  TTwwoo  
IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  

TTeecchhnnoollooggyy  ffoorr  LLeeaarrnniinngg  
 
Participants: Young people who want to improve their capability in understanding and 
memorising one subject, to study with easier way and fun, and to study how the brain 
works. 
 
Unit Two: ICT for Studying helps participants in studying activities such as learning of 
how to use mind map and Flash Card to ease understanding and memorisation. 
Participants will explore internet to take animation of science process and include it to a 
study material. Participants will also be introduced with the benefit of number process 
application to learn to manage finance. In the last activity in this unit, participant will try 
to collaborate with other people through internet. 
 
The main purpose of this unit is to help participants in learning process. Participants will 
learn how the brain works, so that it will be easy for them to understand a lesson. 
Participants also will learn to memorize fast, and to use helping equipment of 
Information and Communication Technology. 
 
The time  length in this Unit Two will ease the participants’ learning process. 

• To learn how to use Mind Map 
• To Memorize with the help of Flash Card 
• Animation of Science Process 
• To Learn finance with using Worksheet 
• Collaborative learning 

 
All activities have been designed to give direct experiences for participants. Skills that will 
be sharpened are the skills they will need in school, workplace, society, and personal life. 
 
Assignments and activities provided in this toolkit are adjusted to conditions in 
Indonesia. As a result, participants will know more about situations and conditions in 
Indonesia. 
 
All activities provided in the ICT toolkit are interactive, of which all activities, step by 
step, will be done by participants such as discussion, brainstorming, presentation, 
computer practice, research work and data analysing. 
  
Assessment is a process from beginning to the end. All participants’ involvement in all 
activities must be recorded. 
 
Each activity will end by making a final project. This final project can be worked on 
during outside of the class hour.  
.  
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AAccttiivviittyy  11  
LLeeaarrnn  HHooww  TToo  UUssee  MMiinndd  MMaapp 

IInnttrroodduuccttiioonn 
This activity will explain what mind map is and how to implement it. Mind Map can be 
used to ease participants in studying or memorizing one subject’s topic. Mind Map also 
will ease participants to do planning, in studying as well as in life. 
 

   OObbjjeeccttiivvee  aanndd  LLeeaarrnniinngg  OOuuttccoommeess    
With this activity, participants will be able to manage thoughts in their mind. With the 
help of mind process application, thoughts and concepts managed can be done easily. 
The mind map will ease the understanding as well as memorizing a discussion topic. It 
also can be used to plan, make decision and solve problems. 
By doing this activity, participants are expected to: 

• Understand what mind map means  
• Understand tip and tricks to make mind map  
• Create a mind map  
• Present the mind map created by them (Final Project of Activity 1) 
 

      

AAgee  TTaarrgeett::    
This activity is intended for all grades (VII, VIII, IX) 
 
��� LLeevveell  ooff  DDiiffffiiccuullttyy  
The level of difficulty of this activity is three stars.  This means the difficulty level of this 
activity is above average. 
 

    LLiinnkkss  ttoo  tthe  Currriiccuulluumm     
ICT Competence  
This activity can be used to intensify the Competence Standard (SK) and Basic 
Competence (KD) of ICT subject. Specifically, the SK, KD which are contained are: 
 
 
 
 
 
 
 
 
 
Grade VII ,  Semester 1 

IX VII
I

VII 
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Competence Standard Basic Competence 

2. Understanding the use of information and 
communications technology and future 
prospect 

1.6 Identifying various equipment of information and 
communication technology 

1.3 Explaining the role of the information and 
communication technology in daily life. 

1.4 Identifying various benefits and uses of the 
information and communication technology. 

 
Life Skills 
Also related to the development of the life skills, as follows: 

Learning skill  Planning Decision Making Problem 
Solving 

Self 
Consciousness 

Vocational 

9 9 9 9 9 9 

 

   TTiimmee::  
Minimum 2 (two) hours. For practice work, it can be adjusted to the needs. 

    RReeqquuiirreedd  MMaatteerriiaallss  
• Blackboard 
• Stationary 
• Photocopy of “Tips & Tricks in Creating Mind Mapping” sheet to be distributed 

to the participants. 

IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  TTeecchhnnoollooggyy 
• Computer Unit which has been installed with MindMapper Jr application. 

Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (if permissible) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 

   AAsssseessssmmeenntt 
Mind Map is one of ways to ease to memorize. Certainly, each individual has a different 
way of memorizing something. 
But, there are some technical matters that need to be considered that that might become 
a data for making an assessment: 

• Selection of Key Word 
• Colouring 
• Using of drawing 
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• Association among thinking 
• Creativity 
• Etc.. 

In order to be objective during assessment, pass the assessment matrix sheet to each of 
the participants, and let each of them evaluate the result of another participant’s work. 
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    Step 1: To understand mind map concept (10 Minutes) 

    Note for the Facilitator 
If there is an internet access, ask participants to open the website 
http://www.sekolahindonesia.com. “SekolahIndonesia.com” is educational 
portal containing data of all schools and students  that have become members of 
“Proyek Sistem Informasi Akademik Sekolah Online” completely and detail.  
Through this website, parents, students and teachers can see academic data of 
students such grade, absence, conduct, and school data and matters, school 
activity, library, educational articles and other school information by using login 
code and password given.  
Bisde being able to see academic data in internet, members of “Proyek Sistem 
Informasi Akademik Sekolah Online “ also receives data transmission through 
SMS, e-mail and printed academic report. Therefore, now, teachers and parents 
together can observe and monitor all children development while they are in 
school easily and fast. 

 
The following is an explanation on mind map created by one of  school students. The 
full address is: 
http://www.sekolahindonesia.com/sidev/NewDetailArtikel.asp?iid artikel=16&cTipe a
rtikel=2   
 

Mind Mapping  
 
Mind Mapping is a method of learning a concept discovered Tony Buzan. This 
concept is based on the way of our brain to keep information. A research result 
show that our brain does not keep information in boxes of nerve cells laid in a 
row neatly but they are kept in nerve cells having many branches which look like 
tree branches. From this fact, we can conclude that if we keep the information 
like how our brain works, the information saved in our brain can be kept better 
and of course the final result is that our studying process will be better.  
 
Through the above explanation, it can be concluded the way of Mind Mapping 
works is to write down the main theme as a central/mid point and to think 
branches or sub-themes coming out of the central point and to look for the 
relationship between the sub-themes. That means that every time we study 
something, our focus will be directed to topic of the main theme, important 
points of the main  theme  that we are now studying, the development of each 
important point and to look for the relationship of each point. By doing this way, 
we can get a picture of what we have known and which area that have not been 
handled well. 

Some important things in making Mind Mapping are listed below: 
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1.  Make sure that main theme is located in the center  
For example, if we are studying history of Indonesian independence, the main 
theme is Indonesian History. 

2. Form main theme, sub-themes related with the main theme appeared 
will be appeared  
From main theme "Indonesian History ", sub-themes can consist of: 
Period,Area, Form of the Indepence, etc. 

3. Look for the relationship between each theme and underline it with a 
line, color or symbol  
From each first sub-theme, second sub-theme will appear, third and so on. 
Then, next step is to look for the exsiting relationship among each sub-theme. 
Use line, color, arrow or branch and other symbol forms to show the 
relationship among those sub-themes. This relationship patterns will help us to 
understand the topic that we are reading. Beside that, the Mind Mapping that 
has been modified with symbols and marks that we like, will be more beneficial 
compared with Mind Mapping that “lack of colors” 

4. Use capital letter  
Capital letters will encourage us to only write important points in Mind 
Mapping. Beside that, to read a sentence in a picture will be easier if they are in 
capital letters compared to in small letters. The use of small letters can be used 
for points that function to explain key points.  

5. Make Mind Mapping on plain paper and avoid editting process 
The idea of Mind Mapping is so that we think creatively. Therefore, use plain 
paper and don’t be tempted to modify Mind Mapping at the beginning. 
Because if we do the modification at early stage, our focus will often be 
changed that slows down the absorbent of the theme’s understanding that we 
are studying. 

6. Live room to add themes.  
The useful Mind Mapping is usually the one that has been added with 
additional themes and modified severeal times for a period of time. After 
drawing the first Mind Mapping, usually we will add information, write 
questions or mark important points. So, live space in Mind Mapping paper to 
add themes.   

Sender:Cinthya Dewi |Email : - |cinthya@hotmail.com 
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 Step 2:  Explanation of Mind Mapping (10 minutes) 

    Note for the Facilitator 
Because this material is about Mind Mapping, use mind mappings in explaining 
all concepts of mind mapping. Beside showing examples of Mind Mappings that 
has been done, the teaching using mind mapping eases participants to understand 
and remember the concept and idea. 
For the first five minutes, explain about the weakness of traditional note taking 
and the benefits of using mind mapping. If time allows, ask participants to tell 
their difficulties in traditional note taking or perhaps its benefits. On the other 
hand, let participants tell the benefits and weaknesses of taking notes with using 
mind mapping.  
Ideas that given by participants should be written down on the chalk board by 
using mind mapping. 

 
Traditional Recording Technique: 
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Recording Technique using Mind Mapping: 

 

    Note for the Facilitator 
Five minutes later explain method of mind mapping which is adapted from the 
book “Mind Training” written by Tony Buzan. 
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 Step 3:  Tips dan Trick to Make Mind Mappings (10 Minutes) 

    Note for the Facilitator 
Explain step by step how to make mind mappings. Participants need to 
understand that the best, effective and suitable mind mapping is not the one 
done by sophisticated software. It is not also the one that is made by people who 
we think smarter than us.  
The most effective Mind Mapping is a mind mapping that is made by each 
individual. To understand easily, memorize and remember again a subject, it will 
be better if each participant make his/her own mind mapping to be used by each 
of them. So, participants will understand much faster and easy to memorize it 
instead of  looking at and memorizing the mind mapping that has been prepared.  
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 Step 4:  To make Mind Mapping (60 Minutes) 

    Note for the Facilitator 
This is the time to  practice of what have been explained. Distribute paper on 
“Periode Menjelang Kemerdekaan RI” to participants. Ask participants to make 
Mind Mapping from the article that has been distributed. 
For the first sub-theme, guide them to make the mind mapping. When they can 
make some branches, let them do it by themselves. Give a guidance if 
participants have some questions. If picture collections are available, distribute its 
file to participants as a supporting material for mind mappings that they make. 
Remember that no body is wrong in making mind mapping! Try to give enough 
inputs, don’t dictate participants in making their Mind Mapping.  
In this Step 3, the making direction will be more detail. Please follow step by step 
will. Pay attention also to time allocation. Try not exceeding the time that has 
been designated. 
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  Handout for Participant 3.1 
Sheet for Exercise in Making Mind Map 

 
 

 Period Approaching RI Independence  
(Taken from: http://id.wikipedia.org/wiki/Indonesia: Era Jepang) 

On the 6th of August 1945, two atomic bombs were dropped down into two ICTies of 
Japan, Hiroshima and Nagasaki, by The United States of America. This caused Japan to 
surrender to the U. S and its allies. This moment was then used by Indonesia in 
proclaiming its independence. 
On the 7th of August—BPUPKI changed its name into PPKI, Committee for the 
Preparation of Indonesia’s Independence. 
On the 9th of August 1945, Soekarno, Hatta and Radjiman Wydeodiningrat were flown to 
Vietnam to meet Marshall Terauchi.  They had been informed that the Japanese war 
forces were heading for destruction but still Japan wanted Indonesia’s Independence on 
the 24th of August. 
Meanwhile, in Indonesia, Sutan Syahrir had heard the news from radio on the 10th of 
August 1945, that Japan had surrendered to the Allied forces. The underground fighters 
got themselves ready to proclaim RI independence, and they rejected the construction of 
independence that was a gift from Japan. When Soekarno, Hatta and Radjiman returned 
to Indonesia on the 14th of August 1945, Syahrir insisted that Soekarno immediately 
proclaim independence. Soekarno, however, was still not convinced wheather Japan had 
really surrendered, and proclamation of independence at such a time might cause a huge 
mass bloodshed, and bring down fatal consequences if the fighters were not ready. 
On the 15th of August—Japan surrendered to the Allied forces. The Army and Navy of 
Japan were still in power acrossed Indonesia because Japan had pledged to return the 
power of occupation of Indonesia to the hands of the Dutch. 
Those young freedom fighters, includedly Chaerul Saleh, who were joined in the 
Underground movement, got impatient, and by the dawn of the 16th of August 1945, 
they kidnapped Soekarno and Hatta, took them to Rengasdengklok, a forceful move later 
to be known as Rengasdengklok affair. There, they again tried to convince Soekarno that 
Japan had surrendered and that all the fighters were ready to fight against Japanese forces 
at whatever risk they might encounter. 
By the same evening, Soekarno and Hatta returned to Jakarta, met with General 
Yamamoto and were accommodated at the Vice Admiral’s residence. From the 
communication between Hatta and the Right hand of the Japan’s commander in Java, 
Soekarno and Hatta were convinced that Japan had really surrendered to the Allied 
forces and they no longer had the authority in granting Independence. 
Knowing that proclamation of independence without bloodshed was no longer possible, 
Soekarno, Hatta and other members of the PPKI, held a meeting and by the same night 
the proclamation text was written to be on the following morning read aloud throughout 
Indonesia on the 17th of August 1945. 
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 5 Steps in Making of Mind Map!!! 
 
At this moment we are going to learn the how-to of making mind map with the help of 
an application that is called MindMapper Jr. This application is meant for children and 
teenagers, containing many drawings and interfaces that are not uncommon for children 
and teenagers.  
To begin with the first Mind Map, go through the following steps: 

 

 Open MindMapper Jr. (5 Minutes) 
Click the START button -> All Programs -> MindMapper Jr -> 
MindMapper Jr. 
When the program opens, the following window will appear: 

 
At this time, just choose Open Empty Map. 

    Note for the Facilitator 
Do not rush, use your time wisely as allocated. Please be careful that you are not 
trapped in anyone step too long. When the allocated time is over, immediately 
move on to the next step. When time still remains, ask all the participants 
whether they have all completed or not yet, if there are some who are not yet 
through, give them a hand. 
When time allows, please describe what is meant by Run Wizard (to open the 
file of mind map already made by the program before). Open Existing File (to 
open the mind map file we have just made), and Open Empty Map ( to open 
mind map file which is still empty) 
 

1. 
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 Determining the Main Theme. (5 Minutes) 
As is described earlier, the main theme is placed in the middle of the page.  For 
the example now, the main theme is Approaching Proclamation of 
Independence of RI. 
 The way how to do it is by clicking twice on the elliptical that is inscribed with 
Please Insert Title, then change it with Approaching Proclamation of 
Independence of RI.. 

 
 

    Note for the Facilitator 
The participants are actually free in determining the main theme based on their 
own will, however , since this is still in practice, you want to make all the 
participants obey as instructed. 
 
 
 

2. 
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 Making Branches and Sub Branches. (15 
Minutes) 
Now, let’s take a look at branches and sub branches. Branch is a derived theme 
which is related with the main theme. While sub branch is a derived theme from 
the branch, and so on it goes. 
To construct branches and sub branches is very easy. Make sure that the main 
theme has been chosen (ref. to the box with green lines). Then, push spacebar 
or insert button on the keyboard. This brings up new branch, then you will type 
figure “6”. This figure represents the date 6 August 1945. To make it easy to 
remember, just type 6  Please do the same thing with all the dates included in 
the article “Approaching Proclamation of Independence of RI”. 

 
After making branches, continue doing the same thing with sub branches 
(description of derived theme).  The method is just the same  with making 
branches, this time however, you need to make sure that the derived theme 
chosen is the figure “6” . After that, you will again push the spacebar or Insert 
button on the keyboard. The same procedure applies when we want to add 
more Sub branches on the ATOMIC BOMB, it’s very easy, just click again on 
the ATOMIC BOMB, and then push the spacebar or insert. It’s easy, isn’t it? 
Because it’s easy , you can go on with those points that follow it. ☺  

 
 

3. 
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 Inserting Drawings and Designs. (25 Minutes) 
 When all steps have been fully followed, now is the pleasing to the soul part 
that is to beautify our mind map by altering types of letters, their colors, and 
inserting drawings. 

 

 
 

 
 

 
 
 

    Note for the Facilitator 
Let the participants try each function in the menu and let them insert any design 
they want. If the computer is connected at the moment with internet, allow them 
to explore picture or drawing of the proclamation figures such as Soekarno—
Hatta, etc. 
On this fourth step, try stimulating the participant’s creativity by doing 
modifications on our mindmap or by issuing mindmap which is also done by 
them earlier. 
 

 
 

4. 
Click the picture 
of paper to get 
the menu of 
STYLE 

Choosing from the already existing 
pictures, just click it. It’s easy isn’t 
it? ☺ (Do not forget to first choose 
which branch you want to insert 
picture). 

These are the 
contents of 
STYLE menu, 
explore on your 
own to get to 
know each of 
their functions. 
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 Saving and Printing Mind Map. (10 Minutes) 
Finally….the first Mind Map making is finished. The next step is to save it to 
be later accessed whenever it deems necessary. Or, have it also printed in order 
that we can easily read this mind map anytime. 
How?? Again. Amazingly very easy. Please note the following visuals: 

 
Push or press folder button (menu FILE). Soon after a series of pictures appear 
under it. The following is a brief description: 
1. Wizard: making new file. 
2. Open:  To open files that have been made before 
3. Save: To save keep file 
4. Save As: If you –wanting to have the same file named differently or you 

want the file readable anywhere, you must use .bmp(bitmap), under Save 
As. 

5. Save As HTML: If you want an appearance in the monitor in the form of 
HTML 

6. Print: Yup!! This is for printing. 
7. Print Preview: To have a view on what it’s like when printed 
8. Document Information: Information which regards with the maker of this 

mind map, its title and etc. 
9. Close: This is obviously clear.  This will end the program of MindManager 

Jr.  
10. Sound On/Off: To let sounds on or off the computer. 

 

   EExxtteennssiioonn  
The mind map which has been made is based on the already existing article.  For the 
Purpose of further development, try the following things: 

• Try making a mind map of one of your school subjects. For example, on Cell 
making (Biology), Market Mechanism (Economics), Grammar (English) and etc. 

• Make a mind map on participant’s purpose for life. Whenever possible, make                    
it as clear as possible. For example, a five—year plan, 10 – year plan, 20— year 
plan, 25—year plan and etc. 

• Make a mind map on school holiday plan or a comparative study plan to other 
school. 

5. 

E 

1 2 3 4 5 6 7 8 9 10 



USAID DBE3 Life Skills for Youth 78

AAccttiivviittyy  22  
MMeemmoorriizziinngg  wwiitthh  tthhee  HHeellpp  ooff  FFllaasshhCCaarrdd 

 IInnttrroodduuccttiioonn 
“Amin, what is meant by tectonic earthquake?” asked a teacher. Amin answered, 
“hmmmm…forget it again mam.”.  
The answer given by Amin is very likely the answer most frequently heard by a teacher. 
As a teacher, we are frequently forced to feel wanting to give up being faced with low 
memorizing capability of students. The materials that we discussed last week, could be 
easily forgotten but students. 
Is there any way for the students to quickly and easily remember what have just been 
learnt? One of the solutions is by using Flash Card. 
 

OObbjjeeccttiivveess  aanndd  LLeeaarrnniinngg  OOuuttccoommeess    
The objective of this activity is that participants are enabled in raising the level of their  
memorizing capability by using a computer application called Flash Card. It is expected 
that by participating in this activity, the participants will no longer have difficulty in  
memorizing a topic for discussion, school subjects, foreign vocabularies, and etc. 
 
By participating in this activity, the participants are expected to be capable of: 

• Understanding what is meant by Flash Card 
• Knowing the tips and tricks in making Flash Card 
• Making a Flash Card 
• Memorizing a topic in some school subjects. (Finishing project of Activity two) 
 

 

      

AAggee  TTaarrggeett::    
This activity is intended for all grades (VII, VIII, IX) 
 
�� LLeevveell  ooff  DDiiffffiiccuullttyy  
The level of difficulty of this activity is two stars.  This means the difficulty level of this 
activity is not that difficult to follow 
 

    LLiinnkkss  ttoo  tthhee  CCuurrrriiccuulluumm   
ICT Competence 
This activity can be used to intensify the Competence Standard (SK) and Basic 
Competence (KD) of the ICT subject. Specifically, the SK, KD which are contained are: 
 
Grade VII ,  Semester 1 

IX VII
I

VII 
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Competence Standard Basic Competence 

3. Understanding the use of information and 
communications technology and future 
prospect 

 

 

1.7 Identifying various equipment of information and 
communications technology 

1.5 Explaining the role of the information and 
communication technology in daily life. 

1.6 Identifying various benefits and uses of the 
information and communication technology. 

 
Life Skills 
Also related to the development of life skills, as follows:  
Learning Skills Planning Decision Making Problem 

Solving 
Self 

Consciousness 
Vocational 

9 9 9 9 9 9 
 

   TTiimmee::  
Minimum 2 (two) hours. For practice work, it can be adjusted to the needs.  

    RReeqquuiirreedd  MMaatteerriiaallss  
• Blackboard 
• Stationary 
• Photocopy of “Tips & Trick in Memorizing” sheet to be distributed to the 

participants. 
• Photocopy of English vocabulary sheet and the translation thereof. 

IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  TTeecchhnnoollooggyy 
• Computer Unit which has been installed with FlashCard (MemoryLifter) 

application. 
Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (if permissible) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 
 
 
 
 
 

   AAsssseessssmmeenntt     
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Flash Card is a methodology for remembering all things easily and quickly. Frequent 
repetitions in planned schedule will increase participants speed in remembering a 
discussion topic and or material. It is somewhat difficult though evaluating the degree of 
effectiveness in the use of Flash Card by the participants, during their learning process 
because each participant’s spin-off capability is different. 
However, there are some techniques which need to be attended to which can also be 
points of consideration during evaluation: 

• Asking the right question 
• Colouring 
• Use of pictures 
• Grouping of question types 
• Readability 
• Correct, conceptually 
• Creativity 
• Etc. 

In order to be objective during assessment, pass the assessment matrix sheet to each of 
the participants, and let each of them evaluate the result of another participant’s work. 
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Step 1:  Description of Flash Card (10 minutes)  
 

    Note for the Facilitator 
Before using Flash Card, it would be also good arousing the participants curiosity 
by showing them a couple of flags of different countries. Show them, and then 
ask which country’s flag did they see? Give them appreciation or prize if they 
gave the right answer. Or, at the beginning of the activity, imitate a question in 
the” Who Wants to be a Millionaire”. Ask the participants various easy things but 
often forgotten.  
After a few minutes, the room will be crowded with voices. Then is the right time 
to introduce the concept of Flash Card. Tell the participants that there are quick 
ways in winning Questions of the “Who Wants to be a Millionaire”, that is 
through the use of Flash Card.☺. 
 
If there is internet accessibility, ask the participants to open the page of 
http://agro.web.ugm.ac.id/pagefiles/trivial/laporan-trivial.pdf. This article was 
written by one of education world practitioners and there in the writer discusses 
on recollection-capability, effective mind recollecting method, and the 
methodology of Flash Card application. The Flash Card application used is 
Trivial. 
Show the participants that there are plenty of applications that cover Flash Card. 
Ask the participants to carry out some explorations in order to discover 
application that suits them. In this activity, we are going to use Flash Card 
application which is called Memory Lifter. 
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  Handout for Participant 2.1 
Tips and Trick in Memorizing 

 
Effective Repetition Method 
Based on experiences, we are conscious of the facts that information known or 
memorized previously may at any time be difficult to recall if that information 
happens to be not in use for  a significant length of time. In order to prevent 
us—you and I, from such an issue, we need to conduct a review at every certain 
time interval (making use of repetition factor). The effective method for that 
necessity is spaced time repetitions. 
 
This method does not use constant review time interval. Each time a review is 
done, we raise the time interval for the next. For example, Tony Buzan proposes 
in his book “Make the Most of Your Mind”, the following time intervals: 
 
Review 1: 10 minutes after preliminary understanding 
Review 2:  one day after the earlier review 
Review 3:  one week after the earlier review 
Review 4:  one month after the earlier review 
Review 5:  four months after the earlier review 
Next reviews: only if needed 
 
The idea emerges in accordance with our daily experience. Those things that we 
have well memorized, for example, dates of birth, home addresses, don’t need to 
be frequently repeated. While those things that we have not memorized well, like 
for instance newly learnt vocabularies, must often time be repeated if we want to 
always remember them. 
 
The difficulty that may appear from the methodology of repetitions with spaced 
time intervals is its management. It is for that purpose that programs written 
directed at managing schedules in spaced time intervals are in application 
businesses. 
 
What the users need to do is only entering data and doing review on schedules 
determined by the computer. The programs so written are called Flash Card 
programs. 
 
Flash Card Programs 
Flash Card (or flashcard) is a piece of paper that contains on its one side 
questions and on its other side answers. This learning assistant facilitates 
memorizing process.  We read the question on the one side of the flashcard and 
then the answer that we have in mind can be compared with the answer written 
on the other side of the flash card. Here’s an example: 
 
Question: Who was the first Indonesia’s president? 
Answer    :  Soekarno 
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 Inputs needed for writing the programs of Flash Card come also in the form of 
questions and answers. 
 
Next, the flash card program will prepare its scheduling following a certain 
algorithm. For example, “The user is exercising his flashcard program. He sees 
that under the days Flashcard program there are 6 questions scheduled to be 
discussed. He then answers those questions. Every time he answers one question 
and comparing his answer with the answer provided, he informs the program to 
make sure whether his answer was either right or wrong. After completing all the 
questions and answers, he adds two new information that need to be 
memorized” 



USAID DBE3 Life Skills for Youth 84

Step 2:  Flash Card Tips dan Trics (10 minutes) 

    Note for the Facilitator 
On Activity one, the participants have all learnt how to make Mind Map. Show to 
the participants Mind Map Tips of Flashcard. The use of this Mind Map is to 
facilitate their understanding and to show them one of the examples in the use of 
Mind Map in learning. 

 
 

 

    Note for the Facilitator 
The following is a description of each point of the Mind Map: 
1. Color – You may use color to distinguish between one behavior from 

another and making it easier for you to memorize. In language lesson, for 
example: If the word in question is Regular Verb, color it Blue. If the word in 
question is Irregular Verb, color it Green 

2. Write it yourself- Flash Card that is self written is far more effective. Because 
by so doing, the association between question and answer will become clearer 
and easier to bring back to memory. 

3. Be timely on schedule- The Flash Card that you have made will be worthless 
if not reviewed, and if not again and again put into practice. Based on a book 
written by Tony Buzan entitled “Make the Most of Your Mind”, spaced time 
repetitions are as follow: 
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1st review: 10 minutes after preliminary understanding 
2nd review: One day after the earlier review 
3rd review: One week after the earlier review 
4th review: One month after the earlier review 
5th review: four months after the earlier review 
Next reviews: if only needed 

4. Multimedia – use as many media as possible; both in the form of Audio or 
Video or combination of both. The more media you use, the better will it be 
to the brain as it can do more association in recalling the memory of one 
word or certain discussion. This will also be very helpful for students who 
love auditory and visual learning styles. 

5. Never give up! Usually the students would feel happy if they could answer 
any question correctly. However, often time they feel disappointed if answers 
that they give are not the right answers. Give them encouragement and 
motivation to continue reviewing a material until they are able to know and 
understand well. 

6. Easy to Carry – Try in the best way you can, make the flash card easy to carry 
anywhere. When the students are waiting for transportation, or waiting on 
queue, they could easily produce the small flash card and again be on the 
review of lesson. If you make flash card by using a computer application just 
have it printed in small size. The more often you do the reviews, the better 
and easier for you to remember 

 

Step 3:  Making a FlashCard (60 Minutes) 

    Note for the Facilitator 
This is the time to put into practice what we have discussed earlier distribute the 
sheet of paper containing vocabularies in English, vocabularies of which are 
equipped with pictures. Ask the participants to make flash card of those 
vocabularies just given to them. It will be better if the participants are also 
provided with a file of pictures that they may use in facilitating their learning 
process. If the participants are accessible to microphone and speakerphone, they 
can pronounce words in English and exercise themselves in the pronunciation of 
those words. The participants will feel happy learning their voices recorded and 
then being replayed. If there is video file, use it.  
The applications program which will be use in making flash card is Memory 
Lifter. This application is free of charge and maybe of use by anybody.  
In this step 3, the instruction for the making will be more in detail. Please follow 
the sequences carefully. Also note the time allocation. Try not to overshoot the 
time allocation. 
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  Handout for Participant 2.2 
Example of FlashCard Exercise 

 
(For complete vocabulary it is contained in the CD) 

Picture English 

 

antelope 

 

beaver 

 

bee 

 

budgie 

 

butterfly 

 

buzzard 
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Cock 

 

crocodile 

 

donkey 

 

duck 

 

eagle owl 

 

elephant 

 

ferret 
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5 Steps in Creating FlashCard!!! 
 
This time we will learn how to make flash card with the help of an application called 
MemoryLifter.  Like the name, this application is useful to assist us in remembering or 
memorizing a lesson.  As an example, we will make a flash card on the names of animal 
in English.   
To start creating FlashCard, follow the following steps. 

 

 Open MemoryLifter. (5 Minutes) 
Click START button -> All Programs -> LearnLift -> MemoryLifter 1.7 
After the program is open, the following window will appear: 

 

    Note for the Facilitator 
Don’t hesitate, use the time allocation properly.  It is also necessary to observe, 
don’t be trapped in a step very long. If the time allocated is used up, immediately 
move to the next step.  If there is still time, ask all participants, whether they have 
finished or not if there are those who have not finished yet.  Give assistance 
immediately. 

1. 
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 Creating a New Dictionary. (5 Minutes) 
Dictionary is a collection of flashcard which has been made.  Since we begin 
from the start, we must make new dictionary first, by selecting the menu File -> 
New. The following window will appear:  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

    Note for the Facilitator 
In the first dialogue, “Dictionary Options”, there are 2 tabs, namely 
“Commentary” and “Advanced”.  It is not necessary to inform each function, let 
the participants try themselves.  The participants will promptly master/control an 
application when they try themselves. 
In the second box “Manage Chapters” there are 2 buttons, “New” and “Delete”.  
These buttons function to add and eliminate the chapter or group of Flash Card.  
For instance, in the lesson on Economics, there is a chapter on Hakikat of 
Economics, there is also chapter on Demand and Supply, as well as International 
Trade, etc. 

2. 
Question: This is a title 
for us to differentiate 
between the question and 
answer.  For example, 
Type Drawing 
Answer: This is for the 
tile of answer. Type: 
English 

After the question got answer has 
been completed, click OK.   
A dialog box will come out as on 
the left.   
Fill the Title of our FlashCard, and 
Description with the explanation 
about our Flash Card.  Then click 
the Apply button, then click OK.. 
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 Insert Data or Card Baru. (45 Minutes) 
 This is the most important step, namely the making of Flash Card.  The way to 
make new card is very easy.  Just click drawing ‘+’, then the following dialogue 
box will appear. 

 

 
 

 
 
 
 

3. 

Complete/Fill in 
each box provided.  
If a drawing wants to 
be inserted, click the 
button with the 
drawing of man . 
Then, the next 
dialogue box will 
appear.  Choose the 
drawing desired.   
After completed, 
click the button Add 
to add new card. 
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    Note for the Facilitator 
Like usually, all functions will not be explained and the button in the dialogue 
box “Add New Card”.  Let the participants guess first each function. 

As seen in the drawing, we can insert the file drawing , voice , and video  

. Let the participants try existing buttons. 
 
 

 Start to Learn. (25 Minutes) 
After all cards are completed, now the pleasant part.  Namely, we begin to learn! 
☺. In this box on the left is question.  The right box is where we answer the 
question.  Insert the desired answer and then click data. It will appear whether 
the answer is right or wrong.  If wrong, it will go into the box to be repeated.  
If right, it will be inserted in the next box, which will be listed again. 

 

    Note for the Facilitator 
Let the participants answer themselves from their result of work.  In the button 

‘Learning Options’  in the upper toolbar, show the participants that Flash 
Card can also be in the form of double choice.  After that, let the participants try 
themselves all kinds of from of question, which exist. 
 

4. 
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 Saving and Printing FlashCard. (10 Minutes) 
In order that the Flash Card we make is not lost, it must be saved How? Again, 
it is very easy observing the following drawing:  
 

 
Indicator or sign that our file has been saved, namely the TIK Bar will change 
into name of our file. 

 
To print, just click the print button.  Have a try.! ☺ 
 

   EExxtteennssiioonn  
The FlashCard the participant make in this activity is made on the basis of the English 
Vocabulary, which has been prepared in advance.  For further development, try the 
following matters: 

• Try to make FlashCard of one of the lessons.  For instance, about Species 
(Biology), Economic Term (Economics), Vocabulary (English), etc. 

• Make a collection of FlashCard, which is obtain from several participants 
concerning one certain lesson. The complete collection of FlashCard can become 
reference in learning, if facing the national examination. 

• The FlashCard which has been made, should be saved in a website which 
contains the collection of FlashCard on various matters in various languages.  
The website address is http://www.flashcardexchange.com 

 

5. 

E 
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AAccttiivviittyy  33  
AAnniimmaattiioonn  ooff  SScciieennccee  PPrroocceessss  

IInnttrroodduuccttiioonn 
One day after the Christmas celebration, a day that marks the year of 2004 and the date 
of December 26, signified the occurrence of an eventfully shaking the nation –Indonesia 
and in fact the world. Aceh, accompanied by several areas of neighbouring countries, was 
devastatingly hard hit by gigantic waves of Tsunami and driving thousands of people to 
their lives termination, thousands others missing nowhere to be found and thousands of 
houses destructed or transported out of sight. (For data on scale of destruction, get 
access at http://id.wikipedia.org/wiki/Gempa bumi Samudra Hindia 2004) 
 
Not insignificant number of people across the world raised the question why could or 
should this awesome natural disaster take place starting from scientists all the way 
through to children, the drive to want know the why, swept, as if wave, the world over. 
What we roughly know through our naked eyes was the destruction it had caused. 
Probably, only those scientists who can research the location of the disaster and who 
could find answers of the causes and effects, for the students, however, it would be 
difficult to carry out research in finding answers to the question of why and how 
tsunami. 
 
Fortunately, during this last one decade, some individuals have invented application 
programs that can help make animation and scientific process simulation. Now, even 
kids, can easily understand how the process of tsunami and its impacts take place simply 
by looking at its animation. 

   OObbjjeeccttiivvee  aanndd  LLeeaarrnniinngg  OOuuttccoommeess    
The objective of this activity is to introduce the participants on the animation process of 
science. It is expected that after knowing the benefits of science process of animation, 
the participants can use it in helping them through their learning process. 
By participating in this activity, the participants are expected to be capable of: 

• Understanding the benefits of using scientific process animation. 
• Searching and finding scientific process animation in the internet. 
• Retrieving scientific process animation from the internet. 
• Including scientific process animation in one’s learning process. 
• Micro Teaching, Making a presentation on a topic of discussion using scientific 

process animation (finishing project of activity 3) 
 

      

AAggee  TTaarrggeett::    
This activity is intended for all grades (VII, VIII, IX) 
 
 

IX VIII VII 
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��� LLeevveell  off  DDiifffiiccullttyy  
The level of difficulty of this activity is three stars.  This means the difficuty level of this 
activity is above average. 
 

    LLiinnkkss  ttoo  tthhee  CCuurrrriiccuulluumm   
ICT Competence 
This activity can be used to intensify the Competence Standard (SK) and the Basic 
Competence (KD) of ICT subject.  Specifically, the SK, KD which are contained are: 
 
Grade VII ,  Semester 1 

Competence Standard Basic Competence 

4. Understanding the use of information and 
communications technology and future 
prospect. 

 

 

1.8 Identifying various equipment of information and 
communications technology 

1.7 Explaining the role of the information and 
communication technology in daily life 

1.8 Identifying various benefits and uses of the 
information and communication technology 

Grade IX ,  Semester 1 

Competence Standard Basic Competence 

3 Understanding the basics of 
internet/intranet use 

3.2 Explaining the basic understanding of internet/intranet 

3.3 Understanding the basics of network system in 
internet/intranet 

3.4 Identifying the size of speed of internet access 

3.5 Identifying the hardware used in the access of 
internet/intranet 

3.6 Conducting various ways to obtain connection of 
internet/intranet 

Grade IX ,  Semester  2  

Competence Standard Basic Competence 

4 Using Internet to obtain information 

 

4.2 Demonstrating the access of Internet in accordance 
with the procedure 

4.3 Identifying several information serious, which are 
available in Internet 

4.4 Accessing various sites to obtain information, which is 
useful.   

 
Life Skills 
Also related to the development of life skills, as follows: 
Learning Skills Information 

Searching Skills 
Decision Making Problem 

Solving 
Self 

Consciousness 
Vocational 

9 9 9 9 9 9 
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   TTiimmee::  
Minimum 2 (two) hours. For practice work , it can be adjusted to the needs. 
 

    RReeqquuiirreedd  MMaatterriiaalls  
• Blackboard  
• Stationary 

 

 IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  TTeecchhnnoollooggyy 
 

• Computer Unit which has been installed with Internet Explorer/Mozilla Firefox 
application 
Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (if permissible) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 

   AAsssseessssmmeenntt   
The evaluation of this activity will be more difficult because what the participants have 
produced are not real products. Matters for evaluation are more on the aspects of 
affection of the participants and their ability in following through all instructions given.  
The following are some of the matters for consideration during evaluation: 
• Capability in following procedures. 
• Attracted ness in learning more new things. 
• Capability of searching by using search engine. 
• Capability of problem solving when confronted with constraints.  

In order that evaluation is objective, distribute the sheet of evaluation matrix to each 
of the participants and let them evaluate the working result of other participants.
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Step 1:  Brainstorming the Benefits of Animation of Science Process (10 
minutes) 

    Note for the Facilitator 
Before beginning the learning process an animation of science process, it is better 
to show several animations of science process, which have been collected 
previously.  For instance, the animation of tsunami.  This is needed to stimulate 
the curiosity of participant. 
After that by using the application of making mind map, conduct the 
brainstorming on benefit of using animation in the Learning process (if the 
application of making mind map is not provided, it can be recorded in the 
blackboard by using several kinds of colours). 
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    Note for the Facilitator 
After the time of brainstorming, let the participants issue what they want to point 
out.  Record all, there are no wrong ideas. 
To facilitate the facilitator in presenting this subject, several ideas on the benefit 
of Animation of Science Process are given below: 
1. It is pleasant to use the animation, the students can see the cell moving, then 

if there is a voice of the animal, it can be heard, as well as the use of various 
colours.  Unlike the book, which has only one colour, immovable, and does 
not have voice 

2. Interactive, the animation runs in accordance with the response we give.  This 
is very good to support the simulation, in which we can determine ourselves 
the variables, which affect something. 

3. With the interactivity and the pleasant nature, it will certainly facilitate, 
improve and accelerate the understanding of students.  As well as, if the 
student does not understand about a topic, the student can repeat it until the 
student understands. This is one of the superiority of the computer compared 
with man, in which the computer never gets bored to receive one order 
repeatedly. 

4. Time and Scale.  Imagine, if we want to see the process of forming butterfly 
from a caterpillar directly on a tree.  Maybe the process will take days.  But, 
with the animation, the process can be accelerated only in a few minutes.  
Similarly with the scale.  It will be difficult for us to see erythrocyte which is 
in the blood.  But with animation, we can easily see the cell without having to 
use microscope. 

5. Training. The use of animation, as earlier stated, has the role in simulation.  
This simulation functions when we want to see the consequence of a matter, 
but it will be difficult to conduct an example in the concrete world.  For 
instance the simulation the consequence of an explosion in human.  It will 
not be possible for us to use man in this experiment.  This experiment will be 
possible, if we use animation.  In the animation several variables, which have 
very big similarity to man, are inserted, so that the experiment does not need 
man as the object. 

6. The place of this animation is in the form of a file, like other files, we can 
save them in internet.  If it has been saved in the internet network, wherever, 
whenever and whoever can access it easily. 

7. Community is unlike the book which goes through the process of printing, it 
will be difficult to reedit, because it must be reprinted.  It is adequate to 
appear in the monitor screen.  The change will immediately appear. 

8. Resistance power.  If a major earthquake occurs, all learning materials used in 
school, such as skull, torso (for biology learning), chemical materials, etc. will 
vanish by the earthquake.  But by using animation, the skull, torso, etc. will 
not be damaged, affected by the earthquake, if saved in the internet network, 
because we can take it again whenever we want.  Also by using animation, it 
will not be affected by wear or expiry.  We will not find the skull any longer 
which has dust all over it, or torso with some parts are missing. 
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Step 2:  Seeking and Finding Animation of Science Procees on 
the Internet (20 minutes) 

    Note for the Facilitator 
In this activity two internet connection is needed, if in the school internet access 
is not available, ask the participants to go to warnet and to practice it there.  

 
 
Learning or finding the information from the internet is the same as trying to take water 
using the glass from the channel of speedy flow of water. The information is so 
enormous, that the information we accommodate will spill. 
In the second step, we try ro make water filter to choose the water which we only need 
we accommodate. In other words, we seek and choose whatever information we need. 
For that purpose, follow the following second step: 

 

 Open www.google.com  (5 Minutes) 
Before enter the internet address, we open first the browser (Internet Explorer). 
Click the button START -> All Programs -> Internet Explorer. 
After the program is open, then type www.google.com in the address bar. The 
following window will appear: 

 
www.google.com is one of the search engines which is available in the internet. 
Search engine is the searching machine, with the duty of seeking the website 
addresses in accordance with the credieria we enter. There are several search 
engine in internet, the most frequent used one, are among others: 

1. 
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- www.google.com 
- www.yahoo.com  
- www.altavista.com 
- www.baidu.com 
- www.exICTe.com 
- www.hotbot.com 
- www.alltheweb.com 

- www.search.msn.com  
- www.looksmart.com 
- www.ask.com 
- www.alexa.com 
- www.about.com 
- www.refdesk.com 
- www.teoma.com 

- www.daypop.com 
- www.yisou.com 
- www.search.aol.com 
- www.snap.com 
- www.kartoo.com

    Note for the Facilitator 
The appearance will probably vary in each computer, if the Internet Explorer is 
not available, other browsers can be used, such as: Opera, Mozilla Fireworks, 
Netscape, etc. 
If there us extra time, let the participants try their own search engines to identify 
each difference. 
 

 Type the Keyword Wishes to be Sought (15 
Minutes) 
After opening the google page, enter the keyword we want to seek. For instance 
“cell animation” then press Enter. 
Then several websites will appear containing animation cell. For the example 
this time, try to click ‘Virtual Cell Animation Collection’. 

 
  

2. 

The window on the left 
side is the appearance of 
website on Animation 
Cell. Please explore! ☺ 
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    Note for the Facilitator 
May it will take a long time to appear the page containing animation, because the 
speed of internet varies. If in the slow condition, use only one computer as the 
example. If the connection of internet is fast, all participants can access it 
simultaneously. 
For the Indonesian-language website containing the scientific process animation, 
as well as other subjects animated, type the following address: http://www.e-
dukasi.net. 
Presented below are Tips on Searching in Internet. Have a Try! 

 
 
Taken from: http://www.smu-net.com/main.php?act=ti&xkd=3  
10 TIPS ON EFFECTIVE SEARCHING OF  
INFORMATION IN INTERNET  
[ March 28, 2001 ]  
 
If you often utilize the internet as a source of information, you should apply the 
following tips:  
 
1. Use several "Browser" simultaneously 
May be this matter is not secret any longer for you. But, you had better open 
several Browser simultaneously. In this way, you can open other browsers 
simultaneously waiting for other sites download are completed. How? 
a. Click Menu File (upper left of the screen)  
b. Select New Web Browser (or New Window). Or press  ^N  
Afterward, another windows will appear, which you can use to track other sites 
by typing the URL address. It is easy, isn’t it?  
2. Stop Option Graphics and See Drawing as necessary  
Time Out…Time Out…Wow, it is serious, if the situation is like this. If you 
often experience it, you had better stop the option graphics, because it is the file 
of image which has big sizes. How? Use Option Image,  in which the images will 
not be appeared first, as soon as the process of download is completed. If there 
us image you want to see, direct the mouse to the box of image. Click the right 
button of the mouse and select "Show Image" or "Show Picture".  
3. Don’t Afraid to Use Back Button 
Never be afraid to press the Back button, if you miss click the link. If you miss 
click the link, you need not want for the "download" until the process is 
completed. Just click the Back button as soon as possible. Or, if the appearance 
on the screen has not changed, click the button Stop. Both methods mentioned 
above will save time for the error made.  
4. Jump!  
But the back button is not always effective to be used, if you want to return to 
the previous links. Because you must click the Back button several times. There is 
a faster way. Use Go menu, the choose the web, which you desire. This method 
is much faster and much appropriate because you can directly "jump" to the page 
you want. 
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5. Make the Decision Promptly!  
This can save your money, if you are tracing the results of search of the search 
engine or internet directory hierarchy. Because, at the time of using web browser, 
your computer at that time is connecting to ISP. This means it take longer period 
to be connected to ISP, this also means that you must speed increasingly high 
level of money.  
6. use BookMark!  
Bookmark, bookmark, bookmark. Use bookmark to "remember" the sites 
address, which is interesting to you. As soon as you find the information wanted, 
is bookmark which the address of sites. Usually, by pressing the button ^D, the 
address of the relevant page can be directly remembered by the web browser. See 
also Tips No. 8.  
7. Don’t hesitate to Repeat  
Our computer often seems to "hang" when we are downloading a homepage. 
This can last for more than 5 minutes without any addition appearing in the 
screen. Certainly this kind of event makes disappointment. To avoid this kind of 
event, just click the button Reload/Refresh. This method is often successful.  
8. Categorize Your Bookmark  
If you have applied Tips No. 6 above, don’t stop there. Like papers on the table, 
if you don’t collect them and arrange in such a way, sooner or later, they will 
complicate yourself. Particularly if you collect your bookmark, which is 
enormous, make a folder.  
9. Ashamed to Ask Question, You will Go Astray in the Street  
It turns out that old proverb still applies, although many people say that the 
internet is the warehouse of information. But the problem is there are numerous 
information there. Therefore, don’t hesitate to ask question to the mailing list, or 
to the newsgroup, which relates to your question.  
10. Avoid Busy Day of Internet  
How is the performance of your internet connection? Slow? If so, have you ever 
observed when the connection is felt slow? One of the causes of the slowing is 
numerous users within the same period. To overcome this problem, you can 
conduct experiment by changing the times of connection of internet. May be if 
you surfing at about 5.00 a.m. (after SUBUH), your internet connection will be 
faster. It is anticipated that at that time there were still a few people use internet, 
because there are still many people who are illiterate. Or it may be that you do it 
at midnight.  
 
(adapted from Hill, Brad, WWW Searching for Dummies 2nd ed. IDG-Books).  
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Step 3:  Grabbing Animation of Science Processes on the 
Internet Using Internet Explorer. (15 Minutes) 

    Note for the Facilitator 
The animation available in Step Two can only be seen if we are linked to internet. 
But, how can we see again without having to be linked to internet? 
In this Step Three we will try to save the animated file which is available in the 
internet to be used in the future. 
This saved animation we will enter into Microsoft PowerPoint to be subsequently 
presented to participants. 
The Browser used in this example is Internet Explorer. 
 

To take the animation file using Internet Explorer, follow the following steps: 

 Open a Website which Presents Animation  
(5 Minutes) 
Open www.e-dukasi.net (EdukasiNet is a portal of learning material and the school 
community network, which is gided and developed by the Center for Information and 

Communication Technology (Pustekkom) of the Department of National Education. This site originates 
from a series of researches and developments which are conducted by the Pustekkom team).  
After it is open, seek an animation. 

 

1. 

Press link SMA in the ’Materi 
Pokok’ (Main Subject).  
(At that time there is no animation 
file for SMP level). 
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Choose one of the subjects. As an example, choose the subject on “El Nino”. Choose 
the link “selengkapnya” (“fully”). 

 
After that, the following window will appear: 

 
 

This is an animation. Usually, 
the extension is.swf (file 
extension for macromedia 
flash). 
If we found this animation 
file, follow the following step 
to take this animation. 
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 Take Animation File (10 Minutes) 
After finding the animation file sought, do the following step to take the 
animation file: 
Press the menu Tools -> Internet Option. Then the following dialog box will 

appear: 

 
 
 
Then, the following window will appear. This is the holder of Temporary Internet 
Files. This place is the place, where our pages and files are open in internet are saved. 
Including the animation files we open in the above-mentioned steps. 
To identify which file is included in the animation file, there are several methods: 

1. Seek the file having the extension .swf  
2. In the Type file, seek the Flash Movie type 

 

2. 
Choose Settings. Then this dialog 
box below will come out. Choose 
button View Files.
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    Note for the Facilitator 
This is one of the animation files. In the above-mentioned example, there are 3 
files which have the extension .swf (having the type of Flash Movie). If the 
computer we use has been used for a long period, Flash Movie files will certainly 
be enormous. It will also be difficult to seek what we want. 
Show to the participants that the first method of taking the animation we want is 
y seeing the Internet Address. The second method is by sorting the file on the 
basis of date. If you get used to it, the skill to seek the file wanted will feel 
automatically TERASAH. 
Flash animation files can be seen by clicking twice. it is also necessary to observe 
that to open this animation file, Flash Player must be used. Flash Player can be 
free obtained in: 
http://www.adobe.com/shockwave/download/index.cgi?P1 Prod Version=Sh
ockwaveFlash.  

 
If the file we seek has been found, conduct the copy file, then save it at the place we 
want (for instance: in My Documents). 

    Note for the Facilitator 
If participants do not know how to do copy file, show to them the easiest way, 
namely right click, then choose Copy. Then, at the folder wanted, right click 
again at the blank place, then choose Paste.  
Ensure that the participants do not forget any longer the place, where they save 
their animation file. We will use this animation file in the Step Four, inserting the 
Scientific Process Animation into Learning. 
 

 

Step 4:  Inserting Scientific Process Animation into Learning 
(15 Minutes) 
This time we will learn how to enter oe of the animation files, which we have saved in 
the previous step. The animation file we will enter into the application of Microsoft 
PowerPoint. 
In the initial settings, PowerPoint cannot directly enter animation file (Flash Movie) into 
the presentation document. To facilitate the inserting of this Flash file into the 
powerpoint, download and install plugin from Breeze at the following address: 
http://www.breeze.usu.edu/common/help/en/support/pptplugin.htm  
After being installed, open Microsoft PowerPoint. Press Start -> All Programs -> 
Microsoft Office -> Microsoft Office PowerPoint. 
To enter the animation file, press the Menu Breeze -> Insert Flash Movie... 
Then seek the animation file desired. Remember! The animation file has extension swf. 
Or if the Flash Player has been installed, the icon will have the following form: 
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   Note for the Facilitator 
Guide participants to carry out this Step Four. This time the activity needs several 
installation of other applications. The great possibility is the participants will feel 
confused.; Explain to the participants about the term “Plugin”. Plugin is a 
supporting application to facilitate us to perform certain several work.  
Also show to the participants a presentation file which has been complete with 
title of animation. 

 
 

   EExxtteennssionn  
In order that participants continuously seek and try the Scientific Process Animation in 
internet. Several recommendations are provided below for development: 

• When searching www.google.com, type like the following format: <keyword> 
filetype:<type of extension>. For instance tsunami filetype:swf. The results that 
will appear is all animation files which have the extension of “.swf”. Try to open 
several pages. If we want to seek the file which has the type of presentation such 
as powerpoint, complete the file type with the extension of powerpoint (.ppt). 
The following is some file extensions: 

- .swf: Shockwave Flash Player (usually animation) 
- .ppt: Microsoft PowerPoint (presentation File) 
- .pdf: Portable Document Format (Document File) 
- .doc: Microsoft Word (Document File) 
- .xls: Microsoft Excel (Worksheet File) 

• In the presentation process, divide each participant with several topics of 
discussion. Request them to prepare the materials of presentation, then seek the 
Scientific Process Animation file, and insert it into their presentation. 

E 
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AAccttiivviittyy  44  
LLeeaarrnniinngg  FFiinnaanncciiaall  MMaannaaggeemmeenntt  UUssiinngg  

CCoommppuutteerr  AApppplliiccaattiioonn 

Innttrrodduuccttiioonn 
Almost all people through out their lives will never be exempted from figures or 
numbers whether it is for measuring something or for trading things. On this activity, we 
will discuss about the basic principles of accounting, and then how to apply the 
principles in our daily lives. We will also discuss about the procedural steps of computer 
application to facilitate us in the process of recording and accounting calculation. 
 

   OObbjjeeccttiivveess  aanndd  LLeeaarrnniinngg  OOuuttccoommeess    
The objective of this activity is train the student’s ability in setting up personal financial 
planning, calculating profit and loss of a business, and making graphics on the 
developments of a business month after month or year after year. The participants will 
be trained using a computer application. 
 
By participating in this activity, the participants are expected to be capable of: 

• Understanding the basic principles of accountancy 
• Entering figures into working sheet 
• Conducting simple mathematical operation. 
• Using functions which are found in computer applications 
• Making an accounting system for a canteen or school cooperative (finishing 

project of activity 4) 
 

      

AAggee  TTaarrggeett::    
This activity is intended for all grades (VII, VIII, IX) 
 
���  LLeevveell  ooff  DDiiffffiiccuulltyy  
The level of difficulty of this activity is three stars. This means the difficulty level of this 
activity is above average. 
 

    LLiinnkkss  ttoo  tthe  Currriiccuulluumm     
ICT Competency 
This activity can be used to intensify the Competence Standard (SK) and the Basic 
Competence (KD) of ICT subject.  Specifically, the SK, KD which are contained are: 

 

Grade VII,  Semester  1 

IX VIII VII 
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Competence Standard Basic Competence 

3. Understanding human efforts in fulfilling his 
needs 

3.1 Describing human as social and economic moral beings 
in fulfilling needs 

3.2 Identifying economic actions based on moral and 
economic principles in various daily activities 

Grade VIII,  Semester  2 

Competence Standard Basic Competence 

3. Using numbers processor software to 
present information 

 Identifying the menu and icon the number processor 
software 

 Explaining the function of menu and icon in the 
number processor program 

 Using the menu and icon in the number processor of 
the software 

 Creating document on simple numbers processor 
 
Life Skills 
Also related to the development of life skills, as follows: 
Learning Skills Planning Decision Making Problem 

Solving 
Self 

Consciousness 
Vocational 

9 9 9 9 9 9 

   TTiimmee::  
Minimum 2 (two) hours. For practice work , it can be adjusted to the needs. 

    RReeqquuiirreedd  MMaatteerriiaallss  
• Blackboard 
• Stationary 

IInfoorrmattiioonn  aanndd  CCoommmuunniiccaattionn  TTeecchnolloggyy 
• Computer Unit which has been installed with Microsoft Excel applications. 

Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (if permissible) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 
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   AAsssseessssmmeenntt  

Financial intelligence has nowadays become one of the most important things in 
planning and the success of life. At this moment the evaluation is based on the 
participants’ basic skills in understanding financial intelligence and its application in their 
daily lives. 

These are several technical matters, however, which need to be attended to and perhaps 
become points of consideration during evaluation: 
• The accuracy in data/figure entering 
• The ability to understand a material 
• Financial logic 
• Basic operational capability in using computer/data processor 
• Taking initiatives 
• Knowledge of functions on the data processor/computer 
• Capability of presenting figures into a graphic 
In order to be objective during assessment, pass the assessment matrix sheet to each of 
the participants, and let each of them evaluate the result of another participant’s work. 
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Step 1:  Explanation of Basic Accounting Principles (10 
minutes) 

    Note for the Facilitator 
Before the participants are allowed to use the data processor maximally, they 
should first be explained about the Basic Accounting Principles. 
Also, it is necessary for the participants to be stimulated so as vividly they will 
follow this activity. If there’s internet accessibility, let the following page be 
opened: http://niex-klaten.blogspot.com/2006/07/mengukur-fq-financial-
quotient.html. The page discusses a little explanation about financial intelligence 
which must be possessed if we want our lives to be successful.  
Of course, it is not easy to understand accountancy in one time meeting, 
especially when it is only in ten minutes. Give the participants materials on basic 
principles of accounting.  
In the CD that accompanies this toolkit, you’ll find a document of power point 
presentation concerning Basic Principles of Accountancy. That presentation 
contains materials, quiz, glossaries, reading reference, etc. Follow the instruction 
in there that you may be familiarized with  that presentation. After that give the 
participants a summary on what is meant by accountancy and financial recording.  
Here under, you will find a summary of document on the presentation of Basic 
Principles of Accounting. Please, when participants begin to get confused, tell 
them that this is an accounting theory. To get deeper insight, you are 
recommended to read it outside of this activity. Also tell them that what we are 
going to do in the next step is to directly put into practice accountancy in our 
daily lives. 
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  Handout for Participant 4.1 
Measuring FQ (Financial Quotient) 

 
Measuring FQ (Financial Quotient)  
Following after intelligence Quotient (IQ), Emotional Quotient (EQ), Spiritual 
Quotient (SQ), you now have the Financial Quotient (FQ). Financial intelligence 
is a personal capability in cultivating his personal ability for earning and managing 
money. This intelligence is needed in order that we are not trapped in bipolar 
financial problems: lacking of money or over abundance of money. Lacking of 
money causes one to be always busy making money, and this situation may take a 
person into spiritual blindness that eventually will justify him for any means to 
getting money, over abundance occurs on someone who owns overly abundant 
money but who is incapable of being grateful or thankful and feels unhappy. 
 
When we were just born, our FQ score was zero, because we were absolutely 
incapable of fulfilling our financial needs on our own. Later on, the older we get 
the more we learn and begin to gain ability in earning something and decreasing 
our dependency on our parents. 
 
For instance, when we were in high school, our monthly need is around 
Rp.400.000,-. Later that time, we begin to have part time job of selling snacks 
around the class with a net earning of The Rp.50.000,- of such our individual FQ 
score = 50/400 = 0.125. Then when we get into college, our needs increase to 
Rp.600.000,- monthly. But by this time we already have plenty of links that our 
round the class snacks selling has grown into opening stands in places for 
students or dormitories, for some commissions. This business earns us 
Rp.150.000,- per month. Our individuals FQ score grows into 150/600 = 0.25.  
 
Our business keeps growing until eventually we become an agent of well 
established snacks business company which has big market and well organized 
marketing network that enables us to earn Rp.600.000,- per month. And so our 
individual FQ score becomes 600/600 = 1. 
 
Score 1 is a score of self reliance or may also be called score of independence 
which actually means that we have passed the dependence stage!!! 
 
So, why don’t we calculate our FQ score now? (Ashamed of your score?)  Then, 
let us make a plan to raise our FQ score level. Get a piece of paper and a pen, 
and write your plan forward! 
 
A Paraphrased version of: http://niex-klaten.blogspot.com/2006/07/mengukur-
fq-financial-quotient.htm  
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  Handout for Participant 4.2 
Basic Principles of Accounting 

A. Financial Transaction* 
 The realization of a transaction can be seen in proof of transactions such as 
receipts, invoices, notes and memos. Transactions that happen are usually expressed 
descriptively by hearing three primary matters as follow: 

Date of Transaction, points at the date when transaction took place and this is stated 
in the proof of transaction 
Description of Transaction, refers at a memo that explains about the type of 
transaction that happens 
Value of Transaction refers to the amount of money of the transaction, while for 
certain transactions which carry interrelation ships with other transactions, the value of 
such transactions are at times not stated. 

 
 
 
 
Date of Transaction Æ May 10, 2002 
Description of Transaction Æ Received…for car wash service 
Value of Transaction Æ Rp25.000,00 
 Type of transaction that happens may be known by looking at the keyword stated 
in the description of transaction. On the above example, the keyword is received 
payment and car wash service. This points to the fact that the company has received cash 
for a service rendered, which was the benefit of clean washed car that ucok experienced. 
Some other keywords are: purchased, sold, paid, in payment for, return to and received 
repayment. 
 
B. Proof of Transaction 
 Every financial transaction that occurs must be recorded in the proof of 
transaction correctly. Proof of transaction is the source of recording in accountancy. The 
types of transaction proofs may be differentiated as follow: 

Internal Proof refers to proof recording for a transaction that took place within the 
company or organization. For example, memo written by the book keeping manager 
External Proof refers to proof recording for a transaction that took place between the 
company and other party/organization. For Example: Cash expenditure proof, cash 
payment proof, cash received proof, sales proof, and purchase proof. 

 
The following are some examples of external transaction proof: 
a. Receipt 
Receipt is a record of receiving and spending of money transaction.  
Receipt consists of two parts, the right part of which is to be given to the party that pays 
and the left part which is called “soice (pronounce sus) to be kept as file by the party that 
receives the money. Receipt may be written in several copies as needed. 
 
  
b. Invoice 
                                                 
* Taken from: Accounting written by Ajang Mulyadi. Grafindo Publisher 

Example: 
May 10, 2002  Received payment from Ucok for car wash service at the 

amount of Rp.25.000,- 
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Invoice is a transaction proof of purchase or sales of goods (usually carried out on 
credit). Invoice is issued by the seller and is given to the buyer / purchaser. On the seller 
side, invoice issued functions as sales invoice. While on the buyer side, the invoice 
functions as purchase invoice.  
Invoice is usually issued in three copies, and used for the following purposes: 

First copy for the buyer; 
Second copy for the seller; 
Third copy for file; 

 
c. Debit Note 
Debit note is a transaction proof on the return of goods purchased. Debit note is issued 
by the purchaser (purchase returnable). 
 
d. Credit Note 
Credit note is a transaction proof on receiving back of goods sold (sales returned). Credit 
note is issued by the seller when goods already sold is returned by the purchaser. 
 
e. Cash Note 
Cash note is a record proof of goods purchased on cash transaction. Cash note is usually 
issued by a trader that sells goods in small party (retailing business). Cash note is written 
in two copies, one copy is given to the buyer and the second copy is kept for file by the 
seller. 
 
 f. Check 
Check is an order letter to a bank for paying an amount of money to the check holder. 
Check is written by the party that has a deposit in a bank. Check is divided in two parts, 
the left part is kept as file and the right part is given to the party that needs the check. 
    
C. Accounting Basic Equation 
  The recording of transaction in accountancy must be done systematically 
and regularly that an equation which is called basic accounting equation may be reached.  
  Every transaction must be recorded based on the double entry principle 
that is the principle of keeping balance between assets and liabilities. 
   
 
 
 
 
 

 

Asset = Liabilities + Equity* 
 

*Income increased capital, cost reduced capital. 
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D. Financial Statement 
 Financial statement is the end of an accounting process which is 
presented in time of reporting. In the financial statement, information on the 
financial position during  relevant period is presented. 
 Information which is presented in every financial statement is 
interrelatimal one to the others. Therefore, the order in the preparation of 
financial statement must be carried out as follows: 
 
 
 
 
 
 
 
 In brief, a financial statement contains several points as follows: 
Profit & Loss statement: All incomes deducted by all costs will result in profit 
or loss. If income is bigger, it is called profit and on the contrary it is called loss.  
In a merchandizing company: Incomes deducted by cost of goods purchased 
and also deducted by sales costs. 
Capital statement-- changes in, refers to any charges that occur in the capital, like 
withdrawal of personally invested money or capital investment. Also, included is 
the capitalization of either profit or loss obtained from point (a) above. 
Remember, profit or loss (all incomes-all costs) is recorded in the capital side. 
Balance Sheet: This refers to the balanced condition between the assets side and 
debts (liabilities) plus capital. Thus, in the balance sheet, every transaction is 
recorded again in it’s account designated. Remember also that assets must always 
be in balance with liabilities (debts) + capital. Here the capital is obtained from 
the final capital position (point b) above.  
Cash Flow Statement: This points to sources of cash and it’s uses for what 
purposes. The difference in the sources and uses of cash or funds is called Cash 
Balance. 

 

Profit/Loss Income 
Statement 

Statement of Changes 
on Capital  

Balance 
Sheet 

Net Profit 
of Loss 

End Capital 
Position 
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Step 2:  Getting to Know the Application of Date Processor (45 
Minutes)  

    Note for the Facilitator 
The following is a tutorial or a lesson on Microsoft Excel taken from 
www.IlmuKomputer.com. IlmuKomputer.Com is a site that contains materials 
and free of charge Lectures in Indonesian language on computer science and 
information technology. By now the site has grown to be an “Open community a 
Learning-“Gratis” Ilmu Komputer Indonesia. The main mission and it’s 
proclamation are to partake (be in participation) in building up the intellectuality of 
the people, particularly in computer science education. Gratis or free of charge 
materials with open content license are accessible in PDF format that can be down 
loaded anytime. Also available Gratis CDROM and Mirror Server for you who are 
at difficulty getting access on this site. 
 

Microsoft Excel Tutorial 
Tua Namora Nainggolan dan Team Kursus Komputer Trainee Jepang  
cokubear@yahoo.co.jp  

Document License:  
Copyright © 2003 IlmuKomputer.Com  
All documents contained in IlmuKomputer.com may be used, modified and 
disseminated freely for non commercial purposes (non profit motives), an condition 
that no part of this be either erased or writer’s attribute be charged, and accompanied 
by statement of copyright in every document. Rewriting of the material is not 
allowable, unless there is a secured permit from IlmuKomputer.com 
 

 
I. Getting to Know Microsoft Excel 
Microsoft excel, later known to be excel, is an application program which is plentifully 
used in assisting the user to calculate, to protect, to analyze and presenting data. Here we 
are going to be often time in touch with methods of making tables and graphics that are 
much needed in company’s data preparation and presentation, research results analysis 
and in the making of personal papers. 
  
  
II. Working with Microsoft Excel  
   A. Microsoft Excel Worksheet 
Before entering into the discussion of Microsoft excel, it is also good t get first to know 
with the appearance of Microsoft Excel, with also some of its much used general 
terminology. Some of the general terminology that appears in the following pictures are 
frequently used in our following discussions, and so we would be better off memorizing 
them.  
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Picture 1: Microsoft Excel Exhibit and some important terminology  

 
   B. Moving the Cell Pointer  

There are several methods in moving the cell pointer. For its complete ways please see 
the following table:  
  
Table 1.Some Ways for moving the cell pointer 

 Button Description 

  
Move from one cell to the left, to the right. Upward or down ward

Enter  Move from one cell down ward 
Home  Move to A column on the position of active line 

Ctrl + Home  Move to A1 Cell on the active worksheet 
Ctrl + End  Move to end cell position of the line in use 

PgUp  Move to one layer up 
PgDn  Move to one layer down 

Alt + PgUp  Move to one layer leftward 
Alt + PgDn  Move to one layer rightward 
Ctrl + PgUp  Move from a worksheet table to the next worksheet table 

Ctrl + PgDn  Move from a worksheet table to the previous worksheet table 
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C. Entering Data into Worksheet 
Various types of data may be entered into the worksheet like text, values, dates, hours 
and etc. In order to enter data into a cell, the following steps must be in the procedure: 
 1. Choose or click the cell where data are to enter 
 2. Type the data you want to enter in 
 3. Press the data or button of arrow director or Pg up and Pg Dn 
  
      D. Correcting Errors of Typing 
If ever there’s data typing error, you may correct it by following these procedural steps: 

1. Choose the cell where in data need to be corrected, then press F2 or click the 
left button of the mouse twice on the cell of the data that need correction. 

2. Then, correct the wrong data and press the enter button if you have finished 
correcting it. 

 
E. Using Formula 

You may enter formula of math instruction into a cell of your worksheet. The calculation 
operators that you can use among others are: + (addition),  - (deduction), *  
(multiplication), ^ (exponential). 
  
In Identifying ways for its uses, you must first prepare a table like what is in picture 2 
below: 

     
Picture 2. Work-wages Table  
  
In order to fill in cell E5 which is the Total Wages Received, there are several ways you 
can follow:  
  
¾ Writing Formula using fixed figure  

 a. Direct the cell pointer to the position wanted (in this example it is E5)  
 b. Types the formula “=48ˇ3500” on the column of formula and press enter   

Note: The writing of formula must always be preceded by a symbol “equal” (=)  
  
¾ Writing Formula using Cell Reference 
 a. Please position the cell pointer on the intended position (in this example it is E5) 
 b. Type the formula “=E3ˇE4” on the column  and press enter  
Note: By the use of this method, any change of data in cell E3 and or E4, will cause the 
result in cell E5 be also changed.  
  
¾ Writing Formula by Pinpointing  
By the use of keyboard or mouse:  
 a. Please position the cell pointer on the intended position (in this example it is E5) 
 b. Type “=” on the column of the Formula  
 c. Choose or click cell E3, then click “ *“ 
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 d. Choose or click cell E4, then press Enter.  
 
F. Setting up Range or Cell Block 

At the moment of working using Excel, we are not only working in just one cell. 
Sometimes, you are going to work in groups of cell. For Example, if you want to change 
any type of letter of some columns and or lines, you want to change formula of some 
columns and or lines, copy-paste or deleting data of some columns and or lines, etc. In 
condition like the above, you can use this range or cell block for your easier work.  
Range is named in accordance with its cell address positioned at the up-left end all the 
way down through the right-end. For example, the range that extends from B2 cell to E7 
which is written as range B2-E7. (See Picture 3).  

   Picture 3. Range B2-E7 Exhibit  
  
Range/ Block Cell maybe setup in several ways:  
¾ Setting up Range by using Shift Button  
 a. Please position the cell pointer at beginning range of cell intended to be blocked, 

that is B2 (See Picture 3).  
b. While pressing Shift, also press arrow button to reach the intended cell, that is E7 

¾ Setting up Range by using Mouse ** 
  a. Click the cell which is the beginning cell range that is B2. Mouse pointer must 
be in the white positive symbol (Pointed in the cell, not at its side). (See Picture 3).  
 b. While pressing the left click of the mouse, drag the mouse pointer to the 
intended cell that is E7 Cell.  
¾ Setting up Columns and Rows  
 a. Click the cell of the beginning cell-range, which is B2. The mouse pointer must be 

at white positive symbol (pointed in the Cell, not at its side) (See picture 3).  
 b. While pressing the left Click of the mouse, drag the mouse pointer to the intended 

Cell that is E7 Cell.  
A column or row maybe lime-lighted by clicking a letter of the column or a number 
of the line intended. Like for instance, clicking a letter of column B if you intend to 
lime-light all Column B.  
  

¾ Blocking a Series of Columns and Lines  
In order to block a series of columns (like for instance BCD) as a series of lines (like 
for instance 3, 4, 5), you may do so by following these steps:  

 a. Click at a beginning letter of column or at a beginning number of a line (in this 
example, it is B or 3)  

 b. While pressing the left button of the mouse, drag the mouse pointer to reach the 
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fully lime-lighted lines (in this the example is D or 5).  
  

   
Picture 4. Lime Lighting Series of Columns  
  

G. Deleting Data  
For data deleting from a cell or certain range of cells, moving cell to, etc., please make or 
set a range of places you want to delete, then press the Delete Button. And when you 
want to delete the exhibit format of a data/ cell, you can do it by choosing and clicking 
the Menu Edit, Clear, Formats. 
  

H. Entering a Series of Data by Using Auto Fill Facility  
Entering data like figures or texts by using Auto Fill Facility, you can do it by following 
the steps as follows:   

1. Choose or click the beginning position of the cell’s place of the series of data you 
intend to set. Example: choose or click Cell B2. 

2. Type the beginning data that is intended. Example text of “Jan” (January) 
3. On the next cell (cell under it) B3 or at its side (C3), type the next data that you 

intend. Example at B3,, you type “Feb” (February) 
4. Lime –light or just block B2 : B3 (See Picture 5) 

   

 Picture 5. Beginning Data Exhibit 
5. Still on the condition of being lime-lighted, direct the mouse pointer at down-

right and corner of Cell B3 till the white positive (plus) symbol changes to 
positive black.  

6. Press the left button of the mouse and drag the mouse pointer position to the 
intended Cell, for example B12. By doing such, the series of figures data can be 
exhibited. See Picture 6. 
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Picture 6. Result of Data Series by the Use of Auto Fill Technique  
  
 I. Using Auto Calculate and Auto Sum Facility  
¾ AutoCalculate  
Auto Calculate Facility (automatic calculation) is used in doing speed and easy calculation 
of many data in certain range room. Within this Auto Calculate Facility, there are 6 
instructions, which are automatic instruction to calculate average, addition of data 
(count), many figures data (Count Numbers), Maximum Value (max), Minimum Value 
(min), and Summation or Totaling figures data.  
  
The how-to of using auto calculate facility is as follows:  
 1. Lime-light the data range you will calculate. For example limelight range C7; C12 

from the data like here under.  
 

   
Picture7.  Example of using Auto Calculate  
  
 2. Click the right button of the mouse on the status line, and choose type of calculate 

that you intend to use. Example, choose Average (A) to calculate Data average.  
 3. The result will be exhibited at the status line.  
 
¾ AutoSum  
The function of Auto Calculate above is to calculate speedily many data, but by this it 
cannot automatically write the result on your worksheet. Especially for summation 
there’s an easy way to do it which simultaneously also can write the result in your 
worksheet. The way is simply using the toolbar button AutoSum (∑).  
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In the example above, if me want to write the total unit, just place the mouse pointer at 
our intended position (example, C13), then press the button ∑ on the toolbar. Next, 
limelight the range that is intended to be totalled ( in this example it is C5;C10 ), then press 
Enter.  
  

  Picture 8. Example of using AutoSum  
 

 Step 3: Practice: Using Data Processor Application in Personal 
Financial Planning (20 minutes) 

    Note for the Facilitator 
On step 3, there are several things we will do. First, is to decide on what things to 
buy and at what price. Second, is to analyze on how much income we make and 
what expenditure we spend out every month. Finally, is to determine the 
difference (balance) between our monthly income and monthly expenditure. The 
difference is going to be our saving which we will use in buying the things we 
want. 
Show the participants the final result that they must achieve in the practice of this 
time. Try to give the least assistance. Let the participants try and be on their own 
doing this exercise. 

 
Udin is a seven grader SMP student wanting to buy a bicycle at the price of Rp.240.000,-. 
He, however, doesn’t have the mount money now. Luckily, Udin has learnt to use data 
processing application. In the first step he does an analysis on how much money he 
receives every month and what expenditures he spends out during the same period. The 
result of his analysis is a follows: 
 

Monthly Income  Monthly Expenditure 
Monthly Money 50000  Transportation Cost 30000
Other business 25000  Purchase stationary 10000
Bonus 10000  Snack & Softdrink 5000
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Please assist Udin in his financial Planning. The followings are questions that Udin asks: 
1. How much is the total income and total expenditure of Udin per month? 

(Instruction: please use AutoSum Function.) 
2. How much monthly balance that Udin get? (Instruction: The difference between 

Income and expenditure per month.) 
3. How many months does Udin need till he will be able to buy or purchase his 

dreamt bicycle ( Instructions : use division ) 

    Note for the Facilitator 
Make sure that the participants do not manually calculate. Let them use the 
AutoSum function for the Summation. And so with the deduction and division to 
prevent them from using manual calculation on transportation costs, purchases of 
writing utensils, buying Food & Drinks, etc. If there’s no change on total Income 
& Expenditure (monthly), the participants must have calculated it manually. To see 
on what is supposed to be the final Exhibit, see picture below. 

 
 
 
The final result intended is as follows: 

 

Step 4: Making Graph (10 Minutes) 
Fortunately, Udin doesn’t have that much monthly expenditure. If he has many kinds of 
expenditure, it will be difficult to find out which expenses are most and therefore he may 
reduce expenses there from. Here is also feature that can serve him to make to graph 

(1) 

(3)

(2)

(1) 
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that’s provided by Excel. By having graph; it will be much easier for him to figure out the 
percentage of each expense. 
To make graph, please follow these steps: 

 Highlight the area where you want it to be 
displayed in Graph. (5 Minutes) 
Before we make the graph, the computer needs to know what is intended to be 

graphed. Highlight to choose the area intended for it. 

 
 Making Graph. (10 Minutes) 
After choosing the area, what we do next is to make the graph. This can be done 
in to ways. First, is by clicking on the graphic icon chart   second, is pressing the 
menu Format -> Chart... Then the following window will appear: 

1. 

2. 

Drag the mouse 
pointer from cell D6 
toward E8 Cell (Title 
and Total of monthly 
expenditure) then click 
the graphic chart icon. 
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Choose PIE graph 
type. Then choose 
picture that looks like 
cake cut into pieces 
then press the NEXT 
button. 

The picture on our left 
side is a graph exhibit 
that we have made. 
Make sure Columns is 
chosen. Then press the 
NEXT button. 
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The graph that we made will look like below: 

Grafik Pengeluaran Bulanan
Ongkos
transport

Pembelian alat
tulis

Makanan &
Minuman
Ringan

 

What is visible from the graph is obvious that transport expenses, occupies the biggest 
proportion in comparison with other expenses. Try to change the total of each expense; 
you will see that the graph will also change in accordance with the changes in the data 
that we have entered. Have a Try!☺ 
 

Write the graph title 
then, press the NEXT 
button. 

Choose the area where 
the graph is to be 
exhibited. It is made as 
a new worksheet, or as 
a picture on a chosen 
worksheet. Now, 
choose As Object in 
Sheet 1. Then press the 
FINISH button. 
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   EExxtteennssiioonn  
Do the following things so that the participants may continuously sharpen their financial 
intelligence: 

• Make a school canteen accounting system which states the school canteen’s 
incomes and expenditures. Also its financial statements such as its profit and loss 
statement, monthly. A graphic that shows its development month after month, 
after year after year is also needed. 

• Make a personal financial planning; include in it the plan for expenditure and 
incomes and the amount of money planned for saving on daily, monthly, and 
yearly basis. Then make a graphic of the increasing (growth) in savings or the 
decrease in money owned. 

• In relation with a school concert organized by students, the committees mobilize 
its people raising funds for the program, when the concert is over, the committee 
is asked to write a report on financial accountability. Try to make the financial 
statement to appear that the total incomes and total expenses are at least 
balanced. If there’s a surplus) incomes > expenses), calculate how much the 
surplus is. How’s the committee’s compliance with the planned budget. Also plan 
on what to do with the surplus. 

 

E 
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AAccttiivviittyy  55  
CCoollllaabboorraattiivvee  LLeeaarrnniinngg 

IInnttrroodduuccttiioonn 
Sometimes it is difficult to find answer to our questions. Each time we ask the person 
around us, they nod the head or lift their shoulder saying: “Sorry, I cannot help. I don’t 
understand about this matter.” 
Maybe the answer is frequently uttered by the persons around us. But, the world is large. 
The science is disseminated all over the world, and very many people from all corners of 
Indonesia and the world with pleasure help us solve the problems both relating to life, 
learning and employment.  
In this activity, We will understand what is meant by joint learning, how to join in a 
group as well as the last is how we set up a group of joint learning in the internet. 
 
 

OObbjjeeccttiivveess  aanndd  LLeeaarrnniinngg  OOuuttccoommeess    
The objective of this activity is to introduce one of benefits of Internet, namely joint  
learning. In addition, the participants understand what is meant by joint learning, the  
participants will also learn how to register in a group of joint learning, as well as how to  
set up a joint learning group in Internet. By following this activity, participants are  
expected to be able: 

• To understand what is meant by the joint learning 
• To know the tips on attending a joint learning group 
• To joint in a joint learning group 
• To set up a joint learning group (Project at the end of Activity five) 
 

 

      

AAgge  Taargeett:    
This activity is intended for all grades (VII, VIII, IX) 
 
��� LLeevveell  ooff  DDiiffffiiccuullttyy  
The level of difficulty of this activity is three stars. This means the difficulty level of this 
activity is above average. 
 

    Liinnkks  too  tthe  Cuurrriicculuumm     
ICT Competence 
This activity can be used to intensify the Competence Standard (SK) and the Basic 
Competence (KD) of ICT subject.  Specifically, the SK, KD which are contained are: 
 
 
 
Grade VII ,  Semester 1 

IX VII
I

VII 
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Competence Standard Basic Competence 

5. Understanding the use of information and 
communications technology and future 
prospect. 

 

 

1.9 Identifying various equipment of information and 
communications technology 

1.9 Explaining the role of the information and 
communication technology in daily life 

1.10 Identifying various benefits and uses of the 
information and communication technology 

Life Skills 
Also related to the development of life skills, as follows: 

Learning 
Capacity 

Information 
Searching 

Decision Making Problem 
Solving 

Self 
Consciousness 

Vocational 

9 9 9 9 9 9 

 

   Tiimmee:  
Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs. 
 

    RReeqquuiirreedd  MMaatteerriiaallss  
• Blackboard 
• Stationary  
• Photocopy of “Joining a Mailing List” sheet to be distributed to the participants. 

IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  TTeecchhnnoollooggyy 
• Computer Unit which has been installed with the following application: 

o Internet Explorer (or any other browsers) 
• LCD Projector (if permissible) 

   AAsssseessssmmeenntt 
This activity is further emphasized in the aspect of following the instruction. There are 
several matters, in which evaluation can be conducted: 

• Understanding about the joint of learning (mailing list) 
• The capacity to seek the group desired  
• The capacity to carry out the basic instruction in the mailing list 
• The capacity to reveal question 
• The capacity to set up mailing list group 
• Etc. 

 
In order for the evaluation can be objectively carried out, distribute the evaluation matrix 
sheet to each of the participants, and let them evaluate the work result of other 
participants.
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Step 1:  Understanding what is meant by Collaborative Learning 
and Mailing List (15 Minutes) 

    Note for the Facilitator 
Explain to the participant that the joint learning in the internet is not limited to the 
use of mailing list. There are many other ways, among others the existence of 
forum website community online, etc. 
In this activity, we limit to the use of mailing list. Mailing list is elected, because the 
process of registration and preparation are relatively easy and can be conducted by 
anyone within a fast period. Below is the explanation about the joint learning 
(collaborative learning) as well as about mailing list. (Translate into Indonesian, if 
participants do not understand the meaning). 

 
If internet access is available, type define:COLLABORATIVE LEARNING in 
www.google.com. Then the following window will appear. 
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  Handout for Participant 5.1 
Mailing List or Milis 

Since our focus this time is mailing list, the following is the explanation about Mailing 
List: (taken from: http://balita-anda.com/milis.html)  
 

Mailing List or Milis  
Mailing list is the word, which is very intimate for internet user, particularly, the email 
fan, what is mailing list? 
Mailing list, also usually abbreviated to Milis, basically is a group of persons joined in 
an electronic discussion form (two ways) or electronic publications (one way) to 
discuss a topic based on the certain interest and objective. Therefore, there is Milis 
for garden, Milis for reporter, Milis for those who have children under 5 years old, 
milis for Internet practitioners, religions Milis, Milis for marketing practitioners, etc. 
Through this facility, members are permitted to freely and openly discuss a problem 
and exchange information in accordance with the mission and objective of Milis. 
The persons who joins in milis called member or participants,  while the persons who 
safeguards milis is called administrator or moderator or usually called list admin or 
list owner. Their duty usually involves problem of milis administration and other 
technical matter, such as bounced email, approve message, statistical posting, 
safeguards in order that the regulation of milis is complied with, etc. while the 
content of milis lies in the responsibility of list moderator. But, in practice in milis 
milis in Indonesia, both functioned are combined into one.  
And although requested by list-admin or list-owner, in practice there are two types of 
milis. 
The first type is milis which does not use moderator, or called open milis. In this 
milis, each posting (email) of direct member is disseminated to member, without 
having to be approved first by moderator. Even, anyone may subscribe without 
having to be approved by moderator. At the most, the would-be subscriber only 
receives a reply which must be replied, only to check whether the email address is 
already correct. While the second type is the milis, which is controlled by moderator, 
or usually called closed milis. In such a milis, each posting must go through 
moderator and than after being approved disseminated to member. In the milis of 
this type, subscribe must be approved by moderator. Those who do not meet the 
requirement are rejected. 
Each milis indeed has its own procedure. But, in general, they only expects its 
member to send a posting, which is in accordance with the objective of milis, and not 
messages which can be categorized as pornography, junkmail or spam. The violation 
against this rule, will usually sanctioned in the form of the dismissal from the 
membership. 
At this moment, in the cyber world, there are thousand of milis. Almost each day 
thousands new milis emerge, while the old milis are void. In Indonesia alone, there 
are many varieties of milis. There are new milis, but there are milis which silently 
disappears. There are milis which are laris, and there are milis which are kurang laris. 
Several milis, have many members, while others only have a few members. 
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Step 2:  Knowing Tips on Joining a Mailing List (15 Minutes) 
 
The following are quoted from: http://www.smu-net.com/main.php?act=ti&xkd=2  

 
MAILING LIST TIPS 
[March 28, 2001 | 1363 readers]  
Adopted and translated from RFC-1855 
 

Adhi has a red face when he opens his email. The problem is that he gets email from 
the persons, which he does not expect in advance. Oops!!? Yea, it turns out that he 
has ever sent an email in a Mailing List. What worst is, the email is read by all 
members of mailing list. As a matter a fact, he intends to send it to the one he loves. 
 
In order that you are not ashamed as Adhi, the following are several tips on mailing 
list. There are general tips and special tips. OK, in order not to waste time, directly 
observe them! 
 
GENERAL 
1. Read the mailing list which you follow, at least one month before you start 
participation by passing. This is important, to assist join in understanding the culture 
of mailing list concerned.  
2. Don’t blame the system of administration, for something which is done by another 
member.  
3. Be careful to write, remember, there are very many people read your posting. And 
you need to know that mailing list often has file (archive) and the words you write 
will be save within a quite long period at the place, which can be accessed by many 
people.  
4. Assume that individual states the opinion privately and what they express does not 
represent the organization they follow (except specifically mentioned).  
5. Only observe the special regulation owned by the organization follow. Remember 
that email uses resource.  
6. Make effort in order that message and article you write, start and direct to the print. 
Don’t send the message which only shows the editional error of someone, such as: 
mistype or misspell. If you do, all people are certain to brand you as a beginner, who 
is not adult yet.  
7. Forgery of identity (forgery and spoofing) are the matters, which are no be 
justified.  
8. If replying a message, ensure you summary the previous posting on the upper side, 
or include only the part you consider important just to give context to your posting. 
This will make readers understand when they read your reply.  
9. Ensure that you have signature in your posting. This will ensure that certain mail 
client cutting the header will eliminate reference in your message on how to contact 
you.  
10. Be careful if you reply the posting of another person. The reply to a message will 
often go to the sender, but there is also directly goes to the whole group if you do not 
intentionally send the personal message to the whole group. Wow, It’s very 
embarrassing.  
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11. If you unintentionally send personal message to member or certain group, you 
must promptly the request for forgiveness to the person you direct and the relevant 
group.  
12. Never get involved in a flame war, Don’t react to sensitive matters.  
13. Avoid sending a message, which only contains thankfulness to the response which 
has been given.  
14. Be careful with the type of letter you use. Certain type of letter can be presented 
differently in different system and in different email client. 
 
SPECIAL 
There are many ways to find information on whatever mailing list available in the 
Internet and how to follow them. But, it is better to ask first to your organization 
before seeking information through Internet. Certainly there are several sets of file 
which are periodically posted in news. Answers which describes on the mailing list 
available in the Internet and how to follow them. This is a very valuable source to find 
the mailing list with certain topic. 
1. Send the message subscribes and unsubscribe to the appropriate address. Although 
several mailing list software are quite 'clever' in 'catching' such matters, not all of 
them can do it.  
2. Save the welcome message you receive, if you follow a mailing list. This message 
will usually inform you how to unsubscribe to the mailing list.  
3. In general, it is impossible to cancel the message you have sent. Even the 
administrator system will not also be able to cancel a massage, if you have sent it. 
This means that you must really ensure that a message is ready to be sent with the 
consequence to be read by many people.  
4. The auto-reply feature from mail client which is useful in private communications 
will interrupt if sent to the whole group. Check the address "Reply-To" if replying the 
message from the mailing list. Most of the auto-reply will be sent to all members of 
the mailing list.  
5. Don’t send big file to the mailing list if the URL address or ftp address is not 
adequate. If you want to send as something which is divided into some parts, ensure 
you follow the habit of the group you follow. If you don’t know what the habit looks 
like, ask first.  
6. Consider activating the 'normal' option (if available), if you cannot check your 
email within a period, which is relatively long.  
7. If you send message to more than one mailing list, particularly if the topic of the 
mailing list is interrelated, forgive for the existence of cross-posting.  
8. If you ask, ensure that you summarize the answers and if you want to send the 
summary, properly summarize them and don’t only send the collection of the 
messages you receive.  
9. Several mailing list are private, don’t sent to this mailing list without being invited 
and don’t repost the message which you get from this mailing list to another person or 
mailing list.  
10. If you are trapped in the argumentation, maintain that the discussion is focused on 
the problem and not on the attitude and personality of the relevant persons..  
 
 
 
 
 



USAID DBE3 Life Skills for Youth 133

Step 3:  Seeking an Online Learning Group (10 Minutes) 

    Note for the Facilitator 
This third step needs internet line. If the interne line available is very slow, do in 
front of the class, then show to participant. After that, in turn and in group, request 
participant to seek an online learning group desired.  

 
 
There are hundreds even thousands of mailing list or learning group/online discussion in 
the internet. One of the greatest mailing list maker is the internet is YahooGroups!  
Open the address http://groups.yahoo.com.  

 

After yahoogroups 
display come out, type 
the word “belajar” then 
push the button 
SEARCH. 
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Then the following display will come out: 

  
These are the names of online learning group available in the YahooGroups 
together with the information on what is the mailing list. We can choose 
whichever group. The next step is how we join with the group we desire. As an 
example for the activity this time, press link free-english.
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Step 4:  Join with Online Learning Group (20 Minutes) 
The next step is to register. Follow the following steps to join with a mailing list. After in 
the Step Three we click one of the links, the following window will appear:  

 
After that, enter username and password YahooID. If not having account in Yahoo, to 
register you can send email to Free-English-subscribe@yahoogroups.com.  
 

This is the 
information 
about the 
status of this 
mailing list. 

To join, click the 
button Join This 
Group! 
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Step 5:  Making an Online Learning Group (20 Minutes) 
If we don’t find what we seek we can make ourselves in online learning group or mailing 
list. To make it, follow the following steps: 
As we have conducted previously, Open the address: http://groups.yahoo.com. After 
the following display comes out, choose link Start Your Group. 

 

    Note for the Facilitator 
To register, first you must have Yahoo account. If you have, the next step is to 
enter the username and password., then follow the following steps. Let 
participants try themselves. If participants face problem, help them. The more the 
participant lear themselves, the better it will be.  
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   EExxtteennssiioonn  
The joint learning this time: the Mailing List is discussed. For further development, the 
following ideas are given:  

• Seek in the internet on a community which has the same hobby, which is the 
same as that of the participant (for instance: photography, cooking, drawing, et 
cetera), then join. 

• If the school has a website which is equipped with the capacity to carry out script 
(php or asp), make online community yourself.  

E 
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LLaanngguuaaggee  aanndd  
CCoommmmuunniiccaattiioonn  
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UUnniitt  TThhrreeee  
LLaanngguuaaggee  aanndd  CCoommmmuunniiccaattiioonn  

 
Participants: Teenagers who are interested in expressing their talents and interests in 
writing and communicating. Teenagers who are interested in making a work piece by 
using digital creativity. 
 
Unit three: Language and Communication introduce the participants on the concept 
of printing, the how to of managing a school news paper, printing of books, small books 
containing poetry and short stories, training them on how to write diaries, learning to 
communicate ideas through pictures/drawings and caricatures and getting knowledge on 
how to make posters, stickers and invitation cards. 
 
The main objective of this unit is to stimulate talents and interests of the participants in 
writing and expressing ideas and thoughts both in the forms of poetries, short stories, 
diaries and drawings. 
 
The are four activities in this Unit Three which will help the participants in expressing 
ideas opinions. 

• Writing and printing School New papers. 
• Composing and Publishing poetries and short story books.] 
• Caricatures on School activities, Social and local problems.  
• Digital Graphic 

 
All activities have been designed in giving direct experience to the participants. The 
abilities which will be sharpened are abilities which will directly be faced by them in 
school, work world, community and personal life. 
 
The assignment given and activities which are in this toolkit have been adapted to suit 
with the conductions in Indonesia; so the participants will be more familiar with the 
conditions and situations as they occur. 
 
All activities have been designed to give direct experiences for participants. Skills that will 
be sharpened are the skills they will need in school, workplace, society, and personal life. 
 
Assignments and activities provided in this toolkit are adjusted to conditions in 
Indonesia. As a result, participants will know more about situations and conditions in 
Indonesia. 
 
All activities provided in the ICT toolkit are interactive, of which all activities, step by 
step, will be done by participants such as discussion, brainstorming, presentation, 
computer practice, research work and data analysing. 
  
Assessment is a process from beginning to the end. All participants’ involvement in all 
activities must be recorded. 
 
Each activity will end by making a final project. This final project can be worked on 
during outside of the class hour.  



USAID DBE3 Life Skills for Youth 140

AAccttiivviittyy  11  
CCrreeaattiinngg  aanndd  PPuubblliisshhiinngg  SScchhooooll  NNeewwssppaappeerr  

IInnttrroodduuccttiioonn 
This activity will introduce the participants on what is meant by newspaper. After giving 
some understanding on newspaper, the participants work in making a school newspaper 
by using an application,. the participants work result will then be printed   through a 
printer to be then reproduced by using photocopy machine. 
 

OObbjjeeccttiivveess  aanndd  LLeeaarrnniinngg  OOuuttccoommeess    
The objective of this activity is to give understanding to the participants on what is mean 
by newspaper. Also explaining the participants on the how to of making a school 
newspaper. It is expected that after participating in this activity, the participants’ ability to 
writing article can be channeled through school newspaper; Also training the participants’ 
ability to be a reporter or journalist. 
By participating in this activity, the participants are expected to be able to: 

• Understand and explains about printing concept. 
• Form a group/club. 
• Organizing the contents. 
• Searching for news and composing an article. 
• Composing and integrating the contents and the supporting pictures. 
• Printing a school newspaper (finishing project of Activity I) 

 

      

AAggee  TTaarrggeett::    
This activity is intended for all grades (VII, VIII, IX) 
 
��� LLeevveel  ooff  DDiifffiicculttyy  
The level of difficulty of this activity is three stars. This means the difficulty level of this 
activity is above average. 
 

    LLiinnkkss  ttoo  tthhee  CCuurrrriiccuulluumm     
This activity can be used to intensify the Competence Standard (SK) and the Basic 
Competence (KD) of ICT subject.  Specifically, the SK, KD which are contained are: 
 
 
 
 
 
 
ICT COMPETENCE 
Grade VII ,  Semester 1 

IX VII
I

VII 
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Competence Standard Basic Competence 

6. Understanding the use of information and 
communications technology and future 
prospect. 

 

 

1.10 Identifying various equipment of information and 
communications technology 

 

1.11 Explaining the role of the information and 
communication technology in daily life 

1.12 Identifying various benefits and uses of the 
information and communication technology 

 
Life Skills 
Also related to the development of life skills, as follows: 

Analysis Skills Informaction 
Searching  

Information 
Processing 

Problem 
Solving 

Self 
Consciouness 

Vocational 

9 9 9 9 9 9 

 

   TTiimme::  
Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs. 
 

    RReeqquuiirreedd  MMaatteerriiaallss  
• Blackboard 
• Stationary 
• Photocopy of “8 Steps in Creating School Newspaper” sheet to be distributed to 

the participants. 

Infoorrmaattiioon  aand  CCoommmuunniiccaattionn  Teecchhnnoollooggyy 
 

• Computer Unit which has been installed with Serif PagePlus SE 1.0 application.  
 Note: 

See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (if permissible) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 

   AAsssseessssmmeenntt 
Evaluation on this activity will more be emphasized on the ability to work within a 
group. Aspects to be evaluated are among others: 

• Ability to organize 
• Work as a team 
• Searching for news 
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• Planning the layout and design of school newspaper 
• Etc. 

In order for the evaluation to be objectively carried out, distribute the evaluation matrix 
sheet to each of the participants, and let them evaluate the work result of other 
participants. 

    Step 1: Understanding and Explaining the Publishing 
Concept (5 Minutes) 
 

    Note for the Facilitator 
Before beginning this learning process, show the participants some newspaper 
and tabloids which are on circulation in the society. Stimulate the participants’ 
curiosity in making a school newspaper. 

 

    Note for the Facilitator 
Give the participants explanation about newspaper. It doesn’t have to be too 
long. This part may be categorized as introductory part. If there’s internet 
accessibility, ask the participants to open website 
http://id.wikipedia.org/wiki/koran. 

Koran 

From Wikipedia Indonesia, Independent Encyclopedia in Indonesia. 

Koran (newspaper) (from Dutch: Krant; from France: Courant) or newspaper is a 
light publishing and easily thrown away, usually printed on cheap priced paper 
that is called newspaper paper, that contains most recent news in various topics. 
The topics can be in politics, criminality, sports, editorial, and weather. 
Newspaper may also contain cartoon, cross puzzle and other entertainments. 

There are also newspapers which are developed in certain fields like news on 
certain Industry, certain sports fans, certain arts fans or certain activity 
participants. 

General newspaper type is usually published daily, except on certain holidays. 
Evening or afternoon newspapers are also common in certain countries. Aside 
from those, there are also weekly newspapers with lesser prints and lesser 
prestigious compared to daily newspapers and their contents are only more 
entertaining in nature. 

Most countries have at least one national newspaper that is published across all 
parts of the country. In Indonesia, the example is KOMPAS. 
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 Step 2: Forming a Group/Club (10 Minutes) 

    Note for the Facilitator 
On this second step, the participants are to be divided into several groups. Each 
participant will have a different role to play, but they however will be in a group. 
Each group will have at least roles as follows: 

- Editor in Chief 
Assignment: Managing all personnel under his supervision 

- Editor 
Assignment: doing editing in terms of grammar, contents, and overall layout 

- Journalist (minimum 2 persons) 
Assignment: searching for news and writing it to be an article or news in the 
newspaper. 

- Photographer 
Assignment: documenting all events that occur 

- Layout Designer 
Assignment: setting up the appearance and positions of contents within the 
school newspaper 

Make sure that every participant has clearly understood the role he has to play. 
Also tell the participants that the role of each should not be fixedly tied at his job 
description but should also be ready to assist his teammate on finishing his part.  
 

 Step 3: Organizing the Contents (20 minutes) 

    Note for the Facilitator 
After being divided in several groups, ask them now to join in the assigned group 
for each and also give instruction to the editor-in-chief to begin to chair the 
meeting of his group. Matter to discuss in the meeting at this time is to be in the 
edition and who is going to be responsible for the rubrics. 
For example, the following is rubrics found in Kompas newspaper; It is 
presented in the form of mind map. 
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Below is a Standard Rubrics for a School Newspaper: 

 

    Note for the Facilitator 
Do not show the participants the above examples. Let them make their own 
Rubric that they want. By doing so the participants’ creativity may be more 
touched. 
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 Step 4: Seeking for News and composing an article (45 
minutes) 

    Note for the Facilitator 
In this fourth step the participants will be assigned to search for news and writing 
that news into an article. The time allocated is one week. When that one week 
time is over, the article will be collected by an editor to be edited in terms of its 
grammar. There after, the article will be passed on to a layout designer to be later 
place on the school newspaper pages. 
The way how to make school newspaper will be discussed on the next step. 

 

 Step 5: Organizing the Composition and Integrating Contents 
with Supporting Pictures (45 Minutes) 

    Note for the Facilitator 
At this stage the role of layout designer is demonstrated, the participants 
however, must be able to do it. This is to prevent the newspaper from not being 
published because the layout designer is absent. 
Next we will discuss about an application that is called Serif Page plus SE 1.0. 
This application can be obtained free of charge from 
http://www.freeserifsoftware.com. One of the requirements that one can use 
this application is by getting oneself registered through internet. After the 
registration, this application can be of use. 
By this program application, it would be easier for the participants to make the 
school newspaper based on the already made design. The design, however, is 
meant to be for making brochure. All we need to do is to make a little adjustment 
on its layout that its appearance will look like the school newspaper that we 
intend to make. 
Follow the steps on the next page in order to make that school newspaper. 
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 Open the Serif PagePlus SE 1.0 application. 
(5 Minutes) 
Click the button START -> All Programs -> Serif Applications -> PagePlus 
SE 1.0 -> PagePlus SE 1.0. 
After the program is open, the following window will open: 

 
Choose Use downloaded designs. (If you has skilled, you can directly choose 
Create my own design). 
 

 Choose the design desired. (5 Minutes) 
After the step 1 is completed, a dialog box below will appear:   
   

 

1. 

2. 

Choose the Brochures 
design. Then choose 
Side Half Fold. Then 
press A4. Then choose 
Winebar. Then press the 
b tton Finish
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 Enter the school data. (5 Minutes) 
The next step is to enter the school data into the provided box.   
  

 
 

 Change the layout and design. (45 Minutes) 
Now it is the time to change the layout and design! ☺ it is very easy.. follow the 
following steps. 
Press tab written “Schemes” on the right side. 

 
The theme of school newspaper will change in accordance with the color we choose. 

3. 

4. 
Change the color of our 
school theme into 
another color. There are 
tens of option for color 
combination. As an 
example, choose HOT. 
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 Insert the images. (5 Minutes) 
School newspaper does not have any value, if it is not entered into the attractive 
drawings and articles. 
In the fifth step we will try to enter the drawing and enter the text into the 

school newspaper. 
As the first trial, we eliminate first the drawing which has existed and then enter the new 
drawing. 
To delete the drawing, the method is easy. Just click the drawing desired, then press the 
key delete on the keyboard. 

5. 
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Now we try to enter the new drawing. The method is also easy. Just press the menu 
Insert -> Picture -> From File, then choose the drawing we desire. 
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A small box will appear. Draw from the upper left corner to the lower right at the place 
we desire. Then, work out the size and position of the drawing.  

 
Treng.. teng.. teenng.. the drawing has entered into our design. ☺ 

 

 Inserting the text. (15 Minutes) 
Now we try to insert several words for the front page of school newspaper.  
To insert the text into our school newspaper, do the following step.  
Press the button to insert the text on the left side. Then, draw the box to the 

place we desire to inset the text. Then complete the text we have prepared previously.  

6. 
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The color of the text and the color of the backdrop can also be changed. 

Press Attributes tab. 
And then on the Color 
section, choose the most 
wanted color by clicking 
to your right on the 
color, then choose the 
color of the text, for the 
backdrop, or for the 
lines.
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 Complete all pages. (45 Minutes) 
After knowing how to insert picture, and then how to insert text, next step is to 
fill in all pages based on articles and pictures that we had already have. 
To shift from one page to another, press a row sign on the bottom left. There 

are words Front (front page), Inside (inside page), and then Back (back page).  

 
 

    Note for the Facilitator 
When the participant are doing his/her own assignment, show some tricks to 
some participants on how to beautify the pages. Show them in different interval. 
Let them explore this application independently. 

7. 
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 Printing School Newspaper (5 Minutes) 
Finally the times come to print school newspaper. The follows are steps to print 
school newspaper. But before printing school newspaper, don’t forget to save 
the file. 

To print, press the menu File -> Print. It is easy, isn’t it?!?! ☺ 

 

   EExxtteennssioonn  
Making school newspaper in this activity use a design which has been made available by 
this application. For further development, here are some recommendations: 

• Create a school newspaper from the beginning (not from a design which has 
been made available). The step on making newspaper can be seen in 
http://www.komputeraktif.com/langkah.asp?tahun=2004&edisi=90&file=langk
ah2 

• Create a school club newspaper, in which you are assigned to cover all activities 
taking place in our around the school. 

8. 

E 
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AAccttiivviittyy  22  
PPrreeppaarriinngg  aanndd  ppuubblliisshhiinngg  ppooeemm  iinn  EEnngglliisshh  

aanndd  SShhoorrtt  SSttoorryy  BBooookklleett 

IInnttroodduuccttiioonn 

“One may be as clever as the height of the sky, but as long as one does not write, one will be lost in the 
public and from the history….Writing is working for eternality” 

Pramoedya Ananta Toer in Summon from the life path. 
 
This activity will train the capacity of participant in writing poem and short story. In each 
step, tips and trick will be provided on how to write poem and short story. At the end of 
this session, the participant will learn how to make a booklet which contains poem and 
short story. 
 

  OObbjjeeccttiivvee  aanndd  rreessuullttss  eexxppeecctteedd  
The objective of this activity is to sharpen the capacity of the participant in writing, 
particularly writing poem and short story. In addition, the participant is also expected to 
be able to publish the result of their work by using the application of desktop publishing. 
By following this activity, the participant is expected to be able: 
• To understand and explain the concept of poem and short story. 
• To write diary. 
• To make poem in English. 
• To make short story in English. 
• To make booklets which contains poem and short story in English (Final Project of 

Activity 2) 
 
 

      

AAggee  TTaarrggeett::    
This activity is intended for all grades (VII, VIII, IX) 
 
��� LLeevveell  ooff  DDiiffffiiccuullttyy  
The level of difficulty of this activity is three stars. This means the difficulty level of this 
activity is above average. 
 

IX VII
I

VII 



USAID DBE3 Life Skills for Youth 155

    LLiinnkkss  ttoo  tthhee  CCuurrrriiccuulluumm     
This activity can be used to intensify the standard of competence (SK) and basic 
competence of subjects ICT and PKn (Citizenship Education). Specifically SK, KD 
which covers as follows: 
 
ICT COMPETENCE 
Grade VII ,  Semester 1 

Competence Standard Basic Competence 

7. Understanding the use of information and 
communications technology and future 
prospect. 

 

 

1.11 Identifying various equipment of information and 
communications technology 

1.13 Explaining the role of the information and 
communication technology in daily life 

1.14 Identifying various benefits and uses of the 
information and communication technology 

 
PKn COMPETENCE 
Grade IX, Semester 2 

Competence Standard Basic Competence 

4. Presenting the achievement of oneself in 
accordance with the capacity for the sake of 
nation’s superiority  

4.1 Explaiing the importance of achievement of oneself for 
the nation’s superiority 

4.2 Recognizing oneself’s potential for achievement in 
accordance with the capacity 

4.3 Presenting participation in various activities to realize 
the achievement of oneself in accordance with the 
capacity for the sake of nation’s superiority 

 
Life Skills 
Also related to the development of life skills, as follows: 

Analysis 
Capacity 

Information 
Searching 
Capacity 

Information 
Processing 
Capacity 

Problem 
Solving 

Self 
Consciousness 

Vocational 

9 9 9 9 9 9 

   TTiimme::  
Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs. 
 

    RReeqquuiirreedd  MMaatteerriiaallss  
• Blackboard  
• Stationery    
• Articles in techniques of writing short story and poem to be distributed to 

participant. 
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Infoorrmaattiioon  aand  CCoommmuunniiccaattionn  Teecchhnnoollooggyy 
 

• Computer Unit which has been installed with the Serif PagePlus SE 1.0 
application. 
Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (if permissible) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 

 

   AAsssseessssmmeenntt 
The evaluation in this activity is not to measure the skill to write poem and short story, 
but the capacity of participant in expressing the idea and thoughts into the forms of 
poem and short story. The effective aspect is very much observed here, because the skill 
to write poem and short story for some persons is not an easy matter. 
In addition, in making booklet it is also necessary to observe the expertise of each 
participant in following the procedure, layout capacity and creativity of the participant. 
 
In order to be objective during assessment, pass the assessment matrix sheet to each of 
the participants, and let each of them evaluate the result of another participant’s work. 
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 Step 1: Understand and explain the concept of poem and short 
story (15 minutes) 

    Note for the Facilitator 
Before starting the process of learning, read to participant a poem or short story 
which is inspiring, encouraging and making participants sink in to the world of 
words. 
Pay attention to the time, don’t be too long reading the poem or short story. 

 

    Note for the Facilitator 
If the internet access is provided, request participant to open the address of 
website, as follows http://id.wikipedia.org/wiki/puisi.  

Poem 

From Wikipedia Indonesia, free encyclopedia in Indonesian. 

Poem (from the ancient Greek: ποιέω/ποιῶ (poiéo/poió) = I create) is the 
written arts, in which the language used for the quality of aesthetics for addition 
or other than the guarantee meaning. The emphasis on aesthetic aspect of a 
language and the deliberate use of repetition, meter and rhyme differentiates 
poem from prose, but this difference is still debated. Several modern experts 
have the approach by defining the poem not as a type of literature, but as a 
realization of human imagination, which becomes the source of all creativity. 

Then, the following address: http://id.wikipedia.org/wiki/cerita pendek.  

Short story 

Short story or often abbreviated to Cerpen is a form of fictive narration prose. 
Short story tends to be solid and directly to the objective, compared with longer 
fiction work, such as novella (in the modern sense) and novel. Since it is short, 
the successful short stories rely on literature techniques, such as figure, plot, 
theme, language and insight in a written way compared with the fiction, which is 
longer. The story is bias in various types. 

Short story comes from anecdote, a situation, which is depicted briefly which 
promptly arrives on the destination. In parallel with the tradition of verbal telling, 
with the emergence of realistic novel, short story develops as a miniature, with 
examples in the stories by E.T.A. Hoffmann and Anton Chekov. 
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History 

Origins 

Short story comes from the tradition of telling verbally which produces famous 
stories, such as Iliad and Odyssey by Homer. The stories are conveyed in the 
form of poem, which has rhythm, with the rhythm functioning as the device to 
help person remember the story.  Short parts of these stories are centered on 
individual narration which can be presented on a short occasion.  The whole 
story can only be observed, if the whole part of the story has been presented. 

Fable, which is in general in the form of people’s story with messages on morality 
in it, it is considered by historian Herodatus, a Greek as a result of finding of 
Greek Slave named Aesop in the 6th Century BC. (although there are other stories 
which come from other nations, which are considered having come from Aesop).  
There ancient fables now are known as Fable Aesop. 

Another Ancient form of short story namely anecdote, popular in the period of 
Roman Empire. Anecdote functions as parable, a realistic short story, which 
covers a message or objective.  Many survived Roman anecdote are recently 
collected in Gesta Romanorum in the 13th and 14th centuries.  Anecdote 
continues to be popular in Europe until the 18th century, when the letters of 
Anecdote containing fiction by Sir Roger de Coverley are published. 

Genre 

In general, short story is a form of fiction and the fictions which are considerably 
published are such as : science fiction, horror, detective tale, etc.   At present 
short story also covers non fiction form, such as travel story, prose lirics and post 
modern variants, as well as non fiction, such as: new journalism. 
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Step 2:  Practicing to Write Diary (~15 minutes) 

    Note for the Facilitator 
Request participant to buy a book to write diary into the book.  There are many 
benefit writing diary as explained in the following block (taken from 
http://yoansoraya.wordpress.com/2006/10/06/manfaat-buku-harian/ ). 
Request one of the participants to read the following writing. 

Benefits of Diary 

It turns out that the diary functions as media to express feelings, write our 
problems.  For instance problem of love or hatred to anyone.  The diary is 
usually written before going to sleep, put under the pillow, the colour is funny. At 
present there are also many blog users, who utilize the blog as media of 
expressing feeling, some published or as draft only.  Until now I am still lazy to 
write the-so-called diary, not the melancholic type … so, I easily forget and 
unorganized. As a matter of fact, writing a diary is also useful in career, health 
and recently it is useful for state history. 

In the case of career (from: Sriwijaya Post) the culture of writing diary can held in 
the work achievement.  Each time after writing something into the diary, try to 
think what has just been written.  For instance, today I am warned by the boss, 
because I lose the Agreement Proposal.  So, promise not to make that mistake 
again.  Another example, whatever work which has just been done but not 
finished yet because it is deadlock or the solution has not been found out 
(hiks..hiks..my code, my KRK). Make reviews, whether it has been written once a 
month or once a week, so that the diary can become a tool for self management:  
The diary also help improve the self confidence.  For instance, you have just 
completed a prestigious project in the office.  Then, you write it down into the 
diary along with the happiness you brought.  This can be a special way to 
improve your self-confidence and to liften up  your spirit.  So, the diary helps in 
reflection and motivation in work.. 

In the area of health, it is inspired by the Japanese film: one litre of tears ..hiks 
sad, not having the nerve to see this film (patient of Spinocerebellar 
Degeneration) is recommended by the doctor to always write what happens to 
himself each day in the diary:  The notes are used by the doctor to analyze the 
progress of the diseases.  Maybe, for instance, someone who likes to write diary 
has the diseases the doctor is doubtful to determine the disease, the notes can be 
used as the material. There is another film which use diary.  Butterfly Effect (the 
handsome Ashton K).  This film indeed makes the viewers confused.  The doctor 
here asks Ashton  to write notes on what he has done.  The diary here is useful 
for him to move to past life so that the history continues to change. 
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Diary is useful for the nations’ history.  The Book of Pak Habibi can be used as 
an example.  The book entitled “Detik-detik Yang Menentukan” contains notes 
of Pak Habibi at the time of and after he holds the post as President.  But this 
book still creates controversy.  It is mentioned that the son in law will take coup.  
The party cannot accept it and then it will make rival book and supported by 
Deputy Chairman of MPR AM Fatwa (from: detik)  Wow, it’s a war of book.. To 
tell you the truth it doesn’t really matter, as long as it is honest.  So, we can 
actually know, what happens?  Pak Amien also wants take a book on the 
cancellation of the action of people power in May 20, 1998 in Monas.  In 
addition, his book tells about his dialog with Pak Yuzril at night when Pak Harto 
steps down and refuses to become capres (from: detik) 

Step 3:  Making a poem in English (30 Minutes) 

    Note for the Facilitator 
Many trainings and practices are needed as well as talent in order to be able to 
write a poem well.  Below is an article which encourages to write a poem (taken 
from: http://helvytr.multiply.com/journal/item/101).  

Inspiring Poem 

Is there anyone who has written a poem for you?  I try to remember, those who 
have written poem for me.  The first name which emerges is Abdurahman Faiz, 
my son.  At least he has written 2 dozens of poem directed to me.  I indeed 
remember what he writes, among others: mother, it is you who guide me to the way of 
butterfly… or mother, it is you who is the eternal poem, which is impossible for me to find out 
in book! And: mother I love you as I love the heaven! 

How happy and touched to read all those poems! I even inspired to be come a 
mother who is more ideal for Faiz since reading his poems (thank you, love..) 

I am not so proficient in poems compared to Faiz.  I myself seldom write poem 
for someone, except at the time of falling in love or broken heart several time in 
the past in the period of youth.  Then when Mas Tomi proposes to me, more 
than 10 years ago, I start to send poem I write specially for him.  But, since I 
often send poem, when I do not make poem for him, he will ask: “Why don’t 
you write any poems for me recently”. 

Apart from that matter, the poem that we wrote is an eternal gift, which is very 
special for someone we know, love or admire.  Believe me, when we write poem 
for someone, the receiver will be difficult to forget it.  The poem can be a kind of 
magnet which bond us to someone, even if we hate it.  The poem we wrote will 
never die, even when we die. 
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Finally, I want to tell you about a poem, which I receive from a person who I 
have not known at that time,  ten years ago: at the time of sending it, may be the 
poet, Aris Kurniawan who is a worker---probably did it for fun.  I don’t know.  But, 
he seems to write it specially for me.  And for me this poem is one of the ways to 
give me spirit and also encourages me to write with whatever style---since I have 
not had the book from 1995 to date.  

  
    Fragmentasi Buat Helvy Tiana Rosa 

      Kusulut matamu dengan lilin 

---Siti Aisyah berkelebat--- 

engkau memekik menahan angin 

yang terbanting 

engkau terpelanting 

tapi kulihat engkau senantiasa menari 

menganyam hari-hari dengan syair Illahi 

  

Lilin yang kusulut menyala di matamu 

---matamu dalam kelebat ibu--- 

kulihat tinta yang senantiasa kau tuang dalam badai 

menjelma bianglala di langit duka 

   So that’s it.  As I say, Aris writes this poem when I have not published a book.  
He knows that formerly I often writes something which is different, which makes 
me quite “knocked out” to face various challenges.  But he expects that I always 
struggle to pour the ink down”.  And thanks God until now I do not stop 
writing.  In the poem, he expects that my writing can “become rainbow in the sky 
of sorrow”.  Thanks God I also do not stop trying to shine things by rainbow, at 
least, the sky of sorrow surrounding me. 

Aris has given me inspiration ten years ago until now with the short poem.  That 
make me think again, why don’t we start to give inspiration to someone or many 
persons, with simple poem we make ourselves, although we are not the poet? 
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Step 4:  Making a short story in English (30 Minutes) 

    Note for the Facilitator 
The capacity to write needs to be continuously  trained.  It is necessary to have 
the learning forever: Below is the writing from a linguistics on the importance of 
training to write. (taken from http://zkarnain.tripod.com/LCHARLIE.HTM). 
Distribute this article sheet to participants.  Give them time to read.  After the 
activity of reading is finished, discuss what has been read, then make a short story 
in English (if it is still difficult, the participants can do the short story in Bahasa 
Indonesia). 
 
KOMPAS  
DIDAKTIKA - Monday, October 9, 2000  

Lesson on Writing 

By Lie Charlie  

MAYBE Arswendo Amowiloto jokes when he write the book “writing is easy”, 
because actually writing is not easy! Recently, the case on writing lesson has been 
discussed again.  It is mentioned that the lesson on writing will be included in the 
curriculum as a separate lesson, not as part of the Bahasa Indonesia lesson any 
longer. 

Is writing considered important until now? First, writing is the ability to tell 
something with good language.  The contents of the writing can be anything, 
both fact and lie, scientific or maybe fiction.  As other matters, the success or 
failure of ours in writing is very dependent on our will to train.  So in the lesson 
on writing, someone is guided to train to reverse his thoughts in connection with 
this experience of his five senses or also his observation on natural phenomenon, 
etc. 

Certainty there is no bad score for the lesson on writing as long as the evaluation 
on a result of writing is not based on the grammar only.  Remember, that we 
have tried to separate the lesson on writing from the lesson on language.  

*** 

In order not to be trapped to become the lesson or grammar, the lesson on 
writing must be focused on training for communications.  It is true, vice versa we 
certainly return to the discussion the language, because communications is passed 
on through a language too, isn’t it? Here it means that don’t make someone 
translated and does not want to train in writing, because the language of writing is 
continuously criticized.  Let someone compose with the unorganized language 
first, because in turn he will follow the lesson or grammar, until he improve the 
quality of his language. 
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Start the lesson in writing by writing a diary.  Why diary? Because diary helps 
myself who does not need to be evaluated by another person.  There is no one 
who cannot communicate with oneself, isn’t there? Sweet memory, criticism, 
secret, or whatsoever we write in the diary with the language we like and we need 
not read it again especially evaluated by another person! 

After getting bored with writing a diary, try to write letters, because monologue is 
monotonous.  In addition, frequently writing diary makes one crazy! We write or 
compose our letters, because we want our letters to be read by another person.  
In order to be able to be read and understood by another person, letters must 
certainly be wrote with plan, cleverly and with good language, try to write a letter 
to the most intimate friend first.  Choose to write to the friend who is not 
talkative and does not like to criticize or make a love letter.  Try to create 
dialogue. 

The last stage in the lesson on writing is making the writing which will be read by 
all persons and whosoever.  We have done with our monologue, diary and 
dialogue through letter.  Now we want to talk to the world.  Let us now make the 
most beautiful story in the most beautiful language. 

*** 

What can we do to create a conducive atmosphere for the success of the lesson 
on writing in school? The classical intric is by conducting competition on writing.  
Although it is ancient, the rewards with big prize can still attract attention.  

Teacher doesn’t feel being charged with the lesson on writing at all.  It is true that 
examining the writing, which is 100% subjective need more time and attention 
than examining reply sheet of objective examination, which only consists of 
letters (a, b and c).  Here is the usefulness who knows the reason for the 
existence of the lesson on writing and the difficulty to correct result of writing of 
pupils will strongly increase the teacher’s salary. Hopefully, the lesson on writing 
is indeed a blessing in disguise.  

The Indonesia people has a very long verbal culture, long before CH van 
Opphuijsen transcribe bahasa Melayu and Arab characters to aksara and ejaan 
Latin.  “pokrol bamboo” and story telling are reliable tellers, but they are not 
effective and insufficiently succeed in contributing to written culture, because 
they are illiterate.  Maybe this is one of the obstacles which slows down the value 
of the history of our writing.  But, let bygone be bygone, at present do we not 
have Goenawan Mohamad, Pramudya Ananta Toer, and Enny Arrow? 

A friend of the writer has been laughed noisily when he is caught that he is 
writing to his parent while telling about the fighting cocks he sees some days ago 
“Such a thing need not be written: ha, ha, ha” As a matter of fact, writing is not a 
matter of big theme or small theme, but or will and intention to start telling about 
everything, including about the fighting cocks or bomb blast!  

Lie Charlie, the writer is a bachelor in the Indonesian Grammar, graduated from 
the Padjadjaran University. 
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Step 5:  Making a booklet containing poem and short story in 
English (30 Minutes) 

    Note for the Facilitator 
In addition to making a booklet containing poem and short story, both in English 
and Indonesian, encourage the participant to send their result of work to mass 
media.  Below is the tips in sending articles to mass media. (taken from 
http://www.penulislepas.com/more.php?id=11 0 1 0 M).  

 
Effort of Success to Send Article to Mass Media  

Writer: jonru 

When reading an article in mass media, maybe you say in your heart: “Ah, this 
article is average.  I can also make such an article. Even better!”  
 
Then you may start to make an article which – in your opinion – is much better 
and has quality.  You send the script to a certain mass media.  Several days later, 
your script is returned by the editor with the reason “not reasonable yet for 
publication.” 
 
You become angry and disappointed “what is wrong with my script?” 
 
Difficult but easy 
Sending articles to mass media, turns out to be not that easy as imagined by many 
people.  I myself, for instance, must be disappointed first before my first script is 
published in mass media.  My tens of script are rejected by many medias with 
various reasons, both reasonable and unreasonable. 
 
It turns out that quality is not the only guarantee of an article to be published 
successfully in a media.  There are still many other factors. 
 
I will explain several factors, which you need to observe (other than the quality of 
article) which can help you “to work smoothly” to become a reliable writer. 
 
The Factor of Appearance 
Appearance indeed often deceives.  But in many cases, appearance very much 
helps the success of someone.  In sending article to mass media, you must 
“decorate” you article as beautiful as possible.  There are numerous articles sent 
to the Editor of a media, so that the appearance of your article, which is 
interesting, is expected to be able to attract their attention, and makes them want 
to read your article. 

 
Type your articles neatly without interrupting deletions.  Use HVS paper, of folio 
size, or quarto, 70 grams.  The article is typed evenly left-right.  (If this article you 
read is even on the right).  Make margin up and bottom, 3 cm each, the left 
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margin 2.5 cm, right margin 4 cm. The article is typed, with the distance of 2 
spaces. 
 
Help Editor’s Duty 
This means that you are asked to help the editor of a mass media type or edit the 
script. You are not their employee!  But you should present your script in such a 
way that it can help their duties which is piling up. 
 
First, bind your script with staples and don’t forget to mention the page number 
on the bottom of your script sheet.  If your script is not stapled, especially if 
there is no page number, you can imagine what will happen, if your script is 
scattered on the floor?  The editor is certainly confused, how to put it in 
sequence number. 
 
Second, attach the return stamp.  This is not intended to bribe the editor, but the 
stamp is used, if your script is returned.  Since the form of the stamp is very 
small, and to avoid the scattering, stick it to your script (with staple or others). 
 
Comply with the Regulation/Habit of the Media 
Usually each media has its own regulation on script criteria, which they can 
publish.  For instance, there is media, which makes the following regulation: “the 
script should typed on folio paper, 2 space, 5 – 8 sheets the length of the script.  
Accompany the summary of the article about 10 sentences”. 
Such a regulation, you must comply with.  And it is necessary to remember that 
each media has different regulation on this matter.. 
In addition, each media usually has typical character which differentiates from 
another media.  Femina magazine, for instance, has the market share of media 
women, media upward, while the competitor, Kartini magazine, the market share 
is larger, also covering woman of media class, and ordinary housewives.  So, if 
you send your articles to those medias, your article must be adjusted to the typical 
characters of their media 
The typical character also involves the style of the language.  Although they are 
reading materials for youth, the Aneka magazine and Cermerlang magazine have 
different styles of language indeed they use the typical language of youth.  But the 
language used by Aneka is more broken, while the Anita magazine tends to be 
more formal. 
Introduce Yourself 
If your article is frequently published in a media, the editor will certainly know 
the sender of the article being read very easily.  But if you send the article for the 
first time to the media, introduce yourself, is an effort “to seek attention” of the 
editor. 
Accompany your personal data in the script.  Tell there your experience in 
writing, and if any, what achievement you have achieved in this area.  
(Remember, mention only matters which relate to the world of writing.  It is not 
necessary to tell that you, for instance, have been the number I champion of 
Lomba Balap Karung at the sub-district level). 
 
That is all about writing. Have a try. 
 
Writer: Jonru  
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The theory and discussion on the procedure for writing have been explained.  Now, it is 
time to make the small one using an application called:  Serif PagePlus SE 1.0.  
 
 
See the tutorial on making of School Newspaper.  Adjust to your needs. 
 

   EExxtteennssiioonn  
Below are several recommendations for developing this activity: 

• Make a small group which has the same hobby, namely writing poem and short 
story, collect all writings of the students at the school.  Then, make a booklet 
containing all the writings.  If possible, come to a publisher requesting 
recommendations and inputs. 

• If the school has adequate funds, this booklet can be printed and distributed 
freely to students in another school. 

E 
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AAccttiivviittyy  33  
AA  CCaarriiccaattuurree  aabboouutt  sscchhooooll,,  ssoocciiaall  aaccttiivviittiieess  oorr  

llooccaall  iissssuueess  

IInnttroodduuccttiioonn 
This activity will involve discussions on what is meant by the concept of carricature and 
how to express a thought or idea into a picture. In this activity will be introduced a 
graphic making application. 
 

   OObbjjeeccttiivvess  aannd  LLeaarrnniinngg  OOuuttccoomeess    
The goal of this activity is to introduce to the participants the concept of carricature and  
how to express a thought or idea into a picture. Hopefully, after joining this activity the  
participants will be able to express what is in his mind through line sketches and color  
brushes.  By joining this activity, the participants are expected to be able: 
• To understand and explain the concept of carricature 
• To analyze and express a thought in a picture sketch 
• To use lines and fill-in in a picture 
• To relate an object and picture on a canvas 
• To create a carricature (Final Project in Activity 3) 
 

      

AAgge  Taargeett:    
This activity is intended for all grades (VII, VIII, IX) 
 
��� LLeevveell  ooff  DDiiffffiiccuullttyy  
The level of difficulty of this activity is three stars. This means the difficulty level of this 
activity is above average. 
 

    Liinnkks  too  tthe  Cuurrriicculuumm     
This activity can be used to intensify the Competence Standard (SK) and the Basic 
Competence (KD) of ICT, PKn and IPS subjects.  Specifically, the SK, KD which are 
contained are: 
 
ICT COMPETENCE 
Grade VII ,  Semester 1 

Competence Standard Basic Competence 

8. Understanding the use of information and 
communications technology and future 
prospect. 

 

 

1.12 Identifying various equipment of information and 
communications technology 

1.15 Explaining the role of the information and 
communication technology in daily life 

1.16 Identifying various benefits and uses of the 

IX VII
I

VII 
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information and communication technology 
 
PKn COMPETENCE 
Grade IX, Semester 2 

Competence Standard Basic Competence 

4. Presenting the achievement of oneself in 
accordance with the capacity for the sake of 
nation’s superiority  

4.1 Explaining the importance of achievement of oneself 
for the nation’s superiority 

4.2 Recognizing one self’s potential for achievement in 
accordance with the capacity 

4.3 Presenting participation in various activities to realize 
the achievement of oneself in accordance with the 
capacity for the sake of nation’s superiority 

 
Life Skills 
Also related to the development of life skills, as follows: 

Analysis Skill Information 
Searching Skill 

Information 
Processing Skill 

Problem 
Solving 

Self 
Consciousness 

Vocational 

9 9 9 9 9 9 

 

   TTiimmee::  
Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs. 
 

    RReeqquuiirreedd  MMaatteerriiaallss  
• Blackboard 
• Stationary 

IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  TTeecchhnnoollooggyy 
 

• Computer Unit which has been installed with graphics processor application 
(Corel Draw).  
Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (when available) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 

   AAsssseessssmmeenntt 
A carricature is an art work. Apparently it will be difficult to assess the ability of a person 
from the carricature he created. The talent factor in drawing also constitutes something 
which not all the participants have. All experts agree that hard work can substitute 
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for/increase the inherent talent. Therefore the assessment part of this activity is attitude 
rather than cognition. 
 
To make the assessment objective, provide a matrix of assessment sheet to each 
participant, and let each one of them assess the work of another participant. 
   

Step 1: Understanding and explaining the concept of carricature 
(10 minutes) 

    Note for the Facilitator 
Before starting the learning process, show the participants a number of 
carricatures from the newspapers. Discuss with the participants the uses and 
benefits of the carricatures. 

 

    Note for the Facilitator 
If internet access is available, ask the participant to open the following website 
address: http://en.wikipedia.org/wiki/Caricature. The following is an 
explanation of carricature. 

Carricature is a drawing that exaggerates or deviates the specific features of some 
person or some thing to simplify the identification of the visual specific 
characteristics of that someone. A carricature can derogate or be praiseful and 
also can be used as a political tool or just for entertainment. The carricature of a 
politician is most often used in an editorial cartton, while the cartoon of a movie 
star is usually found in entertainment magazines. 

The word “carricature” itself has the meaning of “picture with meaning content”. 
According to a carricature teacher, Sam Viviano, this term is only applicable for 
the drawing of a person in the real world, and not for a fictional character. 
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Step 2:  Analyzing and expressing thought in a drawing sketch 
(20 minutes) 

    Note for the Facilitator 
In this second step, show examples of carricature. Discuss with the participants 
just what specific characteristics do appear dominant. For exercise, take several 
photos of the participants and ask the other participants to comment on what 
specific characteristics can be emphasized and turned into a carricature. 

 
Below are given a number of examples. If internet access is available, as the participants 
to to seek examples of other carricatures.
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Step 3:  Creating a graphic object (45 Minutes) 

    Note for the Facilitator 
This time the participants will first be guided to create a graphic object. Let the 
participants trace the features provided in the graphic processing application by 
himself. The more the participants find their own methods, the further will they 
learn to use an application. 

 
BEGINNING TO DRAW 

Making a Line 

 In CorelDRAW we can create several different kinds of line, from a curve, 
straight line or lines of calligraphy. We can draw a line merely by dragging while pressing 
the left mouse. We can also make a straight line and a curve. We can see these in the 
figures below. 

 
 
 
 
 
 
 
 
 
 

A number of lines have dots that serve as the control points which can be 
manipulated into a the form we want.  

 

 

Straight Line 

Curve and 
straight lines 

Curve Line 

1 2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

Drag 
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We can also create a number of lines using the Bazier tool, by pressing the left 
button (click) at the end of each line. We can look at the examples above, where the 
drawings are made from several lines begun and ended with a black dot  1 Æ 2 Æ 3 Æ 4 
Æ 5 Æ 6 Æ 7 Æ 8 Æ 9 Æ10 Æ 11 and ended by double clicking at the first point, so 
that it becomes a non-stop drawing. 

Creating a Shape (House) 
 
Besides these lines, now we will try to create a finished shape by using tools from Lines 
and Shape, so as to appear as the example below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
We will try to create a drawing as in the picture by using tools from Lines and 

Shape available in the CorelDraw toolbox. 
The steps are as follows: 

1. make a Triangle for the front roof using Tool Line 
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2. After that, make a box using Tool Rectangle and place it below the triangle so as 

to appear like this  
 
 
 
 
 
 
 
 
 
 
3. Then we make the roof using Tool Line (Bezier) to appear like this: 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. After that, we make the sidewall again using Tool Rectangle. 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. To incline that wall, the Skew facility provided by CorelDraw can be used. 
6. The Skew is found on the menubar Arrange Æ Transformation Æ Skew 
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7. After that, the Docker Skew box will appear as below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8. Check the V (Vertical) Box as necessary. 
9. Click the option Use Anchor Point and select the box on the top left corner. 
10. Click Apply to see the change. (For this figure use V=33) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For this figure use V=33 
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11. Then you may draw the parts you want, so that the picture below is formed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
12. Then save your Work with the filename Rumah 

 
Drawing an Animal 
 

After we are able to draw a solid Shape as above, we now can try to create a 
shape with many curves. 

To that end we will demonstrate how to draw the head of an animal which has 
many curves in it. To create such as a shape we will need the previous tool we used, 
Bezier Tool. 

The drawing below is the example we will make, but we will only draw the 
Outline, while for coloring we will discuss it in a later chapter. 
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To make a drawing such as the above, there are several methods. We will draw 
the following picture using the Bezier tool which is a lines making tool. 

 
The following are the steps to follow: 

1. Draw a line following the curve on the top part of the head 
 
 
 
 
 

 
 
 

2. After that use the Shape tool to create curves more resembling the top part of the 
animal’s head, so that to appear like this: 

 
 
 
 
 
 
 
 
 
 
 
3.  After that we draw the lower part for the yellowish colored feathers, then 

combine them.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The parts are drawn separately, to enable us to give different colors to each of the 
parts. 
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4. Now we draw the left lower part for the neck, still using the same tool, the 

Bezier Tool. (Re-combine them.) 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

5. Now we move on to the right lower part, as in the following picture. 
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6. After that we draw a shape with the separate parts with different colors foe each 

part, so as to form the whole part of the animal’s head. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
7. Now we already have the outline form of the animal’s head, which we have 

drawn just using the Bezier tool. 
8. After all these have been completed, we save our work giving the file the name 

Binatang.cdr. 
 
 
 

   EExxtteennssioonn  
The ability to clearly see the characteristics of a person makes it not only easy to create 
the drawing, it also makes it easy for us to remember that person’s name. The following 
is a suggestion for the Extension: 

• As a task, ask the participants to draw the picture of his idol in carricature form. 
The participants’ works can be posted on the classroom walls. 

• Invite an expert cartoonist and discuss with him the tips and tricks of how to 
create a good carricature. 

• In every activity conducted by the school, draw a cartoon depicting a situation in 
the activity. 

E 
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AAccttiivviittyy  44  
DDiiggiittaall  GGrraapphhiiccss  

IInnttrroodduuccttiioonn 
This Activity will train the ability of the participants in utilizing technology to create a 
number of digital graphics works. Among these is the making of a poster, banner, and 
invitation card. At the end of the activity the participants will be challenged to carry out a 
final project in the form of a task to create a poster, banner, and invitation card based on 
a real event. (E.g. making an invitation card for his sister who is going to get married or 
create a poster urging the prevention of dengue fever for the local government, et 
cetera). 
 

   OObbjjeeccttiivvess  aannd  LLeaarrnniinngg  OOuuttccoomeess    
The goal of this activity is to instill a capability in creating a digital graphic work. It is  
hoped by possessing the capability learned in this activity, the participants will be able to  
give more contributions for people around him.  
By joining this activity, the participants are expected to be able to: 
• Understand and explain the graphic concept 
• Create a poster 
• Create a banner 
• Design an invitation card 
• Create a poster, banner or invitation card (Final Project of Activity Four) 
 

      

AAgge  Taargeett:    
This activity is intended for all grades (VII, VIII, IX) 
 
���  LLeevveell  ooff  DDiiffffiiccuullttyy  
The level of difficulty of this activity is three stars. This means the difficulty level of this 
activity is above average. 

 

    LLiinnkkss  ttoo  tthhee  CCuurrrriiccuulluumm     
This activity can be used to intensify the Competence Standard (SK) and the Basic 
Competence (KD) of ICT subject.  Specifically, the SK, KD which are contained are: 
ICT COMPETENCE 
 
 
 
 
 
 
 

IX VII
I

VII 
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Grade VII ,  Semester 1 

Competence Standard Basic Competence 

9. Understanding the use of information and 
communications technology and future 
prospect. 

 

 

1.13 Identifying various equipment of information and 
communications technology 

1.17 Explaining the role of the information and 
communication technology in daily life 

1.18 Identifying various benefits and uses of the 
information and communication technology 

 
Life Skills 
Also related to the development of life skills, as follows: 

Analysis 
Capacity 

Information 
Searching 
Capacity 

Information 
Processing 
Capacity 

Problem 
Solving 

Self 
Consciousness 

Vocational 

9 9 9 9 9 9 

 

   TTiimmee::  
Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs. 
 

    RReqquuiirreed  MMatteerriiaallss  
• Blackboard 
• Stationary 

IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  TTeecchhnnoollooggyy 
 

• Computer Unit which has been installed with graphics processor (Corel Draw) 
application. 
Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (if permissible) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 

 

   AAsssseessssmmeenntt 
The creation of an attractive digital graphic work calls for persistence and a long learning 
process. Apparently it will be difficult to assess the ability of a person from the digital 
graphic work that he has created. An understanding of visual communication design is 
also something not owned by all the participants. But all experts agree that hard work can 
replace/enhance any inherent talent. Therefore the assessment part of this activity is 
attitude rather than cognition. 
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To make the assessment more objective, provide a matrix sheet of assessment to each 
participant and let each of them assess the work of another participant. 

Step 1:  Creating a Poster (35 minutes) 

    Note for the Facilitator 
Before starting the learning process, show the participants examples of available 
graphic designs. Give as many examples as possible. This is to ignite the desire of 
the participants to learn and to show them that there is no limitation to the 
making of a graphical work besides our imagination. 
In this activity, the goal is to create digital graphics using the CorelDraw 12 
application, but any other graphics processing application can be used. The 
differences are just the placement of the menu. The main function is also not far 
different between one graphical processing application and another. 
. 

POSTER DESIGN 
 

A poster is made as a promotional need or the publication of a message (it could be a 
product, slogan, or activity), usually created in a big format (in minimum on an A3 size 
paper) because it is to be posted in public places easily visible to people. The content 
though not brief is practical, containing only the core information of the message we 
wish to convey. 

 
The design of a poster should appear “to sell” in the sense of being able to attract the 
attention of people seeing it. The design may be said to be a great success if it succeeds 
to make someone buy the offered product or sloganized idea only through seeing the 
poster we created. 

 
Designing a poster is actually not too difficult as long as we have an attractive major 
illustration. Up to 70% of the success of a poster design lies in the main illustration, 
while the other 30% lies in the way of arranging or layout elements. 

 
The logo or title of product or occasion is usually placed on the top part of the poster 
with the aim of making people see it clearly from a certain distance (eye catching). The 
logo size or that of the product title should be made big enough to make a “strong” 
impression. 

 
The text or message should be as brief as possible, not too long if not to say 
unnecessarily too protracted. The selection of font should prefer the simple and 
proportional (to the picture space). As a matter of principle, we must not cause the 
poster reader tired reading the text we write. Too much of text also will make the reader 
feel bored, while on the other hand a too haphazard arrangement also can cause a 
headache. 

 
When designing, divide the area of the poster into several sections, with each to have its 
own function. Arrange the available graphic elements in their orderly and proper places. 
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Keep in mind that every design we create always has the goal of communicating a 
message to other parties. It is our duty as a designer to have ability to convey the 
messages clearly (and interestingly) by way of an artwork—our work. But creating a 
design is not as difficult as suspected, as long as we know what kind of design we want to 
make and also what message we want to convey.  

 
Examples of space division and the graphic elements found in a poster: 
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Step 1 : Create a new document in CorelDRAW ( File>New or Ctrl + N ) 
 
 Use Rectangle Tool to create a rectable. 
 
Step 2: with the command Arrange > Transform > Size, with the size of 297 mm and 
height of 420 mm (A3) for the rectangle. 
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Step 3 : Using the Rectangle Tool (F6) make a rectangle box, then click the mouse right 
button and the command Connect to Curves to change the rectangle object into a curve 
which can be further edited.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Step 4 : Give color to the formed box with color by selecting fill on the lower left screen.  
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Step 4: Create a text balloon by first making a circle, then cut as necessary by using trim, 
and after that an addition of line as in the example.  

 
 

 

Step 5: Type the message to convey in the text balloon, select the font which is attractive 
but not complicated. Give color and form it as you like using effects > envelope (ctrl+F7)> 
apply 

Step 6: File > Import or click icon Import on the bar menu shortcut to load variation of the 
picture of the Mother who breatfeeds. The media, which we have made previously.  
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Step 7: File > Import or click on icon Import on the menu bar shortcut to load the 
variation of picture Cow. The media, which we have made previously.  
 

  
 
Step 8: Retype the text as in step 5 for additional message. As variation, we can duplicate 
(ctrl D) text, then the line is thickened (10 points)  in white and put it on the back (ctrl page 
down) original letter.  
 

 

 
Step 9: Save this document uses the command File > Save 
or Ctrl + S. Give the name, which is easy to remember, for instance: ASI POSTER.cdr 
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Step 2:  Creating a Banner (35 minutes) 
 
DESIGN OF A BANNER 

 
With the picture available in the poster we have made above, to prepare the banner with 
the same theme, will be easier. All we have to do is to import the existing picture to be 
laid out in the format of banner.  
 
The size of the banner usually follows where the banner will be installed. For indoor 
installation, it is usually between 5 – 7 meters, while outdoor is could be up to 10 meters.  
 
Like creating a poster, it is better that you divide a baner into several areas, with each 
function. Arrange the graphics elements which are available in the neat and orderly 
manner. 
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Step 1: Create a new document in CorelDRAW ( File>New or Ctrl + N ) 
 
Use Rectangle Tool to create a rectangle.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Step 2: With the command Arrange > Transform > Size, give the length of 5 meters and 
height 90 mm for the said rectangle. To make it easier, the actual size is not made, for 
instance, use the scale of 1 : 100. 
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Step 3: After that, color the rectangle by using uniform fill.        
 
 

Step 4: Then File > Import or click on icon Import on the menu bar shortcut to load the 
variation of the picture Mother who breastfeeds. Place it on the left side in accordance 
with the division of function element mentioned above. 
 
 

 
Step 5 : Then File > Import or click on the icon 
Import on menu bar shortcut to load the variation of 
main message text. Place it in the middle, in 
accordance with the division of function 
element mentioned above. 
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Step 6 : File > Import or click on icon Import on menu bar shortcut to load the variation of 
“callout” which contains additional message. Place it on the right side in accordance with 
the division of function element mentioned above. 
 
 
 
 
Step 7: Then File > Import or click on icon 
Import on the menu bar shortcut to load the 
variation of thepicture Cow. Place it at the 
place, which is in accordance with the 
division of function element mentioned 
above (additional illustration). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 8: Save this document uses the command File > Save or Ctrl + S. Give the name, 
which is easy to remember , for instance: ASI SPANDUK.cdr 
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Step 3:  Designing Invitation Card (35 Minutes) 
 
INVITATION DESIGN 

 
Invitation Design is a design which is sometimes easy to make and sometimes not, 
because it is a compliacted design. It means that in preparing it, we must be able to 
imagine, the invitation will be in what form exactly.  
 
Usually, invitation (particularly marriage) is prepared as beautiful as possible. Therefore, 
the graphic elements are very varied. Especially, if it is addedd with such things as ribbon, 
foil, embos, et cetera. 
 
In addition, invitation usually consists of complicated folds of paper. Therefore the 
position of drawing or text must be in conformity with the form of the folds. Otherwise, 
it will be upside down.  
 
  
 
  
 

 
 
 
 
But, in principle, it remains the same such as making poster or banner, divide the size of 
an invitation into several areas with each function. Arrange the graphic elements available 
in the neat and orderly positions.  
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Step 1: With the command Arrange > Transform > Size, give the size in accordance with 
the need.  
 

 
Step 2: Type the initials of the bridegroom and the bride by selecting the beautiful font 
and color. Then use the command Effects > Power Clip > Place inside Container to 
insert the initial into rectangle. 
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Step 3: Type the names of the 
bridegroom and the bride with the 
the font and color which are the 
same as the initial. Position them 
in a harmonious format, in 
accordance with the theme of the 
marriage. To make it more 
beautiful, add motive as “accent, 
by importing file motip1. 
 
 
 

 
With the motive, the names of 
the bridegroom and the bride 
will be seen more “beautiful”.  
 
 
 
 
 
 
Step 4: Place the two names on 
the previous initial with 
proportional position. For 
instance like the following 
example. 
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Step 5: Add the word invitation, Dear..... name and address box, sorry for the errors in 
the name and degree and place, date of reception. The layout is as the following example. 
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Step 6: If the front and central parts are completed, now we will make the lower part. 
Usually, it consists of verse or message for this beautiful moment. Sicne it will be place in 
front, the position of the letter must be upside down, for easy reading if folded. 

 
 

 
 
 
 
 
 
 
 
 
 

Step 7: To make it more beautiful, add the motive as “accent, by importing file motip1. 
 

 



USAID DBE3 Life Skills for Youth 197

Step 8: The last thing is we make the upper box. First we import file motif is placed on 
the left side of the upper box.  

 

 
 
 
 
 
 

Step 9: Then, by using the arange > transformation > apply to duplicate the motif is multiplied 
to fill the upper box. 
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Step 10: Save in the middle, the initial motive with the reverse position, because if folded 
it will be seen normal. Don’t forget to insert the parents of the bridegroom and the bride. 

 
Step 11: Save this document using the command File > Save or Ctrl + S. Give name, 
which is easy to remember, for instance: UNDANGAN.cdr 
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Step 4:  Creating a Digital Graphic Work (~45 Menit) 

    Note for the Facilitator 
In  this  final  step  the  participants   will  create a digital  graphic  work  by  
themselves.  If   feasible,  entrust  the  participants  with designing posters or 
banners presenting  the school activities or the  activities  of  the  neighbourhood  
community. 

 
FINAL PROJECT 

 
We  do  not  have  to master  all  the  instructions and tools  of  a certain  program to  be  
able  to  use  it  effectively.  Those who  are  called  experts  are those who can  use the 
available equipment (in a program)  at  a minimum to  produce    maximum quality work.  
 
The next  step to be taken is to develop the new methods  in  accordance  with the 
respective  working  styles based on  the  examples and  steps  described above. There  
are  several  prints  here  that  can  be  used  as  training  material to   sharpen  our  
ability.  To train  intensively  and  to  dare  experiment  are  our primary  assets to   
master graphic  programs and  designs.   Good luck. 
 
Banner 
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Poster      Invitation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Poster 
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Banner 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   EExxtteennssiioonn  
The following  is  a suggestion for  furthering  developments  of this  activity: 

• Form a graphic design club  with  duties  that  include  producing  banners, 
posters,  invitation  cards, etc  If   seriously pursued,  it may  become one  of  the 
school’s   units of  enterprise  by offering graphic  design  services. 

E 
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TToowwaarrddss  MMyy  DDrreeaamm  
CCaarreeeerr    
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UUnniitt  FFoouurr  
TToowwaarrddss  MMyy  DDrreeaamm  CCaarreeeerr  

 
Participants:  Young people  who  wish to  know  about  the  ins and outs  of  the 
working world,  the  required  capabilities,  information about vacancies and plans  for a 
future  career. 
 
Unit Four :  Towards My  Dream Career  gives  participants  the  capacity  to 
understand the  conditions  in  the working  world. Participants will practice  
brainstorming and surveys on  whatever  skills  is  needed   in  the  working  world,  seek 
information  about  vacancies in newspapers  and  the  internet, input  collected  data  in  
a  database,  and  do sorting and filtering to search for certain data in a local company. 
 
The primary  purpose of this  unit is  to provide  the  participants  with  an  
understanding of  the  working  world, and to give  early information  on  working  skills  
and  vacancies  at the job  market.  It  is  hoped that  the plans  the  participants  may  
have  for  their  future  are  based  on  the  information  they  have  obtained. 
 
Three  kinds of  activities  in Unit Four will  aid participants  in  seeking  information 
about  the  working  world. 

• Skills in Workplace 
• My  Dream Career 
• My local Enterprise 

 
All activities have been designed to give direct experiences for participants. Skills that will 
be sharpened are the skills they will need in school, workplace, society, and personal life. 
 
Assignments and activities provided in this toolkit are adjusted to conditions in 
Indonesia. As a result, participants will know more about situations and conditions in 
Indonesia. 
 
All activities provided in the ICT toolkit are interactive, of which all activities, step by 
step, will be done by participants such as discussion, brainstorming, presentation, 
computer practice, research work and data analysing. 
  
Assessment is a process from beginning to the end. All participants’ involvement in all 
activities must be recorded. 
 
Each activity will end by making a final project. This final project can be worked on 
during outside of the class hour.  
 
The  connection with  the  “Opportunities  for Life, Learning, and  Work”  
Toolkit 
For  better understanding  about  the   post-Junior High  School world, please see  the 
O4LLW  toolkit.  This toolkit  will  discuss ways  for preparing  oneself  to  face  the  
future, to  determine  one’s objectives, to  get  vocational  expertise, and more  
information about  the  working  world. 
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AAccttiivviittyy  11  
SSkkiillllss  iinn  WWoorrkkppllaaccee  

IInnttrroodduuccttiioonn 
According  to  statistical  data presented  by the Statistics  Central  Agency 2005, a  
fantastic increase  in unemployment  among young  people was  observed  in  February  
2005.  For the population above 15 years  of  age, the  total  number  recorded  was  
155,5 million.  Of these,  the  work force  amounted to 105,8   million.  Of  the  work  
force,  94,9  million  had  jobs, and  absolute employment was  10,9 million.  Besides  this  
absolute  unemployment,  there was  the  31,.2 million  in  the category  of under  
employment.   This  means  that  the  current  number  of unemployment  includes  42.1 
million people.  (Suara  Pembaruan, 12/02/06). 
 
The  cause  of unemployment is not  only the  lack of  job  opportunities,  but  also the 
great  deal  lacking  in  the  skills required in  the  working  world.  At almost  any  
enterprise,  whenever  new employees  recruited,  they  always  have  to  be trained  to  
introduce  them to  specific  skills required  in  the job.    The knowledge  obtained  at  
junior  high,  senior high school, and  even  from tertiary  educational  institutions  is  
often  of no  benefit to  the  working  world. 
 

   OObbjjeeccttiivveess  aanndd  LLeeaarrnniinngg  OOuuttccoommeess    
The  purpose of  this  activity  is  to introduce  participants  to   such  skills  as  required  
in  a  job.  Also,  to  train  their  analytic  capacity  in investigating  the  skills  required  in  
a job.  It  is  hoped  that  after  attending  these  activities,   the  participants  may better   
understand  the  complexities  of  the  working  world and  be  ready  to  face  all  kinds   
of challenges.  By attending these activities, the participants are expected to be able   to: 

• Practice  brainstorming on  skills  which  are  vital  in the workplace. 
• Obtain  data  on important skills  of local enterprises. 
• Enter these  data   in a  worksheet  application. 
• Draw up  a  presentation about  skills that  are important  in  the job. (Final 

Project of Activity 1) 
 

      

AAggee  TTaarrggeett::    
This activity is intended for all grades (VII, VIII, IX) 
 
��� LLeevveell  ooff  DDiiffffiiccuullttyy  
The level of difficulty of this activity is three stars. This means the difficulty level of this 
activity is above average. 
 
 
 

    LLiinnkkss  ttoo  tthhee  CCuurrrriiccuulluumm     

IX VII
I

VII 
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This activity can be used to intensify the Competence Standard (SK) and the Basic 
Competence (KD) of ICT and PKn subjects.  Specifically, the SK, KD which contained 
are: 
 
ICT COMPETENCE 
Grade VII ,  Semester 1 

Competence Standard Basic Competence 

10. Understanding the use of information and 
communications technology and future 
prospect. 

 

 

1.14 Identifying various equipment of information and 
communications technology 

1.19 Explaining the role of the information and 
communication technology in daily life 

1.20 Identifying various benefits and uses of the 
information and communication technology 

Grade VIII,  Semester  2 

Competence Standard Basic Competence 

4. Using numbers processor software to 
present information 

 Identifying the menu and icon the number processor 
software 

 Explaining the function of menu and icon in the 
number processor program 

 Using the menu and icon in the number processor of 
the software 

 Creating document on simple numbers processor 
 
PKn COMPETENCE 
Grade IX, Semester 2 

Competence Standard Basic Competence 

4. Presenting the achievement of oneself in 
accordance with the capacity for the sake of 
nation’s superiority 

4.1 Explaining the importance of achievement of oneself 
for the nation’s superiority 

4.2 Recognizing one self’s potential for achievement in 
accordance with the capacity 

4.3 Presenting participation in various activities to realize 
the achievement of oneself in accordance with the 
capacity for the sake of nation’s superiority  

 
Life Skills 
Also related to the development of life skills, as follows: 

Analysis 
Capacity 

Information 
Searching 
Capacity 

Information 
Processing 
Capacity 

Problem 
Solving 

Self 
Consciousness 

Vocational 

9 9 9 9 9 9 
 
 
 

   TTiimmee::  
Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs. 
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    MMaatteerriiaallss  RReeqquuiirreedd  
• Blackboard  
• Stationary  
• Photocopy of “Work Skill” questionaire sheet to be distributed to the employer 

and local company. 

IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  TTeecchhnnoollooggyy 
 

• Computer Unit which has been installed with worksheet application (Microsoft 
Excel 2003) 
Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (when available) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 

 

   AAsssseessssmmeenntt 
In  this  activity,  evaluation can  be  divided  into  several  stages.   At the  first  stage,  
during  brainstorming,  it  is the  participant’s activity, creativity and  desire  to contribute 
to the  group is the one to assessed. 
The  second  stage  is  at  the  time of  data  collecting.  The  aspects  assessed  are  the  
participant’s ability  to communicate  with other people,  ability to analyze, and  ability to 
seek  accurate  and  accountable  data. 
The third  stage is  when  entering  those  data into a data processor.  The  aspects  
assessed  are  the capability  to  enter data,  the  capability  to  process  data, and  the  
capability  to  present those  data in  a  chart. 
 
In order to be objective during evaluation, pass the evaluation matrix sheet to each of the 
participants, and let each of them evaluate the result of another participant’s work.
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Step 1:  Brainstorming Skills  at Work (15 minutes) 

    Note for the Facilitator 
Before  conducting  the  tutorial  process, show  the  participants  the  data  on 
the unemployment  in  Indonesia.   The  intention  is  to make  the  participants  
realize that  skills   at  work  are  crucial for securing  a job.  
Then, using the MindMap application, practice  brainstorming on  whatever  skill  
is  required  at  the  job  ( if  the  MindMap application   is  not  available,   it  can  
be  noted  down  on  a blackboard, using  several  kinds of color) 
 

    Note for the Facilitator 
When  brainstorming,  allow the  participants  to  express  whatever they wish. 
Note  down everything, there  are  no wrong  ideas. 
To make  it  easier  for  the  facilitator in  conveying  the material,   here  are  
some ideas  about  skills  at work. 
They  have  been  obtained  and translated  from 
http://www.conferenceboard.ca/education/learning-tools/employability-
skills.htm. 
Skills  at  work is divided  into  three parts, i.e.: 
1. Basic Skills 

The skills needed as a base for further development 
2. Personal Skills 

The personal skills, attitudes and behaviors that drive one’s potential for 
growth 

3. Cooperation Skills 
The skills and attributes needed to contribute productively 
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Employability Skills 2000+ 
The skills you need to enter, stay in, and progress in the world of work—whether you work on 
your own 
or as a part of a team. 
These skills can also be applied and used beyond the workplace in a range of daily activities. 

Fundamental Skills 

The skills needed as a base for 
further development 
 
You will be better prepared to 
progress in the world of work when 
you can: 

Personal Management Skills 

The personal skills, attitudes and 
behaviors that drive one’s potential 
for growth 
 
You will be able to offer yourself 
greater possibilities for achievement 
when you can: 

 

Teamwork Skills 

The skills and attributes needed to 
contribute productively 
 
You will be better prepared to add 
value to the outcomes of a task, 
project or team when you can: 

Communicate 

• read and understand nformation 
presented in a variety of forms (e.g., 
words, graphs, charts, diagrams) 

• write and speak so others pay 
attention and understand 

• listen and ask questions to 
understand and appreciate the points 
of view of others 

• share information using a range of 
information and communications 
technologies 

(e.g., voice, e-mail, computers) 

• use relevant scientific, technological 
and mathematical knowledge and 
skills to 

explain or clarify ideas 

Manage Information 

• locate, gather and organize 
information using appropriate 
technology and information systems 

• access, analyze and apply knowledge 
and skills from various disciplines 
(e.g., the 

arts, languages, science, technology, 
mathematics, social sciences, and the 

humanities) 

Use Numbers 

• decide what needs to be measured 
or calculated 

• observe and record data using 
appropriate methods, tools and 
technology 

• make estimates and verify 
calculations 

Think & Solve Problems 

• assess situations and identify 
problems 

Demonstrate Positive Attitudes 
& Behaviours 

• feel good about yourself and be 
confident 

• deal with people, problems and 

situations with honesty, integrity and 
personal ethics 

• recognize your own and other 
people’s good efforts 

• take care of your personal health 

• show interest, initiative and effort 

Be Responsible 

• set goals and priorities balancing 
work and personal life 

• plan and manage time, money and 
other resources to achieve goals 

• assess, weigh and manage risk 

• be accountable for your actions and 
the actions of your group 

• be socially responsible and 
contribute to your community 

Be Adaptable 

• work independently or as a part of a 
team 

• carry out multiple tasks or projects 

• be innovative and resourceful: 
identify and suggest alternative ways 
to achieve goals and get the job done 

• be open and respond constructively 
to change 

• learn from your mistakes and accept 

feedback 

• cope with uncertainty 

Learn Continuously 

• be willing to continuously learn 

and grow 

• assess personal strengths and areas 

Work with Others 

• understand and work within the 

dynamics of a group 

• ensure that a team’s purpose and 
objectives are clear 

• be flexible: respect, be open to and 
supportive of the thoughts, opinions 
and contributions of others in a group 

• recognize and respect people’s 
diversity, individual differences and 
perspectives 

• accept and provide feedback in a 
constructive and considerate manner 

• contribute to a team by sharing 

information and expertise 

• lead or support when appropriate, 
motivating a group for high 
performance 

• understand the role of conflict in a 
group to reach solutions 

• manage and resolve conflict when 
appropriate 

Participate in Projects & Tasks 

• plan, design or carry out a project or 
task from start to finish with well-
defined objectives and outcomes 

• develop a plan, seek feedback, test, 
revise and implement 

• work to agreed quality standards and 
specifications 

• select and use appropriate tools and 
technology for a task or project 

• adapt to changing requirements and 
information 

• continuously monitor the success of 
a project or task and identify ways to 
improve 
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• seek different points of view and 
evaluate them based on facts 

• recognize the human, interpersonal, 
technical, scientific and mathematical 
dimensions of a problem 

• identify the root cause of a problem 

• be creative and innovative in 
exploring possible solutions 

• readily use science, technology and 
mathematics as ways to think, gain 
and share knowledge, solve problems 
and make decisions 

• evaluate solutions to make 

recommendations or decisions 

• implement solutions 

• check to see if a solution works, and 
act on opportunities for improvement 
 

for development 

• set your own learning goals 

• identify and access learning sources 
and opportunities 

• plan for and achieve your learning 
goals 

Work Safely 

• be aware of personal and group 
health and safety practices and 
procedures, and act in accordance 
with these 

 

Step 2:  Obtaining data on important skills needed from local 
companies (~60 minutes) 

    Note for the Facilitator 
In this second step, give participant the sheet of work capacity questionnaire. If 
there are many participants, divide it into several groups. Each group will receive 
10-20 sheets of questionnaire.  
The sheet of questionnaire will be completed by the workers in the local 
company. The technique of collecting data can be in the form of interview or 
difficulty completed by respondent. 
Let participant seek respondent. It is necessary to observe that participant shall 
not complete the sheet of questionnaire by themselves. 
If possible, accompany the participant in data taking process. 
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  Handout for Participant 1.1 
Work Skills Questionaire 

 
WORK SKILLS QUESTIONAIRE 2000+ 
     
Please complete the questionaire as honestly as possible. Thank you for your participation in 
completing this questionaire. (Tick a check mark in the column you considered suitable) 

Respondent Data:     
Name:        
Name of Company/Institution:         

 

Work Skills 
Not 

Needed 
Needed 
Enough 

Needed 
Needed 

Very Much

Basic Skills         
Communication         
• reading and understanding the 
information presented in various form 
(for issuance, words, graph, chart, 
diagram, etc.)         
• writing and reading in order that 
another person observes and 
understands the intention which wants 
to be passed on.         
•  listening to and questioning to 
understood and respect the viewpoint 
of another person. 

        
• sharing information using various 
information technologies and 
communications/for instance: through 
voice , e-mail, computer, etc.) 

        
• using scientific explanation, 
technology and knowledge as well as 
mathematic skill to explain idea. 

        
          
Managing Information         
• seeking, collecting and managing 
information, using technology and 
information, which are appropriate. 
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Work Skills 
Not 

Needed 
Needed 
Enough 

Needed 
Needed 

Very Much

• obtaining, analyzing and applying the 
knowledge and capacity of various 
disciples of science (for instance: arts, 
language, science, technology, 
mathematics, social science and 
humanity).         
Using Number         
• determining what is necessary to 
count or measure.         
• observing and taking data, using 
method, equipment and appropriate 
technology. 

        
• making estimate and testing the truth 
of calculation.         
Problem Solving         
• evaluating the situation and 
identifying the problem.         
• seeking various view panels and 
conducting evaluation on the basis of 
facts. 

        
• identifying the dimension of problem 
from the human side, interpersonal, 
technical, and mathematics sides. 

        
• identifying the root of the problem.         
• create and innovative in seeking the 
possible solution.         
• always using science, technology, and 
mathematics as the way to think, obtain 
and share knowledge, solve problem 
and make decision.        
• evaluating the solution to make 
recommendation and determining the 
decision. 

        
• applying the solution.         
• ensuring tha a solution works well 
and acts when there is opportunity to 
increase the results         
     

Personal Skills         
Demonstrating Positive Attitude 
and Behavior         
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Work Skills 
Not 

Needed 
Needed 
Enough 

Needed 
Needed 

Very Much

• feeling comfortable oneself and self-
confidence.         
• dealing with person, problem and 
situation honestly, full of integrity and 
following personal ethics. 

        
• appreciating the personal efforts of 
and the efforts of another person.         
• maintaining personal health.         
• demonstrating interest, initiative and 
hard work.         
Being Responsible         
• determining the objectives and 
priority, which is in balance between 
the work and personal life. 

        
• planning and managing time, money 
and other resources to achieve the 
objective. 

        
• evaluating, weighing and managing 
risk.         
• being accountable for the action, both 
committed of individual group.         
• socially responsible and giving 
contribution to the public. 

        
Adapting         
• working independently or as part of 
the group.         
• performing various duties and 
projects.         
• motivate and rich in resources: 
identifying and providing 
recommendation on alternative 
methods to achieve the objective and 
complete the work. 

        
• transparent and able to accept change.         
• learning from error and accept 
criticism.         
• making adjustment to the uncertainty.         
Learning throughout the Period         
• always waiting to continuously learn 
and grow.         
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Work Skills 
Not 

Needed 
Needed 
Enough 

Needed 
Needed 

Very Much

• examining a personal strengths which 
can be developed.         
• determining oneself the objective of 
learning.         
• identifying and obtaining the 
opportunity as well as learning 
resources. 

        
• planning and achieving the objective 
of learning.         
Observing the safety and health         
• observing the personal health and 
group health as well as following the 
procedures for safety well         
          

Cooperation Skills 
        

Cooperation         
• understanding and working in a group 
dynamic.         
• ensuring that the purpose and 
objective of the group have been clear.         
• flexible:  respecting, being transparent 
and supporting the premise/opinion 
and contribution of another person in 
the group.         
• identifying and respecting the view of 
another person.         
• receiving and providing constructive 
criticism and demonstrating the attitude 
of empathy. 

        
• giving contribution for the group in 
various information and expertise.         
• leading or supporting at the 
appropriate time as well as motivating 
the group to obtain high performance. 

        
• understanding the role of conflict in a 
group to achieve a solution. 

        
• managing and settling the conflict.         
Participation in Project and Duty         
• planning and designing the project or 
duty from the beginning to the end 
with the objective and result, which 
have been previously determined.         
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Work Skills 
Not 

Needed 
Needed 
Enough 

Needed 
Needed 

Very Much

• developing, obtaining criticism, trying, 
reviving and applying a plan.         
• working in accordance with the 
standard which has been established.         
• selecting and using the appropriate 
technology for a duty or a project.         
• adapting if there is amendment to the 
provision and change in information.         
• continuously motivating the success 
of a project or a duty and identifying 
the methods for further improve the 
success.         
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Step 3:  To Input date into a worksheet application. (30 
Minutes) 

    Note for the Facilitator 
After the data received from survey result from some local companies, the next 
step is to input the data into a number process application. 
Give number for each replied colom. 
Not Needed   = 0 
Needed Enough  = 1 
Needed  = 2 
Needed Very Much = 3 
After finished inputting, give score to each. Make a chart that show scores from 
the biggest one and from the smallest one based on its category. 
Ask participants to present their finding result to other group. 

 
To input data, we can dot it by writting the socre directly or by playing with the provided 
formula in the number process application. 
Watch the following drawing: 

 
Steps to input data are as the followings: 

1. Input respondent data (Name dan Name of the Company) 
2. Give sign “Y” for the colom given by the respondence 
3. Use the following formula in SCORE coloumn (automatically number will be 

written: 
=IF(E11="Y",3,IF(C11="Y",1,IF(D11="Y",2,0))) 

=IF(E11="Y",3,IF(C11="Y",1,IF(D11="Y",2,0
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The purpose of the above function is to know which colom containing letter 
“Y”. Then it will be scored based on the value of each number. 

4. Use Average function (AVERAGE) to count each value of category and make its 
recapitulation in the next sheet. And make a chart that shows how important one 
sub-category is. The following is a drawing of recapitulation result.. 

 

    Note for the Facilitator 
To see the example that has been done, you can see it in the CD that is attached 
to this toolkit. 
Lesson to make a chart can be seen at Unit 2 about Accounting Using Worksheet 
Application 
 

   EExxtteennssiioonn  
Skills in the workplace is an attitude and character that must be maintained so that 
participants continuously improve their skills in the work place. The followings area 
suggestions that can be done after the activity is finished: 

• Ask participants to fill by themselves the questioner distributed before. But, this 
time, give number from 1 to 5 (where number 1 is the lowest and 5 is the 
highest) for each question. Write, according to them, what is their score for each 
question. Try so that they will continuously improve their score. If it is possible, 
meet once in a month to discuss the development of each participant’s skill. 

• In presentation process, invite one of workers working for a local company. Ask 
the guest to discuss with participants. It is expected that participants will get 
knowledge about work world. 

E 
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AAccttiivviittyy  22  
MMyy  DDrreeaamm  CCaarreeeerr  

IInnttrroodduuccttiioonn 
This activity will introduce the participants about the experience of job seekers. As usual, 
first thing that is done by a job seeker is to look at available job vacancies. This can be 
done by looking at job vacancies in printed or electronic media or even through an 
internet.  
After knowing job vacancy map in Indonesia, then participants decide one their 
dreaming career. In this activity, strategy in getting the job that they want will also be 
discussed, short term job as well long term job. 
 

   OObbjjeeccttiivvess  aannd  LLeaarrnniinngg  OOuuttccoomeess    
The objective of this activity is to give a view and direct experience from the job seekers. 
Beside that  participants from the beginning are guided to determine their goal and 
dreaming career. So, the participants’ life will be patterned and organized to reach their 
goal and dreaming career. It is expected that through this activity, participants will not be 
confused anymore to decide what job they will do in the future. 
By participating this activity, participants are expected to be able to: 

• Look for information on job vacancy available in the work market. 
• Determine and decide short term and long term goals. 
• Plan a strategy to reach career/work desired. 
• Prepare and present goal, strategy and dreaming career (Final Project of Activity 

2) 
 

      
  

AAgge  Taargeett  
This activity is intended for all grades (VII, VIII, IX) 
 
��� LLeevveell  ooff  DDiiffffiiccuullttyy  
The level of difficulty of this activity is three stars. This means the difficulty level of this 
activity is above average. 
 

    Liinnkks  too  tthe  Cuurrriicculuumm 
This activity can be used to intensify the standard of competence (SK) and basic 
competence of subjects ICT and PKn (Citizenship Education). Specifically SK, KD 
which covers as follows: 
 
 
 
 
 

IX VII
I

VII 
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ICT COMPETENCE 
Grade VII ,  Semester 1 

Competence Standard Basic Competence 

11. Understand the use of information and 
communications technology and future 
prospect. 

 

 

1.15 Identifying various equipment of information and 
communications technology 

1.21 Explaining the role of the information and 
communication technology in daily life 

1.22 Identifying various benefits and uses of the 
information and communication technology 

 
PKn COMPETENCE 
Grade IX, Semester 2 

Competence Standard Basic Competence 

4. Presents the achievement of oneself in 
accordance with the capacity for the sake of 
nation’s superiority  

4.1 Explaining the importance of achievement of oneself 
for the nation’s superiority 

4.2 Recognizing oneself’s potential for achievement in 
accordance with the capacity 

4.3 Presenting participation in various activities to realize 
the achievement of oneself in accordance with the 
capacity for the sake of nation’s superiority 

 
Life Skills 
Also related to the development of life skills, as follows: 

Analysis Skill Information 
Searching Skill 

Information 
Processing Skill 

Problem 
Solving 

Self 
Consciousness 

Vocational 

9 9 9 9 9 9 

 

   TTiimmee::  
Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs. 
 

    RReqquuiirreed  MMatteerriiaallss  
• Blackboard 
• Stationary 
• Photocopy of “Tips in Planning an Objective” sheet to be distributed to the 

participant. 

IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  TTeecchhnnoollooggyy 
• Computer Unit which has been installed with MindMapper Jr. application. 

Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (when available) 
Note: 
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If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present.

 

   Assssessssmmeent   
Assessment in this activity can be divided into some stages. First stage is when 
participants look for information about job vacancy, this can be assessed from the 
participant’s seriousness to get data on job vacancy, participant’s enthusiasm, their desire 
to share with other participants and his/her capability to look for list of job vacancy 
from the internet (if it is possible)  
 
Second stage is when participants determine their short term and long term goals. Here, 
aspect that is assessed is the analysis ability of the participants to measure the capability 
that he/she has for his/her short term and long term goals that he/she has formulated. 
What needs to be assessed is whether there is a relationship between the capabilities that 
he/she has now with his/her goals. 
 
Stage 3 is when he/she prepares goal or strategy to reach career/job desired. Aspect 
assessed is the capability of participants to describe to participants about steps that must 
be taken to reach goal/career/job desired. 
 
In order to be objective during evaluation, pass the evaluation matrix sheet to each of the 
participants, and let each of them evaluate the result of another participant’s work.  
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   Step 1:  To look for information on job vacancy available in 
work market (15 minutes) 
 

    Note for the Facilitator 
 

Before starting the learning process, present to the participants about data on job 
vacancy available in Indonesia. This will make the participants aware that in the 
workplace, there are many vacancies available. But, because there is no much 
information, we often don’t get the information on job vacancy. 
In step 1, some website addresses on job vacancies will be provided. 
If internet access is available, ask the participants to open the following website 
addresses: 
- www.karir.com 
- www.ekarir.com 
- www.jobsdb.com 
- www.lowongan-kerja.info 
- www.job-indo.com 
- www.bursa-kerja.ptkpt net 
- www.lowongan.net 
- http://lowongan.kafedago.com 
- http://infokerjas.blogspot.com/ 
There are more other websites. To look for more websites, look in 
www.google.com, then enter key word “job vacancy information”. There will be 
many links that has job vacancy information. Be careful in looking for a vacancy 
and apply a job through internet, because there are many frauds happened. Tell 
to participants a safe way to apply for a job through internet (Article is provided). 
If internet is not available, participants can visit school library and check local 
newspaper about job vacancies offered. Ask participants to record jobs that are 
mostly required, and requirements needed.  
Make a list containing 10 jobs that are mostly offered, and 3 jobs that are wanted 
by participants. Write down also requirements needed from each job. When they 
are finished doing that, go to Step 2. 
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This article is taken from http://lowongankerja.blogsome.com/2006/04/07/5-kiat-
aman-melamar-kerja-melalui-internet/  

5 Safe tips to apply a Job Through Internet  

To look for a job through an internet is not an unusual thing. There are even more 
websites and job vacancy information appeared. But, it is better to be careful to receive 
all the information there. 

Wireless information, that is internet. Its technology is not only to ease a task, but it is 
also to make to get a job easily. You don’t believe it? Try to "surf " in this abstract world, 
everything you need is available including job vacancies. Being helped by computer 
technology  that can do a copy paste of writings, internet also can expedite the process of 
sending job’s application. 

Beside that, internet is very effective to save time and cost, and it is practical when we 
send an application to a company that we apply. But, internet is also used to do crimes, 
especially stealing of information and frauds. 

You need to know that frauds and stealing through internet always increases every year. 
Identity stealing through internet has been increased up to 10 million cases per year, and 
most of them were done through fishing. So, it is not a surprising if labor industry, 
especially in USA, is now experiencing a big problem. So, if you want to look for a job 
through an internet, and you receive vacancy information form an company that you  
have never heard before, don’t believe it right away. 

So, a mistake can happen because you believe right away on what you receive. But, it is 
more wise if you recheck the information about the company through internet, 
telephone, or friends. By knowing on how a fraud syndicate (or other criminal actions) 
happens, at least, the step would help you avoid the covered fraud of job vacancy. How 
is it? 

1. Act skeptically on vacancy setup through your personal e-mail 
Scammers as well as spammers, generally has old pattern. They send e-mails to many 
people even though people that they send are not looking for a job. But, they 
don’t expect all of them will be tricked and do what they ask  for. E-mail ID that 
they use is also original so that scan that they are using looks convincing so that 
the prospect victims will not know that they are being  cheated.  

Watch out on vacancy’s e-mail saying "We have seen your resume through Internet and 
we feel that your capability is one that we need. Please complete other attachments we need 
below." 

Remember that you have to be skeptical by asking yourself, have I ever sent an 
application letter through an Internet? Check the website that they sent (if there 
is one), to make sure. So, do not respond the e-mail immediately. Try to check 
further if the company has a certain reputation. How did they obtain your data? 
If necessary, call the company to make sure. Maintain this critical and skeptical 
attitude, especially for the e-mail that does not give clear and complete address. 
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2. Avoid responding personal questions, like credit card or ATM 
Pretend that you receive a job vacancy e-mail from a famous bank. The  E-mail 
said they needed  your account by using an excuse that they need payment 
information to be updated in their database in order to improve their service. 
From the e-mail address, they look so convincing and they even provide their 
bank’s logo.  

When you respond to their request, you feel that it is alright, but actually you 
have been tricked. Big company seldom requests information through e-mail. So, 
continue look for the truth of e-mails that you receive. 

3. When you enter a job vacancy on-line  agent, use password that is hard to 
be interpreted 
Password, will make sure that your information and resume will be kept savely. It 
is better that your password is to be remembered but it is nos also easy to be 
interpreted by other people like birthday date or house number. This is to 
prevent those bad people  to get your important information easily. 

4. Read and understand site rules of your customers  
Agents that has run well usually has tight regulations for their on-line business. 
The regulations are usually written on the front page the company’s website or 
sometimes they are sent to your e-mail directly. This is not only to maintain the 
customers’ trust,   but also because the meaning of trust itself is important.  

Then, they will give information of how the customers will get the information fast and 
accurate, and how to use it well. Then, the group or website will give or sell clients’ 
information to companies that need it. The information given is very basic such as name, 
e-mail address, ID No., and telephone number. 

5. Report! 
If you receive one of these type of this cheating style, or perhaps you might have 
been a victim, do not hesitate to report to the Police. Almost 80% of frauds done 
through an internet are not reported. Either the victims did not know that they 
had been cheated or they were confused where to report.  

Actually, cheatings through an internet are often found, they can even be proved. 
Since the number of cyber crimes are increasing, actually police has formed a 
cyber crime division. So, don’t hesitate to report to police your lost because of 
the conducts of these scammers and spammers.  
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Step 2:  To decide and determine short term and long term 
goals (45 minutes) 

    Note for the Facilitator 
In this step 2, give first tips to determine the goal or to get the dreaming carrer to 
participants. 
If internet access is available, ask participants to open website address 
http://www.mail-archive.com/sarikata@yahoogroups.com/msg04001.html. If 
an internet access is not available, let participants give their ideas of how to 
determine goal. Or if there is a copy machine, distribute to participants sheet of 
“Tips to Plan a Goal.” 
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  Handout for Participant 1.2 
Tips on Planning an Objective 

Determining the objective as progress key in career or other personal life.  If you want to 
lose weight 10 Kgs or achieve the progress in the career world, determining the objective 
in life is an important matter to achieve the success. 
Having a specific objective in career can assist you in being more focused, which helps 
complete the work seriously, and calculating accurately what to do. 
On the other hand, insufficiently determining the objective, will become a serous 
problem in the long run and interrupts the future career prospect. The capacity may start 
to be stagnant or you may feel as if you would be achieve anything in the work. 
Several tips are provided below to determine the objective which assists you in achieving 
the success in the career and also in other aspects in life: 
Be sure that the objective can be achieved 
The effective and realistic objective is certainly easier to achieve, although a trick may be 
needed to make sure that the objective can be achieved. Be sure that you feel challenged, 
so that the objective you carry to the next level. If you determine a very high objective 
and expert to be perfect, you must also prepare yourself accept the future. 
Make the objective personal 
It is better that the objective belongs to you and not to another person, even when the 
objectives emerges in the career world. The indicator when thinking the objective should 
be “I want” not “I must” or “I need”. It is also important to throw out the feeling of 
pessimists or the negative feeling when starting to determine the objective. This means 
that don’t make the objective, which does not want to be done. 
Supervising the objective 
Make the composition of the objective to facilitate to run and do it seriously each day. 
The objective is also necessary to be supervised. You will not always be able to supervise 
what the superior or colleague thinks about you, but you can supervise how hard you 
work, and the attitude of you colleague for instance. 
Possessing a plan 
Possessing a specific plan on how to perform the objectives. It means that you are almost 
close to obtaining it write the objective and study each progress and note each 
implementation of the objective how small it is. You can immediately measure the 
progress. This facilitates you to determine the career objective which can help assist 
yourself or the on-going project. 
Determine the deadline 
Don’t forget to determine the deadline in each objective you implement. If you don’t 
make the deadline, you will never find yourself in the effort to achieve the objective. 
Without deadline an objective only becomes memory and you will and with the feeling of 
frustration. 



USAID DBE3 Life Skills for Youth 226

Step 3:  Preparing the strategy to achieve the career/work 
desired (30 Minutes) 

    Note for the Facilitator 
After removing the procedures for determining the objective, it is time now to 
determine what career work desired as well as how to achieve it.  
In this third step, you will also be introduced to the easy way to work out the 
plan or project by using computer application.  
Below is an article obtained from www.astaga.com. The participant must be 
emphasized that career/work desired must be in accordance with the interest and 
expertise. 

 
Choose the Work in Accordance with the Interest 
Seeking work in this global era is indeed not an easy task. But, it does not mean 
that the problem will settle, if you have obtain adequate work. The work may not 
b suitable, so that it makes you have stress for a long period. To obtain the 
desired work, it is better that you plan the work, career or even the dreamt ideal 
from the start.  

The first step is be sure what career you want. After you are sure, plan whatever 
is necessary to do to achieve the career.  

The following is the simple steps to develop the career plan:  

1. Plan the career based on the desire and expertise. Be sure that your interest and 
expertise will help paid the satisfactory work. In determining the career, think 
that you really like it. Also imagine, that you will enjoy the work. For that 
purpose, conduct evaluation on the types of career, which make you challenged, 
also select the career which is not desired. 
You can also probably learn from several previous experiences. For instance, 
previously you work in the administration department, but you feel that the work 
is not suitable at all. So, this time, you may not try the work again.  

2. Make list of expertise. For instance, you have expertise in several languages, 
computer, internet, etc. This expertise will help you perform the work, it turns 
out that one of the selected careers can’t suitable you to join, utilize another 
expertise to paid another expertise to paid another work, certainly, it is still in 
accordance with your interest. For that purpose, making a list of work is indeed 
very important before you decided to take the work.  

3. Determine several career options which are provided. This can be obtained 
through various medias, at this moment you can easily determine career option 
through interest network, in which there are many sites of career, which can help 
give information on the work. The best thing is keep seeking the career 
opportunity, which is really in accordance with the expertise, interest and maybe 
the experience you like. If needed, consult this matter with the experienced 
expert on career. This matter is important because the career you will perform 
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involves the realization of expectation. So far, performing the career, which is not 
desired will only makes you pressed and bored. On the other hand, if you 
perform the career, which is really suitable, you can enjoy it properly.  

4. After finding and selecting the career which is suitable for you, make 
preparation to face the career. If a special training is needed, such the most 
important training institute. For instance, if you want to improve the capacity of 
the English language, seek the best English course institution.  

After you finish planning the career, you can make sure fans of attention to 
achieve the career. But if you are ready, write an application to the company and 
the work you select. But before that, it is not a mistake if you discuss it with the 
person, who is most potential in his area. Ok, good luck with your career 
planning!. 

 
Make a strategy to achieve the work by using application MindMapper Jr. (for the way to 
use this application, see that unit two on mind map).  
Observe the example of career planning on the next page. 
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   EExxtteennssiioonn  
The capacity to seek information is one of the important capacity in this 21st century.  
The clever a person seeks information, the younger the person to obtain what that 
person wants, including seeking career/work desired. Below are several 
recommendations to be carried out after the completion of this activity: 

• Request a participant to present to another participant, objective as well as 
strategy which they prepare previously.  The more people know the objective and 
strategy to achieve the objective, the speedier that participant to realize it. 

• Guide the participant to prepare a curriculum vitae.  Then, make stimulation to 
apply for a job as well as stimulation interview. 

E 
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AAccttiivviittyy  33  
MMyy  LLooccaall  CCoommppaannyy  

IInnttrroodduuccttiioonn 
This  activity  will  be  dominated  by   collecting  and  entering  data  into  a  database. 
Data collected are of the enterprise, number of workers, gender of workers, and level of 
income kind.  The collected data will be reprocessed, sorted and filtered. The application 
used   is the grade processor application.  Database application which  uses the  database  
special  program will not  be  discussed  in  this  Third  Activity. 
 

OObbjjeeccttiivveess  aanndd  LLeaarrnniinngg  OOuuttccoommeess    
The purpose of  this  activity  is to give  the  participants an  understanding  about  
processing and  selecting  desired information.  Thus  it  is hoped  that  the  participants 
will have  the  ability  to seek the accurate  information out of   many. The  result of this  
database can  be added  continuously up to  regency  or  municipality  level, or  perhaps 
even  provincial  level.  So that the school may have a   complete database on local 
enterprise data. 
By participating in this activity, the participants  are  expected to  be  able to: 
• Data  the  respective  local enterprises based on  kind 
• Data the respective enterprise about  laborers (number of workers, gender,  level of  

income, etc.) 
• Making a query of a company based on type, total laborers, sex of the laborers, level 

of income, etc. 
• Create  a  database of local enterprises  (End  Project  of Third  Activity) 
 

      
  

AAggee  TTaarrggeett::    
This activity is intended for all grades (VII, VIII, IX) 
 
��� LLeevveel  ooff  DDiifffiicculttyy  
The level of difficulty of this activity is three stars. This means the difficulty level of this 
activity is above average. 
 

    LLiinnkkss  ttoo  tthhee  CCuurrrriiccuulluumm      
This activity can be used to intensify the Competence Standard (SK) and the Basic 
Competence (KD) of ICT, PKn and IPS subjects.  Specifically, the SK, KD which are 
contained are: 
 
 
 
 
 

IX VII
I

VII 



USAID DBE3 Life Skills for Youth 231

ICT COMPETENCE 
Grade VII ,  Semester 1 

Competence Standard Basic Competence 

12. Understanding the use of information and 
communications technology and future 
prospect. 

 

 

1.16 Identifying various equipment of information and 
communications technology 

1.23 Explaining the role of the information and 
communication technology in daily life 

1.24 Identifying various benefits and uses of the 
information and communication technology 

 

Grade VIII,  Semester  2 

Competence Standard Basic Competence 

5. Using numbers processor software to 
present information 

 Identifying the menu and icon the number processor 
software 

 Explaining the function of menu and icon in the 
number processor program 

 Using the menu and main icon in the number 
processor of the software 

 Creating document on simple numbers processor 
 
PKn COMPETENCE 
Grade IX, Semester 2 

Competence Standard Basic Competence 

4. Presenting the achievement of oneself in 
accordance with the capacity for the sake of 
nation’s superiority  

4.1 Explaining the importance of achievement of oneself 
for the nation’s superiority 

4.2 Recognizing one self’s potential for achievement in 
accordance with the capacity 

4.3 Presenting participation in various activities to realize 
the achievement of oneself in accordance with the 
capacity for the sake of nation’s superiority 

 
IPS COMPETENCE 
Kelas VII, Semester  2 

Competence Standard Basic Competence 

6.   Understanding community economy 
activity 

6.2 Describing the economic main activity covering the 
activities of consumption, production and distribution 
of goods/services. 

6.3 Describing the role of corporation, including 
cooperatives as the place where the production 
process is conducted in relation to the economic 
player 

6.4 Disclosing the creatif ideas in economic action to 
achieve the self-reliance and welfare  
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Grade VIII, Semester  1 

Competence Standard Basic Competence 

4. Understanding activity of economic player in 
the community 

4.1 Describing the relationship between scarcity of 
resources and the unlimited human needs  

4.2 Describing economic player: household, community, 
company, cooperation and the State 

4.3 Identifying the form of market in the community 
economic activity. 

 
Life Skills 
Also related to the development of life skills, as follows: 

Analysis 
Capacity 

Information 
Searching 
Capacity 

Information 
Processing 
Capacity 

Problem 
Solving 

Self 
Consciousness 

Vocational 

9 9 9 9 9 9 

 

   TTiimmee::  
Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs. 
 

    RReeqquuiirreedd  MMaatteerriiaallss  
• Blackboard 
• Stationary 
• Photocopy of “Data Required from the Company” sheet to be distributed to the 

participant. 
 

IInnffoorrmmaattiioonn  aanndd  CCoommmmuunniiccaattiioonn  TTeecchhnnoollooggyy 
 

• Computer Unit which has been installed with worksheet application  (Microsoft 
Excel 2003). 
Note: 
See the attachment for the instruction on the method of obtaining the above application and 
installation. 

• LCD Projector (if permissible) 
Note: 
If LCD Projector is not available, the ordinary computer monitor can be used. Make efforts in 
order that all participants can see what the facilitator wants to present. 
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   AAsssseessssmmeenntt 
The  assessment  in  this  activity  can  be  divided into  several  stages.  The  first  stage   
when seeking  information about  the  enterprise’s  data.   Participants can  be  assessed  
by  their seriousness  in  encoding    for  processing  the  data  of  the  respective  local 
enterprises, their  enthusiasm,  their  desire to  share  with the  other  participants. 
The  second stage  is  the  creation of  a  database.  The  assessed aspects  are  the  ability  
to  follow procedure, the  ability  to enter  data, and  the  ability  to encode  for  
processing,   and   to filter  or sort  data. 
 
In order to be objective during evaluation, pass the evaluation matrix sheet to each of the 
participants, and let each of them evaluate the result of another participant’s work. 
 

Step 1:  Encoding  for  processing   the  data of the  respective  
local enterprises (~45 minutes) 

    Note for the Facilitator 
This time, instructions  will be implemented outside  the  classroom.  Before 
going to some  local enterprise  for  data  collection,  have  the  school  send  
notification about  the  activity.  
This  activity  can  take place  at  the  same time  as  the  study  tour  organized  
by  the  school.  However,  the   data  entering  activity  will be done  in the  
classroom. 
Explain to the participants that  the  current  activity  is  to  encode  for  
processing  the  data  of  local  enterprises.  Thee  data  the  participants must  
collect  are  as shown  on the  Mind Map. 
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The following is format of the questionaire distributed to the participants. 

* Choose one of the followings: 

• Individual 
• Partnership:  

o Firm 

o Limited Partnership (CV) 
• Cooperatives 
• Limited Liability Company (PT)  

o Closed PT  

o Go Public PT  

o Domestic Capital Investment PT (PMDN) 

o Foreign Capital Investment PT (PMA) 

o PT Persero 
 

    Note for the Facilitator 
The   task should  be  given  to  the participants  one week prior to the 
implementation of  the  activity.  Each practicipant must  encode  for processing  
at  least 5 local  enterprises.  Participants  are not  allowed to  encode for 
processing the same  enterprise as  the others.  Make  sure that  each  participant  
encodes  for processing   enterprises  not encode by  the other  participants.  
Encoding  for processing may be  done  per group,  where each  group  encode 
for  processing  20 different  enterprises. 
When  coming  face-to-face, the  participant  will enter  the data straightaway  
into the  grade  processing  application that functions as a simple  database 
 

COMPANY PROFILE EMPLOYEES DATA 

Sex 

No. 

Company’s 
Name 

Name 
of 
Founder

Year of 
Incor-
poration 

Type of 
Company* 

Products 
Sold/ 
Services 
Provided 

Total  

M F 

Academic 
Qualification 

Average 
Income Rate 
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Step 3:  To  introduce a   query  based  on  the kind of 
enterprise, the  number  of  workers, gender  of workers,  level of 
income,etc. (30 Minutes) 

    Note for the Facilitator 
After  the  enterprise's  data  have  been  collected,  the  next  step  is to  enter  
the  data  into  the  database to  be  created.  Follow these  steps. 
 

 Create  columns and  rows that conform 
with the  questionaire. (5 Minutes) 
First,  open  the  Microsoft Excel grade  processor  application   (the tutorial on  

the use of excel is in Unit  Two- Accounting Using Grade Processor). Then  create  
columns  and  rows  as shown below. 

 
 

 Fill  the  Rows  with  the   Previously  
Collected  Data. (20 Minutes) 
Input the collected  data into  the  grade processor  application. 

1. 

2. 
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 Create  an  autofilter to  facilitate data  
selection. (10 Minutes) 
After  the  data  have  been  entered, grouping  the enterprises according  to  our  

criteria would  be  difficult..  For  this  we will use the  autofilter  available  in  Excel. 
Before doing  the  filtering, we  should first  select  the  column  we  want as the  filtering  
criteria. 

 
After chosen, press menu Data -> Filter -> AutoFilter. 

3. 
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After that row sign on each column as seen in display as follows: 

 
 
 

 Do the filtering  based  on the  criteria. (10 
Minutes) 
We  will do  the  filtering  based  on the  existing  data (only showing  the  data  

we  want).  It is  easy.   For  example, we  wish  to know which  enterprise  is included  in 
“Private” enterprise.  We push   the  arrow sign  on  “Kind  of  Enterprise”,  then  select 

4. 
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“Private”. 

 
 
The  result of filtering is  shown on this print.  It  shows  two  enterprises   of  the 
Private kind  of enterprise. 

 

    Note for the Facilitator 
Do   the  filtering  several times so that the  participants  can do  the  filtering  
easily.  Find  out whether the  workers  have  elementary,  junior or senior high  
school  backgrounds.  
To  return to the initial  appearance  (prior  to  filtering), push  again  the arrow  
in  the  “Kind  of  Enterprise”  column,  then push  “ALL” 
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Second  example: 
Find an enterprise with more than 50 female employees. 
 
This time  we will  use  the  order  (Custom…).  In  column “P", select (Custom….) 

 
 
The  following  dialogue  box will then appear. 
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The  result of filtering  is  as follows: 

 
As  shown on  the  print,  the  data  that will appear is an  enterprise with more than  50 
female employees. 

    Note for the Facilitator 
Provide   several  criteria  to stimulate  the  participants’ inquisitiveness.   We  
wish  for  instance  to  know which enterprises that  were  established after 1990 
are  of  the private  kind and  have  employees  with  an  average  income level of 
minimal 450.000. To livened things  up,   give  prices  to the participant  who 
managed to do it quickly. 

Push the  arrow and  then select  
“is  greater  than or equal to”.  Fill  
in the  figure  50  in the  criteria  
column, then push   OK. 
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   EExxtteennssiioonn  
The  ability to  conduct   data  sorting  and filtering is  an important  skill  where among  
that  many  available  data  we only  want to see   the  one  data  that  is  based  on  the  
criteria  we provided. 
For  furthering  this  activity, the  following  suggestions apply: 

• Fill the  database   till  all  local  enterprises  are  recorded.  Add a new filling 
column if  necessary.  The more complete and the more detailed a database, the  
more  useful it will be. 

• Continue training the participants’ capability  in sorting  and  filtering.  The more  
often  they are done, the  more  habitual and  easy  they will be. 

E 
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AAppppeennddiicceess  
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EExxppaannddiinngg  lleeaarrnniinngg  ooppppoorrttuunniittiieess  ffoorr  yyoouutthh      
We all know that learning takes inside the school or non formal education building and 
day.    Junior high schools and non formal education providers are established as learning 
centers for youth.  Their purpose is to ensure that young people in Indonesia meet a 
minimum academic standard, develop a sense of civic duty and acquire the capacity for a 
productive life full of learning.     
 
However, do you know that learning also takes place outside the school or non formal 
education building and day? Learning starts young, learning happens at home, in the 
neighborhood and in the community.    
 
 
 What is one of the first things that you learned?  
 Where did you learn it and from whom? 
 
Strengthening the connections between all the places that young people learn will enrich 
all learning experiences of young people and help to ensure that they are fully prepared 
and fully engaged for a productive life. 
 
Schools and non formal education providers should look outside of their building and 
beyond the set day to think about how they can connect with the other people and places 
where young people learn can.  There are two main possibilities.    
 
• Taking young people out of the building and into their community to create 

additional opportunities for learning  
 

• Bringing additional expertise and services into the building and into the day 
to offer additional opportunities for learning 

 
 
The following will provide some simple examples of how this can be done to support 
young people to apply and extend their skills developed as Peer Mediators.   
 
 
 
 
 
 
 
 
  
  
TTaakkiinngg  yyoouunngg  ppeeooppllee  oouutt  ttoo  ccrreeaattee  aaddddiittiioonnaall  
ooppppoorrttuunniittiieess  ffoorr  lleeaarrnniinngg  
The community can be used as context for young people to learn.  Young people can be 
taken out into the community to experience learning which cannot take place inside a 

TThhiinnkk    
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school or to apply what they have learned in school.  A useful activity for young people 
to engage in with the community is service learning: 
  

What is service learning? 
Service learning is a teaching method which involves young people going out into the 
community (this can be the wider community or the school community) to provide a 
service whilst at the same time improving and applying what they have learned in their 
studies.   
Therefore, service learning combines a service and an intentional learning experience. 
 

Can you give some examples? 

• The local playing field may be full of rubbish, young science students can collect it 
and start a petition for community members to recycle waste and educate the 
community on environmental health issues. 

• Knowledge of the local history and culture may be diminishing.  Using research 
techniques taught in History students can work with community members to write 
local stories and memories of past events  

• There is always a traffic jam in the community.  Mathematics students survey the 
roads and do some calculations to find out why, design a new traffic route and report 
to the relevant local government agency. 

 

What are the advantages of service learning?  

• Service learning can help make the teaching that takes place in a school or non 
formal education provider relevant to real like.   

• Service learning is beneficial to both the young person and the community and can 
be used in any subject and works at most age levels and especially the age level of 
Junior high school in Indonesia 

• Young people can develop apply key life skills through the process of preparing, 
planning and reflecting on service learning, such as  Sense of responsibility and 
commitment  

- Collective responsibility  
- Cooperation and collaboration  
- Problem analysis and problem solving  
- Decision making  
- Planning  
- Critical thinking  
- Active listening  
- Questioning  

 
How do we organize service learning? 
There are three important parts of Service Learning: 
• Preparation 
• Planning  
• Reflection  
Here are some ideas on how to do each part  
 

Preparation  
• Hold a brainstorming session with your group to identify needs within the 

community or opportunities to do something beneficial which relate to the subject 



USAID DBE3 Life Skills for Youth 246

you are teaching or to the extracurricular activity.  Challenge the students to think of 
as many ideas as possible and to be creative  

• Ask what the solutions are to the needs of the community, they need to think about 
what can realistically be done.   Ask the students to say what they do and do not like 
about each proposed idea and solution.    

• Ask the group to conduct some research before making a final decision.  They need 
to identify resources available and those needed to support the project.  They may 
need to raise funds from a business or organization in the community, parents or 
peers in school.  They may need to invite an individual with expertise in the area of 
interest in order to provide relevant information before a final decision is made.  

Planning 
The group should organize the project themselves.  They need to think about what needs 
to be done, who will do it, how it will be done and when. 
• Brainstorm a list of tasks and determine their most logical sequence. 
• Then define the roles of each student and group of students. Allow the students to 

share the leadership of the project.  
• Decide how the work will be distributed fairly and appropriately among the students, 

as well as what outside resources will be needed. 
• Develop a work plan or timeline.  The timeline should show when the class expects 

to finish each step, as well as when they will accomplish the major goals.  
• Discuss and agree on how the students will support and coordinate with each other’s 

efforts to attain the common goals of the project (e.g. who will depend on whom to 
carry out the work?). 

Reflection 
• Much of what we learn in life comes from reflecting on our experiences. After the 

service learning is project is completed, provide structured time for students to think, 
talk, and write about what they did and observed during the service activity.  

• Ask them the following questions: 
- What did we do? 
- What have we accomplished? 
- What have we learned?   
- What different did/does it make?  
- Why should we do it?  
- How is it important?  
- How do you feel about it?  
- What do we do next?  

 
A project planning sheet can be seen below.  Either the facilitator or the young people 
engaged in the service can complete the planning form.  
 

Service Learning Project Planning Form 
Youth group Class/Extracurricular activity/NFEP/Youth organization  

Project Name  

Project Describe the project – including the process used the decide the project  

Academic component What subject/competencies will be developed  
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Life Skills  

Service How will the community benefit  

Community 
Involvement  

How will members of the community be involved? How will youth 
interact with the community? 

Reflection  How will reflection be carried out and what questions will be asked? 
 
 What are some important points to note about service learning? 

• Service learning must link the academic content with the service.  If young people 
only clean up the playing field they are only providing a service and not learning.   

• The service which is provided should be something the community needs.  Young 
people should be asked to think about and engage with the community on those 
needs. 

• Young people should also have a voice in deciding the service learning project.  The 
young people need to be fully engaged and take leadership in planning the service 
learning activity  

• Young people need to interact with the community in completing the service learning 
activity.  They can create partnerships with members of the community to complete 
the service. 

• Service learning should not be used as a punishment, for example asking a student to 
clean the school yard because they have not completed their English homework. 

 

Where can I get more information about service learning? 
For more information on service learning you can visit the following websites  
• http://www.goodcharacter.com  
• http://whatkidscando.org 
• http://servicelearning.org 
• http://www.teachers.net  
 

  
  
  
  
  
SSeerrvviiccee  lleeaarrnniinngg  ffoorr  IICCTT      
    

The aim of the ICT toolkit is to provide young people with the opportunity to develop 
and practice ICT related skills and to see how ICT can be used to support learning of all 
academic subjects. 
 
Any service learning activity which gives provides young people the opportunity to 
develop and practice different ICT skills and offer a service to the community at the 
same time would be appropriate.   
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Here are three simple examples of a service learning project which can promote the skills 
of peer mediation and combine a community service.    
 

• Young people can become ICT Tutors.  They can persuade the head teacher of 
their school/NFEP, the local SMK or even the owner of the local ‘warnet” to allow 
them to use the computer equipment at least once a week to tutor young children in 
elementary school to operate a computer. 

 

• Young people can create a Community Guidebook:  Young people can become 
community explorers and observe and document many places in their community.  
They can then bring this together in a community map which might include 
photographs, maps, poems, descriptions and even video footage.  All made using 
different forms of ICT.   

 

• Young people can create a Community Story Book for young children in 
elementary school.  Young people can go out into their community and collect local 
stories from members of the older generation which tell a story about local places 
(e.g. how a place got the name) or people (e.g. local heroes and heroines) or the 
tradition behind local events.  These can be collected using audio cassette recorders 
and illustrated with photographs of the place or person.  The stories can then be 
typed up and made into a book and presented to the local elementary school.   
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Setting up an ICT Club 
 

Being an active member of an ICT Club is an excellent way to improve your ICT skills.    
You will be learning ICT in a fun environment where the activities are chosen by you.  
You do not have to be confined within the four walls of a classroom to learn ICT.  Read 
on to see how you can set up your ICT Club and what activities you get can involved in. 
• Get together a group of 15-20 people.  These people should be keen, motivated, 

enterprising and willing to bear their share of responsibility.  Most important of all, 
they must be genuinely interested to learn and practice ICT.   

• Organize a regular meeting place.  You may ask permission to use a classroom after 
school.  One of the local businesses might let you use a room on their premises.  
Your local hotel may allow you use of its facilities once a week. 

• Set a regular time for your weekly meeting two hours give you plenty of time 
• Set up the date for your first meeting 
• Give a copy of the Agenda to all members or write this on a board 

- Purpose of meeting 
- Election of committee members 
- Duties of each member 
- Decide on a name for the club 
- List of possible activities 

• Explain the purpose of your ICT Club provide a fun way to learn and develop ICT 
skills  

• Election of the following committee members: 
- Chairperson 
- Secretary 
- Treasurer 
- Activities coordinator 
- Fine collector 
- News writer  

• If you need other members for other jobs, you can elect a person to that position at a 
later stage. 

• Discuss the duties of committee members write them down and place them in a 
folder. 

• Establish rules for the club.  One major rule should be:   Any one who breaks a rule 
can be fined.  The money collected from breaking this rule can be used by the club 
for some activity. 

• Another rule is that all club activities be documented.  This could be the 
newswriter’s job.  Different people could take turns at this job. 

• Compile a list of possible activities.  You may choose some of the following, or you 
may create your own list: 

- Invite ICT speaking guest speakers from the community 
- Have an ICT games day – monopoly, scrabble, card games 
- Prepare a Graphic Design Club advertisement to be distributed to the 

community. The main purpose of the Graphic Design club is to create 
posters, banners, invitation card, etc. 

- Present a proposal on creating a website to local companies. 
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- Publish a school or community newspaper and distribute them freely for 
the community. 

• Once you’ve got the Club going, you may: 
- Approach the local newspaper and tell them what your club has been 

doing.  Invite them to cover one of your events 
- Invite students studying ICT at the local university to some of your 

activities 
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SSeettttiinngg  UUpp  IInntteerrnneett  CCoonnnneeccttiioonn  ttoo  
TTeellkkoommnneett  IInnssttaann    

If the modem has been installed, the next step is to prepare the connection to 
TelkomNet Instan. We can make special icon in the desktop, which functions to connect 
computer to TelkomNet. 

Click "Start" and enter to "Control Panel" 

 
 

Click icon "Internet Options", then the "Internet Properties" dialog box will appear. 
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click "Tab Connections"  

 
Click "Setup", then "New Connection Wizard" dialog box will appear 
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click "Next" 

 
Choose "Connect to the Internet" and click "Next"  
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Choose "Set up my connection manually" and click "Next" 

 
Choose "Connect using a dial-up modem" and click "Next" 
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.  
Type in ISP Name "TelkomNet Instan", and then click "Next" 

 
Type 080989999 in the box "Phone number", and then click "Next" 
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Fill in: 
• User id : telkomnet@instan 
• Password : telkom 

Click "Next", Windows window will complete connection to TelkomNet and 
"Completing the New Connection Wizard" dialog box will appear. 

Tick a checkmark "Add a shortcut to this connection to my desktop" in order 
that connection icon appears in the desktop. After it is completed, click "Finish".  
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DIAL TO TELKOMNET INSTAN 

Upon the completion of setting connection to TelkomNet Instan, and the connection 
icon has been available in the desktop, we are ready to be connected to the internet.  

Double click on icon TelkomNet Instan in the dekstop, and then "Connect" dialog box 
will appear 

 

User name and Password have been filled. Click "Dial" to connect to TelkomNet Instan.  
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EEvvaalluuaattiioonn  
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PPaarrttiicciippaannttss  EEvvaalluuaattiioonn  FFoorrmm  
 
Unit Title:  

Activity   
 

Please tick the box                  that is most appropriate for you. 
Do not tick more than one box per question 

 
How good was the activity you did?  
 

Very good  Good  Satisfactory  Not Satisfactory. Poor  

 
Did you learn a lot of new things from the activity?  
 

Yes  Satisfactory   Not Satisfactory  No  

 
Was the material provided appropriate to the subject and your needs? 
 

Very good  Good  Satisfactory  Not Satisfactory. Poor  

 
How do you rate the Facilitator’s presentation and delivery method? 
 

Very good  Good  Satisfactory  Not Satisfactory. Poor  

 
What would you like to learn in this toolkit to help you make choices about all 
your opportunities for life, work and learning after junior high school? 
 

  
 
 
 
 
 

a
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FFaacciilliittaattoorr  EEvvaalluuaattiioonn  FFoorrmm  
 
Please comment as fully as possible on all questions.  Your feedback will help us 
to improve this toolkit.  
 
 
Which units did you use from this toolkit? 
 
 
 
 
Which activities did you use from this toolkit? 
 
 
 
 
Did you find it easy to understand how to use the toolkit?  
 
 
 
 
Did you find it easy to follow the Facilitator’s instructions?  
 
 
 
 
What do you think should be added to the toolkit to make it easier to use?  
 
 
 
 
 
What do you think should be added to the toolkit to support the young people in  
your district to learn the English they need for their future life, learning and work? 
 
 
  
 
What do you think should be left out? 
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	Press the menu Tools -> Internet Option. Then the following dialog box will appear:
	Then, the following window will appear. This is the holder of Temporary Internet Files. This place is the place, where our pages and files are open in internet are saved. Including the animation files we open in the above-mentioned steps.
	To identify which file is included in the animation file, there are several methods:
	     Note for the Facilitator
	     Note for the Facilitator
	 Step 4:  Inserting Scientific Process Animation into Learning (15 Minutes)
	    Note for the Facilitator
	    Time: 
	Minimum 2 (two) hours. For practice work , it can be adjusted to the needs.
	  Step 1:  Explanation of Basic Accounting Principles (10 minutes)
	     Note for the Facilitator
	  Step 2:  Getting to Know the Application of Date Processor (45 Minutes) 
	     Note for the Facilitator
	   A. Microsoft Excel Worksheet
	 Button
	Description
	Ctrl + PgUp 
	      D. Correcting Errors of Typing
	E. Using Formula
	F. Setting up Range or Cell Block
	G. Deleting Data 
	H. Entering a Series of Data by Using Auto Fill Facility 
	I. Using Auto Calculate and Auto Sum Facility 



	  Step 3: Practice: Using Data Processor Application in Personal Financial Planning (20 minutes)
	     Note for the Facilitator
	     Note for the Facilitator
	 Step 4: Making Graph (10 Minutes)
	    Time: 
	Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs.
	 Step 1:  Understanding what is meant by Collaborative Learning and Mailing List (15 Minutes)
	     Note for the Facilitator
	Explain to the participant that the joint learning in the internet is not limited to the use of mailing list. There are many other ways, among others the existence of forum website community online, etc.
	In this activity, we limit to the use of mailing list. Mailing list is elected, because the process of registration and preparation are relatively easy and can be conducted by anyone within a fast period. Below is the explanation about the joint learning (collaborative learning) as well as about mailing list. (Translate into Indonesian, if participants do not understand the meaning).
	If internet access is available, type define:COLLABORATIVE LEARNING in www.google.com. Then the following window will appear.
	 
	Since our focus this time is mailing list, the following is the explanation about Mailing List: (taken from: http://balita-anda.com/milis.html) 
	 Step 2:  Knowing Tips on Joining a Mailing List (15 Minutes)
	     Note for the Facilitator
	These are the names of online learning group available in the YahooGroups together with the information on what is the mailing list. We can choose whichever group. The next step is how we join with the group we desire. As an example for the activity this time, press link free-english.  Step 4:  Join with Online Learning Group (20 Minutes)
	 Step 5:  Making an Online Learning Group (20 Minutes)
	     Note for the Facilitator
	    Time: 
	Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs.
	     Note for the Facilitator
	     Note for the Facilitator
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	From Wikipedia Indonesia, Independent Encyclopedia in Indonesia.
	     Note for the Facilitator
	     Note for the Facilitator
	     Note for the Facilitator
	     Note for the Facilitator
	     Note for the Facilitator
	     Note for the Facilitator
	    Time: 
	Minimum 2 (two) hours.  For practice work , it can be adjusted to the needs.
	     Note for the Facilitator
	     Note for the Facilitator
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